Dipl.-Phys.-Ing. Ralf Wirtz

Issue 22-0-0-5

2022
SimplexNumerica
User Manual

SimplexNumerica is a comprehensive and
powerful application that can be used in
order to analyze data, 2D / 3D plotting,
make complex calculations and develop
programs in the C++ language on a
Windows 10 Ribbonbar GUI.
www.SimplexNumerica.com

Data Visualization

V22

-1User Manual

User Manual

1

Hint:
Be aware of the manuals “Programming SimplexNumerica with AngelScript” and
“Excel-like SpreadSheet Module with FormulaEngine” from the developer and author
of this document!

This documentation is provided to familiarize you with the fundamentals of SimplexNumerica.
For additional help using SimplexNumerica, review the sample files or visit the SimplexNumerica web site
www.simplexnumerica.com
This manual helps you to navigate through the user interface. It contains a number of examples, which are
designed to show some of the facilities available for creating charts/shapes, and professional presentations.
There is an additional area for the numerical methods available. However, please refer to the internet if you
require further details on a particular numerical algorithm. It is assumed that you are familiar with the use of
Windows based packages.

SIMPLEXNUMERICA, SIMPLEXIPC, SIMPLEXEDITOR AND SIMPLEXETY ARE PROVIDED "AS IS" WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL THE AUTHOR BE LIABLE TO
YOU FOR ANY DAMAGES, INCLUDING INCIDENTAL OR CONSEQUENTIAL DAMAGES, ARISING OUT OF THE USE
OF THE PROGRAM, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

System Requirements
Hardware:
The minimum hardware requirements are:
•
•
•

CPU: State-of-the-art Intel based processor.
Memory: > 1GB
Available disk space: > 300 MB

Software:
SimplexNumerica was tested on:

•

SimplexNumerica will run on the Microsoft Windows Operating Systems (i86 or x64):
Microsoft Windows 7, 8/8.1, 10 or 11
SimplexNumerica Setup program has already installed the Microsoft Visual C++ Redistribution
Package for MFC C++ DLLs.

Page 1 of 372

SimplexNumerica V21

-2User Manual

Content

1

USER MANUAL.......................................................................................................................................... 1

TABLE OF FIGURES ............................................................................................................................................ 6
3

WHAT’S NEW? .......................................................................................................................................... 8
3.1
3.2
3.3
3.4
3.5
3.6
3.7
3.8
3.9

NEW IN V22 ........................................................................................................................................................... 8
NEW IN V21 ......................................................................................................................................................... 10
NEW IN V18 ......................................................................................................................................................... 10
NEW IN V15 ......................................................................................................................................................... 10
NEW IN V14 ......................................................................................................................................................... 14
SHORTCUTS ON FILE MENU ...................................................................................................................................... 14
EXPORT HTML TABLE ............................................................................................................................................. 14
SXE-VIEW............................................................................................................................................................. 15
GRAPH STATISTICS VIEW.......................................................................................................................................... 17

4

DEVELOPMENT ....................................................................................................................................... 21

5

SIMPLEXNUMERICA REFERENCES IN GERMAN............................................................................................ 22

6

INSTALLATION ........................................................................................................................................ 23

7

START-UP ............................................................................................................................................... 28
7.1
7.2
7.3
7.4
7.5
7.6
7.7
7.8
7.9

8

CHART IMPRESSION ................................................................................................................................ 47
8.1
8.2
8.3
8.4
8.5
8.6
8.7
8.8
8.9
8.10
8.11
8.12
8.13
8.14

9

SWITCHING THE LANGUAGE...................................................................................................................................... 32
NEW USER INTERFACE (RIBBONBAR).......................................................................................................................... 33
ADD A NEW EVALUATION & CHART ........................................................................................................................... 34
LOAD EVALUATIONS................................................................................................................................................ 36
WHAT IS A GRAPH? ................................................................................................................................................ 38
ADD A NEW GRAPH ................................................................................................................................................ 39
HOW TO EDIT A HTML FILE IN SXE? .......................................................................................................................... 42
HOW TO IMPORT A HTML FILE IN SXE?...................................................................................................................... 43
ADD GRID LABEL .................................................................................................................................................... 45

CHART ARCHITECTURE............................................................................................................................................. 47
CHART THUMBNAILS ............................................................................................................................................... 49
CHART PARTS ........................................................................................................................................................ 53
CHART TOOLBAR .................................................................................................................................................... 55
CHART THEMES...................................................................................................................................................... 57
CHART TEXTURES ................................................................................................................................................... 59
CHART LABELS ....................................................................................................................................................... 60
CHART AXES .......................................................................................................................................................... 63
CHART LEGEND ...................................................................................................................................................... 65
GRAPH DATA MARKER ............................................................................................................................................ 66
GRAPH DATA LABELS .............................................................................................................................................. 67
CURSORS .............................................................................................................................................................. 68
MISSING VALUES.................................................................................................................................................... 71
UNEVEN DATA POINTS ............................................................................................................................................ 71

CHART TYPES .......................................................................................................................................... 72

Page 2 of 372

SimplexNumerica V21

-3User Manual

9.1
9.2
9.3
9.4
9.5
9.6
9.7
9.8
9.9
9.10
9.11
9.12
9.13
9.14
9.15
9.16
9.17
9.18
9.19
9.20
10

USER INTERFACE ..................................................................................................................................... 98
10.1
10.2
10.3
10.4
10.5
10.7
10.8
10.9
10.10

11

EVALUATIONS ........................................................................................................................................................ 99
EVALUATION WINDOW ......................................................................................................................................... 101
PROJECTS............................................................................................................................................................ 105
EXTENDED KEYBOARD NAVIGATION ......................................................................................................................... 108
LAYERS ............................................................................................................................................................... 109
CHART EXPLORER ................................................................................................................................................. 115
CHART PROPERTIES............................................................................................................................................... 117
OUTPUT WINDOW ............................................................................................................................................... 120
PROFILES ........................................................................................................................................................ 121

SIMPLEXGRAPHICS FRAMEWORK ........................................................................................................... 125
11.1
11.2
11.3
11.4
11.5
11.6
11.7

12

2D BUSINESS CHARTS ............................................................................................................................................. 72
WHAT ARE BUSINESS CHARTS? ................................................................................................................................. 76
3D BUSINESS CHARTS ............................................................................................................................................. 77
PHYSICS CARTESIAN COORDINATE SYSTEM.................................................................................................................. 81
MATH CHART (MATHEMATICAL CHART)..................................................................................................................... 83
POLAR CHART........................................................................................................................................................ 83
RADAR CHART ....................................................................................................................................................... 83
TERNARY CHART (TRIPLOT) ...................................................................................................................................... 84
LINE CHART........................................................................................................................................................... 85
AREA CHART ......................................................................................................................................................... 86
PIE CHART ............................................................................................................................................................ 87
BAR CHART ........................................................................................................................................................... 88
TRENDING CHARTS ................................................................................................................................................. 89
BOX-WHISKER CHARTS............................................................................................................................................ 89
BUBBLE CHARTS ..................................................................................................................................................... 89
SCATTERPLOTS ....................................................................................................................................................... 90
PYRAMID, CONE & FUNNEL CHARTS .......................................................................................................................... 90
CONTOUR PLOTS/MAPS .......................................................................................................................................... 91
SURFACE PLOT ....................................................................................................................................................... 91
SMITH DIAGRAM.................................................................................................................................................... 92

WHAT IS SIMPLEXGRAPHICS? ................................................................................................................................. 125
SHAPE STYLES ...................................................................................................................................................... 126
INBUILT SHAPES ................................................................................................................................................... 131
CONNECTORS ...................................................................................................................................................... 132
TEXT, LABELS AND LEGENDS ................................................................................................................................... 134
GROUPS ............................................................................................................................................................. 135
USE OF THE SHAPES .............................................................................................................................................. 136

RIBBONBAR OVERVIEW ......................................................................................................................... 148
12.1
12.2
12.3
12.4
12.5
12.6
12.7
12.8
12.9
12.10

RIBBONBAR FILE................................................................................................................................................... 149
RIBBONBAR EDIT .................................................................................................................................................. 153
RIBBONBAR VIEW................................................................................................................................................. 157
RIBBONBAR CHART ............................................................................................................................................... 159
RIBBONBAR GRAPH .............................................................................................................................................. 163
RIBBONBAR ALGORITHM........................................................................................................................................ 166
RIBBONBAR INTERFACE .......................................................................................................................................... 167
RIBBONBAR TREND ............................................................................................................................................... 168
RIBBONBAR CUSTOM ............................................................................................................................................ 170
RIBBONBAR C++ EDITOR ................................................................................................................................... 171

Page 3 of 372

SimplexNumerica V21

-4User Manual

12.11
12.12
13

RIBBONBAR GRAPHTABLE.................................................................................................................................. 173
SELECTION BAR ............................................................................................................................................... 184

RIBBONBAR REFERENCE......................................................................................................................... 185
13.1
13.2
13.3
13.4
13.5
13.6
13.7

CATEGORY FILE .................................................................................................................................................... 185
CATEGORY EDIT ................................................................................................................................................... 217
CATEGORY VIEW .................................................................................................................................................. 222
CATEGORY CHART & GRAPHS ................................................................................................................................. 235
CATEGORY ALGORITHM ......................................................................................................................................... 253
CATEGORY INTERFACE ........................................................................................................................................... 254
CATEGORY TRENDING............................................................................................................................................ 267

14

SIMPLE TUTORIAL ................................................................................................................................. 268

15

TREND TUTORIAL .................................................................................................................................. 279
15.1
15.2
15.3
15.4
15.5

16

METHOD 1: LOAD A SAMPLE TREND EVALUATION ...................................................................................................... 280
METHOD 2: USE DATA IMPORT DIALOG ................................................................................................................... 282
METHOD 3: USE DEDICATED GRAPH TREND FILE ........................................................................................................ 286
METHOD 4, DATA IMPORT TRENDING ...................................................................................................................... 292
TREND TOOLBARS................................................................................................................................................. 294

PRIME EXAMPLE, GENERATE REPORTS .................................................................................................... 295
16.1
16.2
16.3
16.4

CREATE A DATABASE ............................................................................................................................................. 296
CREATE A DOCUMENT REPORT................................................................................................................................ 297
CREATE EVALUATION REPORT ................................................................................................................................. 299
FILLING DOCUMENTS REPORT ................................................................................................................................. 316

17

ADVANCED LABEL EDITOR...................................................................................................................... 319

18

WORKING WITH FUNCTION PLOTS .......................................................................................................... 320
18.1
18.2
18.3
18.4
18.5
18.6
18.7

19

INSERT A FUNCTION .............................................................................................................................................. 320
FUNCTION TYPES .................................................................................................................................................. 321
ADD TANGENT / NORMAL...................................................................................................................................... 322
FILL AREA ........................................................................................................................................................... 323
RELATION PLOT.................................................................................................................................................... 326
DIFFERENTIATION ................................................................................................................................................. 328
CUSTOM FUNCTIONS & CONSTANTS ........................................................................................................................ 330

ALGORITHM IN SIMPLEXNUMERICA ...................................................................................................... 332
19.1
19.2
19.3
19.4
19.5
19.6
19.7
19.8
19.9
19.10
19.11
19.12
19.13
19.14

FUNCTION PLOT ................................................................................................................................................... 333
REGRESSION ........................................................................................................................................................ 333
SAMPLE CONSENSUS ............................................................................................................................................. 335
APPROXIMATION .................................................................................................................................................. 335
INTERPOLATION ................................................................................................................................................... 341
2D SURFACE INTERPOLATION & APPROXIMATION ...................................................................................................... 344
DIGITAL SIGNAL PROCESSING .................................................................................................................................. 347
DFT................................................................................................................................................................... 348
FFT ................................................................................................................................................................... 348
WINDOW FUNCTIONS ....................................................................................................................................... 356
GOERTZEL DFT (FILTER).................................................................................................................................... 356
FIR FILTER ...................................................................................................................................................... 356
IIR FILTER....................................................................................................................................................... 356
TIME-SERIES FILTER .......................................................................................................................................... 357

Page 4 of 372

SimplexNumerica V21

-5User Manual

19.15
19.16
19.17
19.18
19.19
19.20
19.21
19.22
19.23
20

NEW APPROACH FOR REGRESSION ANALYSIS .......................................................................................... 361
20.1
20.2
20.3

21

AUDIO SIGNALS ............................................................................................................................................... 357
MATH OPERATIONS ......................................................................................................................................... 357
MATH FUNCTIONS ........................................................................................................................................... 358
DIFFERENTIATION............................................................................................................................................. 359
INTEGRATION .................................................................................................................................................. 359
OUTLIER ALGORITHM ....................................................................................................................................... 359
DATA REDUCTION ............................................................................................................................................ 359
CONVEX HULL ................................................................................................................................................. 360
MISC. ............................................................................................................................................................ 360

RANDOM SAMPLE CONSENSUS (RANSAC) ............................................................................................................. 362
MAXIMUM LIKELIHOOD ESTIMATOR SAMPLE CONSENSUS (MLESAC)............................................................................ 364
EVALUATION OF SAMPLES ...................................................................................................................................... 365

END-USER LICENSE AGREEMENT ............................................................................................................. 370

Page 5 of 372

SimplexNumerica V21

-6User Manual

Table of Figures
Fig.3-1: SxE-View of a webpage ................................................................................ 16
Fig.3-2: MDI window and Graph Statistics View....................................................... 17
Fig.3-3: Show and hide the Graph Statistics View .................................................... 18
Fig.6-1: SimplexNumerica Installation Folder ........................................................... 27
Fig.7-1: Start-up Dialog to find the right way ........................................................... 28
Fig.7-2: Evaluations are organized in MDI-Tab-Views .............................................. 29
Fig.7-3: SimplexNumerica Environment ................................................................... 30
Fig.7-4: Ribbonbar Controls ...................................................................................... 33
Fig.7-5: Arrange Charts automatically (Arrange All Charts)...................................... 35
Fig.7-6: Chart with two graphs ................................................................................. 38
Fig.7-7: Label made by Table .................................................................................... 45
Fig.8-1: Chart added to Thumbnail Window ............................................................ 51
Fig.8-2: Main chart parts .......................................................................................... 53
Fig.8-3: Chart Themes select in properties for new chart types, only ...................... 58
Fig.8-4: Manhattan Bar Chart with Textures ............................................................ 59
Fig.8-5: Chart Labels pinned by red pins .................................................................. 60
Fig.8-6: Different Chart Axes around the Physics Chart, only................................... 63
Fig.8-7: Top and right axis for new charts, only........................................................ 64
Fig.8-8: Axes Scale Breaks......................................................................................... 64
Fig.8-9: Vertical and Horizontal orientation ............................................................. 65
Fig.8-10: Additional Legend appears. ....................................................................... 69
Fig.8-11: Additional distributed Labelling................................................................. 70
Fig.8-12: Additional label positioned flush right....................................................... 70
Fig.9-1: Business and Normal Chart.......................................................................... 76
Fig.9-2: Manhattan Bar Chart ................................................................................... 77
Fig.9-3: Stacked Column Chart ................................................................................. 77
Fig.9-4: Horizontal Stacked Bar Chart ....................................................................... 78
Fig.9-5: Horizontal Manhattan Bar Chart ................................................................. 78
Fig.9-6: 3D Area Chart .............................................................................................. 79
Fig.9-7: 3D Line Chart ............................................................................................... 79
Fig.9-8: 3D Combined Chart ..................................................................................... 80
Fig.9-9: Range Area in 3D ......................................................................................... 80
Fig.9-10: 3D Line Chart ............................................................................................. 85
Fig.9-11: Step Line Chart........................................................................................... 85
Fig.9-12: Stacked Line Chart ..................................................................................... 85
Fig.9-13: Different Area Charts ................................................................................. 86
Fig.9-14: Different Pie Charts ................................................................................... 87
Fig.9-15: Different Bar Charts ................................................................................... 88
Fig.9-16: Trending Chart ........................................................................................... 89
Fig.9-17: Pyramid, Cone & Funnel Charts ................................................................. 90
Fig.9-18: Surface Plots .............................................................................................. 91
Fig.9-19: Smith Diagram ........................................................................................... 92
Fig.10-1: User Interface with different areas ........................................................... 98
Fig.10-2: Evaluation Page ......................................................................................... 99
Fig.10-3: Main Window and Tabs for the Evaluation ............................................. 102
Fig.10-4: GraphTable View. .................................................................................... 103

Page 6 of 372

SimplexNumerica V21

-7-

Fig.10-5: Project Menus.......................................................................................... 105
Fig.10-6: Extended Keyboard Navigation ............................................................... 108
Fig.10-7: Layer Window beneath the evaluation page........................................... 109
Fig.10-8: Output Window ....................................................................................... 120
Fig.10-9: Script Editor in SimplexNumerica ............................................................ 120
Fig.11-1: User-Interface for Shapes ........................................................................ 136
Fig.12-1: Option Dialog to modify the Quick Access Toolbar ................................. 148
Fig.12-2: Dialogbox for User defined Tools ............................................................ 170
Fig.15-1: Trending a *.csv file ................................................................................. 280
Fig.15-2: Settings for Data Import Dialog ............................................................... 283
Fig.15-3: Settings for Data Import Trending ........................................................... 293

Page 7 of 372

SimplexNumerica V21

-8What’s new?

3 What’s new?
To provide you with the latest changes and improvements of SimplexNumerica we will extent this starter
page and doc folder (see below) from time to time.

3.1 New in V22
The main focus on version V22 was lying on the new user interface with Small Toolbars in addition to the
Standard Ribbonbars. Now, you can switch between the small (Toolbars) and the standard Ribbonbars. There
is a checkbox on top left of the windows title bar, see here:
Small Menus (Toolbar)

Standard Ribbonbar

There are only a few menus (Icons) from the Standard Ribbonbar not available in the small one. If you miss
one (like the font tools in the scripting editor), then switch to the Standard Ribbonbar, set it and go back to
the small one...
Next, we have optimized the user interaction, so that you get more hints from the program. White Papers
are introduced. They appear when you drag a chart from the Thumbnail Window into the Graphics window.

To de-activate this feature, right mouse click on
the Thumbnail Window and select the menu
point: Inform when “White Paper” is available
(see next picture):
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Click on the entry here in that text line above to open a *.pdf file with more information. You can find the
path to the file in the Chart Properties:

Certainly, you can make your own pdf files if you like…
Info:
Use SP:\ to the standard White Paper folder of the program.
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3.2 New in V21
We have made a short description for V21. See the folder
C:\Program Files\SimplexNumerica64\Doc
and the file
Release Notes for Upgrade V21.pdf

3.3 New in V18
To avoid to blow up this manual too much, separate documentation for newer versions is written and placed
inside the installation folder of SimplexNumerica. Please have a look at, e.g.:
C:\Program Files\SimplexNumerica64\Doc
A highlight of version 16 is e.g. the white paper ‘Text and Label Module.pdf’ and the GPX Module.

3.4 New in V15
3.4.1

DPI Awareness

Desktop applications that use older Windows programming technologies do not automatically handle DPI
scaling and, as a result, will render blurry or be sized incorrectly in many common usage scenarios unless
work is done by the developer to handle these scenarios.
As display technology has progressed, display panel manufacturers have packed an increasing number of
pixels into each unit of physical space on their panels. This has resulted in the dots-per-inch (DPI) of modern
display panels being much higher than they have historically been. In the past, most displays had 96 pixels
per linear inch of physical space (96 DPI) but now (as of 2018) there are displays with nearly 300 DPI (or
higher) on the market. Most legacy desktop UI frameworks have built-in assumptions that the display DPI is a
constant value during the lifetime of the process.
Resolution independence is where elements on a computer screen are rendered at sizes independent from
the pixel grid, resulting in a graphical user interface that is displayed at a consistent size, regardless of the
size of the screen.
Since Windows XP, dots per inch (DPI) settings have been a component of the Windows development
platform. For many years, high density displays did not consume a large percentage of the market. Now, due
to the clear and perceivable user benefits, such as text legibility and image presentation, high density
displays are becoming increasingly popular, particularly in mobile form factors. With the growing relevance
of high DPI devices, it is important to enable each monitor of a system to run with optimal DPI settings to
take full advantage of all display hardware. Windows 10 adds developer support that enables desktop
applications to not only become aware of different monitor DPI settings, but to also respond to any dynamic
DPI changes. This gives the user with the best possible experience on any display.
Writing a DPI–aware application is the key to making a UI look consistent across a wide variety of DPI display
settings. An application that is not DPI–aware but is running on a high DPI display or across monitors of
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different DPIs will be scaled by the system to the appropriate size so that it is still usable, but can suffer from
visual artifacts including incorrect scaling of UI elements, clipped text, and blurriness. By adding support in
SimplexNumerica for DPI awareness level, we can present our application’s UI in a predictable manner. By
updating our app to respond to dynamic changes in DPI, we create an application that is crisp, making it
more visually appealing to users.
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3.4.2

Physical Chart to Shapes

You can depacketize a Physical Chart into its text scaling, rectangles, lines and polygons. There is a new icon
in the Ribbonbar Chart that can be used for this.
Start with a sample chart:

Please click on that icon.

That results in this graphic. But that is not any longer a dynamic chart.
They are individual elements.

You can see that, when you click on it and move
the elements (shapes) away.
The most shapes are still grouped. Use that
ungroup icon or use key <Ctrl> + U

So that the original chart is not covered, it is simply made
hidden. The shapes are on the Layer named like
>>> Shaped Layer <<<
Here in this example, the original chart is still on Layer
>>> MyLayer<<<
In the next SimplexNumerica updates we will extend to other charts.
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3.4.3

SVG Graphic

Definition:
Scalable Vector Graphics (SVG) is an XML-based vector image format for two-dimensional graphics with
support for interactivity and animation. The SVG specification is an open standard developed by the World
Wide Web Consortium (W3C) since 1999. SVG images and their behaviors are defined in XML text files.
Object-oriented shapes in SimplexNumerica can now be saved in SVG vector graphic files. If you want to save
a Physics Chart, then you must convert it before in a bunch of shapes (see previous chapter). Types of 2D/3D
Business charts cannot converted and not be saved as SVG.
If you want to save individual shapes, then use the right mouse
click for the selected shapes, that opens the popup menu with
the entry Copy As SVG

…or you can use the File menu Save selected Object(s) as
SVG…

If you want to save everything, then use the File menu Save
Evaluation as SVG…

Again: Use description in previous chapter to save a Physics chart as SVG.
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3.5 New in V14
➔ See the manual “Excel-like SpreadSheet Module with FormulaEngine”
➔ Because of the new spreadsheet, a DataSheet is now called GraphTable.

3.6 Shortcuts on File Menu
Still available but not identified the standard
shortcuts in the file menu after the change from
Pulldownmenu to Ribbonbars.

3.7 Export HTML Table
Already available in previous versions but now optimized for the new editable SimplexEditor-View (SxEView).

Graph
Table

If you like to export a GraphTable (DataSheet) as a HTML file for an external browser program or word
processor, then swap to the GraphTable view (maybe select an area) and use this export menu…
But, for instance, if you want to show the table (or parts of it) as a HTML label around its chart, then you can
either import the previous saved file in SimplexEditor (SxE) or you can use direct the new function Add Grid
Label (see Ribbonbar icon) or the new Ribbonbar icon Add Label.
Please have also a look at the chapters:
→ How to edit a HTML file in SxE? (see 7.7) and
→ How to import a HTML file in SxE? (see 7.8)
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3.8 SxE-View
SxE is the abbreviation of SimplexEditor. SxE and SxE-View are only simplified clones of the Microsoft
Internet Explorer Browser. The HTML editor views of SxE and SxE-View have the same functionality, but SxE
is a separate application.
If the SxE-View is hidden, the view runs in Runtime Mode. If you click on the SxE-View-Tab, then it will
change automatically to the Design Mode (see SxE for different modes) of the Internet Explorer.
Info
The SxE-View is a simple browser that can be used to modify existing HTML labels.
New labels can be made by the SimplexEditor or any other external HTML Editor.
SimplexEditor can be called directly from the label dialogbox.

Webpage inside SimplexEditor.
You can load and display a standard webpage from
file or internet (without frames) - but not always
transferring it to SimplexNumerica, because the
internal conversation tool removes unsupported
HTML tags from such a webpage.

Look in Graphics page:
The webpage is getting a HTML label inside the
Graphics page.
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The next screendump shows the SxE-View of the webpage:

Fig.3-1: SxE-View of a webpage

Now, you can edit the webpage inside SxE-View similar to the SimplexEditor (SxE). In this version of
SimplexNumerica there are no toolbars or menus to support this editor. But you can use copy & pasted,
undo, redo, etc. or size changings, e.g. of a table.
When you are finishing your redacting, then swap back to the Graphics Tab. That applies the changings to
the HTML text label.

Hint
Please have a short look at chapter 7.9 to see another example for the use of the
SxE-View.
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3.9 Graph Statistics View
The Graph Statistics View displays a hierarchically arranged view of the graphs on the chart, in an objected
tree column table. The Graph Statistics View lists information about each graph. When first displayed, the
Graph Statistics View is located under the MDI window.
The Graph Statistics View (as it appears in a default configuration) is shown below; your Graph Statistics
View might look different depending on how it has been customized in your system.
As you may know, the most SCADA systems or process analysts have such a view underneath their trend
view. Consequently, you can use this view in the same way here in SimplexNumerica. It will be automatically
refreshed during trending the graphs of all the available charts.

Fig.3-2: MDI window and Graph Statistics View

As you can see, there is a button row and a white table-like display for each of the charts graphs. The chart
name entries of the table can be collapsed, so that its graph entries are hidden.
You can use the mouse for checking, double-clicking or dragging. Use the Ribbonbar View to hide/show the
view.
Info
Before you start, please read the info text behind the question button:
It explains also the x-Position and Interval Range for the values!
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Here is the content of this messagebox that answers FAQs:
Button Awaken
If the table is not updating for any reason, then press this button once. After the first knock-on, the system
should automatically update the table.
Which data are shown?
If the Ribbonbar <Graph> "Show Curve" is selected, then the CurveData is used for calculation, else the
SampleData.
At which x-Position in the Chart?
For "Science Plots" use right vertical cursor line, then the first available data point to the left will be shown in
this table. For all other charts the last data point will be used.
And in which x-Range?
For "Science Plots" use left and right vertical cursor lines, then from the left cursor the first available data
point to the right and the first available data point to the left from the right cursor will make the range
(inclusive) and used for calculations. For all other charts the first and last data point will be used.
Linear Regression?
If checked, then all available graphs are overwritten by the linear regression line (Line between left and right
cursor in the chart).
Drag & Drop?
Can be used to move columns.
Button Columns?
Use this button menu to select which columns are shown!

You can use the Ribbonbar View and the icon Graph Statistics to show and hide the view.

Fig.3-3: Show and hide the Graph Statistics View
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The table below shows the functionalities of the button row.
Symbol

Function
Info Messagebox
See above the text in the info box.
Button Awaken
If the table is not updating for any reason, then
press this button once. After the first knock-on, the
system should automatically update the table.
Button Copy CSV
Content of the grid will be copied to the clipboard
as Comma Separated Values (CSV).
From there you can simply pasted (Ctrl + V) it into
any other program that supports this format.
Button Copy HTML
Content of the grid will be copied to the clipboard
as HTML. Paste it afterwards into a HTML editor –
like SimplexEditor (SxE).

Button Print
Print the table out to a printer device.
Button Columns
Select and check the columns that you want to see
in the table. Drag & drop the column header(s) to
another position (if you like to do so).

Please look to the
internet for explanations
of the statistic functions.
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Symbol

Function
Radio Button Graph Color
It shows the color of the graphs.
Please toggle around:
• No Color
• First Column
• All Columns
for each of the graph rows.
Edit the Decimal Places
…of the values in the table cells.
Button Recalc Linear Regression in Graph
What it does, it exchanged the existing graph of
each available chart against a fresh calculated
linear regression line in the above described
interval.

Mouse Activities
You can use the mouse on the table as follows:
Mouse Action

Function

Double-click on a
graph row in any cell.

Select Graph
• Activates the associated chart and
highlights the graph of the clicked row.
• Selects the graph in the Chart Explorer
and its properties in the Property Window.

Check and uncheck
the boxes on the first
column

Hide/Show Graph
Hides or shows the appropriated graph in the chart.

Click on any statistic
value cell.

No Function implemented.
Exchange columns

Drag & Drop

Hold down left mouse button on the column header
and drag it on another position. The red arrows are
showing the position.
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4 Development
The idea for SimplexNumerica sprung out of my own desires to create a relatively simple data plotter. Thus,
SimplexNumerica started out as a small side project of mine in 1986. I have previously worked on other
programs and something I noticed early on was the benefits of having a good base layer. In fact, a lot of my
work with the Simplex series has been revolved around building programs like SimplexParser, SimplexIPC,
SimplexGraphics, Simplexety and SimplexEditor as the base layer.
SimplexNumerica is designed to provide the power and functionality to satisfy the most demanding data
plotting requirements. It can handle arrays up to the limits of virtual memory, and will work with 32 and 64bit editions of Microsoft Windows™ Vista, Windows 7, Windows 8, Windows 10 and beyond.
SimplexNumerica has a wide-ranging library of 2D and 3D charts with a large section based on approximation
and interpolation algorithms. Additional charts are from the libraries ChartDirector and BCGControlBarPro.
SimplexNumerica is equipped with genuine object-oriented vector diagrams with context sensitive pull down
menus, e.g. the report and layout windows facilitate the ease-of-use and operation of the program. Likewise,
the chart module integrated into the user interface places its elements (lines, polygons, ellipses etc.) in an
object-oriented manner. Icons and menu options for selecting, increasing, grouping etc. are also intuitively
present. The diagram types and numeric functions can be checked in separate data sheets. The tool windows
are dynamically updated to show the most important functions; mouse-clicks are the only action necessary
for most operations.
The integrated scripting language AngelScript with its colored C++ editor can be used to write simple but
complex sequences. Likewise, complex operational sequences are taken care of automatically as far as
possible by the program.
Auto-scale routines permit the highest automation. The interactive nature of data analysis limits your userinputs to that which are only necessary. When just getting the job done is work enough, the last thing you
need is to waste time having to learn yet another computer application. Your experience with other tools
should be relevant to each new application, making it possible to sit down and use that new application right
away. That is why SimplexNumerica is so popular. Whether you simply need a powerful extension for Excel™,
a tool for plotting row data, or whatever, SimplexNumerica does hopefully what you want and the way you
would expect. Because SimplexNumerica is designed to provide the power and functionality to satisfy the
most demanding plotting needs.
SimplexNumerica has been implemented according to the Microsoft Windows Guidelines for Accessible
Software Design, so great attention has been paid to making it easy for both beginners and experienced
users.
If you still have further questions, please do not hesitate to contact me.
Dipl.-Phys.-Ing. Ralf Wirtz, Software Engineer and
Developer
Email: simplexnumerica@gmail.com
Web: www.SimplexNumerica.com
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5 SimplexNumerica References in German
SimplexNumerica bietet objektorientierte numerische Algorithmen und Datenanalysen sowie
vektorisierte Visualisierungen mit einer hochauflösenden Grafik-Engine. Das Programm hat
bereits eine lange Geschichte hinter sich, die im Jahr 1986 beim deutschen Fraunhofer-Institut
für Lasertechnik in Aachen begann. Das Programm ist sicherlich manchen Wissenschaftlern in
der Vorgängerversion noch unter dem Namen Data Professional für PC und Atari bekannt.
❖ Das Programm lässt sich jederzeit von Englisch in Deutsch (und umgekehrt) umschalten.
Falls jemand die Meinung zu dem Programm interessiert, der kann in den folgenden Berichten die
Beurteilung lesen:
o
o
o

o
o
o

c’t Magazin für Computer Technik, Ausgabe 6 vom März 2013, Seite 140 – 146
Untertitel: Software für Wissenschaft und Technik, (mehrere Programme im Bericht)
c’t Magazin für Computer Technik, Ausgabe 14 von 2001, Seite 124
Titel: Kapieren mit Spaß, Lern- und Trainingshelfer aus Free- und Shareware
c’t Magazin für Computer Technik, Ausgabe 7 vom Juli 1990, Seite 150 – 156
Titel: Annäherungen von Frau Dr. Nicoletta Adams, (nur Data Professional im Bericht)
ST Computer, Ausgabe 4 vom April 1989, Seite 26 - 31
Titel: Ein Messwert kommt selten allein, (nur Data Professional im Bericht)
ST Computer, Ausgabe 6 vom Juni 1992, Seite 50 - 55
Titel: Was eine Auswertung ausmacht, (nur Data Professional im Bericht)
http://www.heise.de/download/simplex-numerica-115924.html

In der c’t vom März 2013 wurden mehrere Programme aus verschiedenen Bereichen von Wissenschaft und
Technik beschrieben. Als Auswerte-Programme wurden nur Origin, Simplexety und SimplexNumerica
aufgeführt. Simplexety und SimplexNumerica wurden vom Ersteller dieses Dokuments entwickelt.
Hier ein Auszug aus dieser Ausgabe:
Die Auswertung und die Präsentation wissenschaftlicher Daten gehören zu den eher lästigen Forscherpflichten. Abhilfe
schafft hier SimplexNumerica, ein leicht zu bedienendes Plot-Programm. Neben einer großen Anzahl von vordefinierten
2D- und 3D-Diagrammen glänzt die Software mit Funktionen zum Importieren und Editieren von Messdaten. Der
objektorientierte Aufbau der grafischen Darstellung und eine C++ Scriptsprache sorgen dafür, dass beim Anpassen an
eigene Bedürfnisse kaum Wünsche offen bleiben.

c’t Magazin für Computer Technik, Ausgabe 6 vom März 2013, Seite 140 – 146
Hier ein Auszug aus Artikel aus c't 14/2001 speziell zu SimplexNumerica:
Wo numerische Werte anfallen, etwa bei Messungen im Physikunterricht, bei Klimabeobachtungen für Geografie oder im
Rahmen beliebiger statistischer Untersuchungen, will man sie aussagekräftig darstellen. Ein sehr komplexes und
leistungsfähiges Visualisierungswerkzeug, das als bloße Unterrichtshilfe schon fast zu schade ist, heißt
SimplexNumerica. Das Programm hat einen ehrwürdigen Stammbaum: Für den Atari ST wurde sein Vorgänger vor
Jahren unter dem Namen `Data Professional´ verkauft. Es beherrscht spezielle Darstellungen für die verschiedensten
Bereiche in Schule und Studium: Geografen, Biologen, Chemiker und Elektrotechniker können es gleichermaßen sinnvoll
nutzen. Algorithmen- und Funktionenliste, Diagrammtypen und Beschriftungsmöglichkeiten lassen ebenso wenige
Wünsche offen wie die Optionen zur optischen Ausgestaltung der Ergebnisse.

c’t Magazin für Computer Technik , Ausgabe 14/2001
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6 Installation
The installation of SimplexNumerica is a standard windows procedure. Download the program in form of a
*.zip file; extract and start the setup executable. Then follow the dialogs…
Once installed, SimplexNumerica is added to the start menu, and a SimplexNumerica icon is added to the
desktop.
Next, put the license file1 into the SimplexNumerica install folder. To run the program, double-click on the
Windows Explorer icon, or run it in the same way that you run your other applications from the start menu
or desktop.
After SimplexNumerica runs, you will see a start-up dialog and after that the program environment.
Here the steps again:
Step 1 - Download the program from www.SimplexNumerica.com
32-Bit-Version: simplex.zip
64-Bit-Version: simplex64.zip
Tip:
Anyone can freely download the SimplexNumerica Professional Edition. If you do
not have a license file, then you will see some hints for upgrading, but you can
use the whole range of functions!

Please unzip the compressed version (*.zip), first...

Before you can run SimplexNumerica, you must install it by running the
setup program. Simply double click on the icon <SimplexNumerica_setup.exe> for 32-Bit or
<SimplexNumerica64_setup.exe> for 64-Bit version, respectively, or use the Run command, found by
pressing the Windows Start button. You will be prompted for the name of the program you want to run.
Installation on the network
To install SimplexNumerica on a network, simply install it on the server in the normal way described above.

1

You will get the license file via email after the order of the program from the developer. Please await it among three
days.
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For each client that will have access to the server, create a shortcut (or icon) for SimplexNumerica on the
client system and run the program once. SimplexNumerica will install itself properly on the client system.
Step 2 - Follow the dialogs...

1

Accept the license agreement...

2

...be aware of a good place to install...

3
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Choose an installation folder ot let the default path…

...we let the name...

4

..a shortcut to the desktop...

5

Evaluations have the file extension *.sx in SimplexNumerica… Except the link to its extension, so that a
double click can open a new instance of SimplexNumerica.
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6

Now, start the installation…

7

Installation runs…

SimplexNumerica is developed in C++ based on Microsoft Foundation Classes (MFC).
It needs their Redistribution Compiler Package (DLLs etc.).
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Microsoft Visual C++ Redistribution Package for MFC C++ DLLs:

8

The installation is all over now! The program icon can be found e.g. on the desktop. Start the program from
here (see next chapter) …

Fig.6-1: SimplexNumerica Installation Folder

Certainly, the place to find the installation folder depends on the 32-Bit or 64-Bit setup (and not to forget
your choice in above dialog no. 3).
Hint:
Later, you can switch the program language between English and German, and vice
versa. Please have a look at chapter 0.
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7 Start-up
Please start SimplexNumerica from the desktop, double-click on the program icon.
→ SimplexNumerica starts very quickly, as a rule, also
because only a few DLLs are loaded at start time.
During startup, a so-called splash screen appears.

If you do not like to
see the splashscreen anymore, then add to the shortcut target path of
the program the argument
„–nosplash“ or „/nosplash“.

The available command-line commands can be interrogated in the program under
the Pulldownmenu Help.

When you have started-up SimplexNumerica for the very first time, then you
should see the next, so-called Start-up Dialog.

Fig.7-1: Start-up Dialog to find the right way
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The start-up dialog makes it easy to deep into the main program parts and to see the program life, step-bystep, in action. Play a little bit around the entries of the start-up dialog.
Info:
Recall the Start-up dialog again, use key <F1> or
use the toolbar icon left from question mark to recall the Start-up Dialog!

The dialog is primarily an introduction to the program. When you click on one of the colored rectangles, then
the dialog will be closed and a sequence of instructions will guide you through a more or less extensive
instruction to the program. If you do not want to see, each time, again this dialog, then click on the text:
Don’t show this dialog again…
If you click on the left symbol, nothing happens more than the program starts up and shows you
its main (default) desktop. If the program starts not for the first time, then the desktop may be
look different – like the next screenshot in Microsoft Windows 10:

Fig.7-2: Evaluations are organized in MDI-Tab-Views

Please call again the Start-up dialog again (key F1)…
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Before you begin working with SimplexNumerica, please open some example evaluations.
Use this button in the start-up dialog. Then the program opens the
Fileselectbox, it shows you the path to the example folder and subfolders.
You can also try to evaluate sample data with a Cubic Spline
function, when you press this button.

Now, go to the main environment of the program…
SimplexNumerica is primarily a Microsoft MDI2 application, ordered by the popularly tabs within the parent
mainframe window. MDI applications consist of a single parent window (like a desktop), and the
application's client windows that are contained within or float on top of the parent window.

Fig.7-3: SimplexNumerica Environment

Note
To change the environmental look of the application, use Toolbar → Skins.
Default is the Windows 10 Skin with the name “Windows 10 Style”.

2

MDI → Multiple Document Interface
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If you start the program the very first time, then the default environment will be shown. The next start will
have exactly the same look as when you have quit the program. All environment settings will be stored into
the Microsoft Windows registry.
If you have an installed SimplexNumerica version (or copied the installed folder to another PC), please delete
this key manually, if you want to remove SimplexNumerica from your harddisk or if you like to set the look to
default, too. That’s because all your user settings are not been lost, if you make an update.

Here is the extract from the Registry Editor

.

Follow the steps to reset the SimplexNumerica settings:
1.
2.
3.
4.
5.

Quit the program
Run regedit.exe
Look for the key Computer\HKEY_CURRENT_USER\SOFTWARE\SimplexNumericaV15
Delete the entry “SimplexNumericaV15” and
Re-start the program again.

After the re-start of the program, you will see the default window GUI, settings and skin of the program.
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7.1 Switching the Language
At present, only two languages are supported, English and German. The program used English as the main
language. German phrases have to be translated after parts of the program were getting finish.

Use the Ribbonbar tab Custom to switch between the languages during runtime. Disadvantage is the reset of
the environment, because we have to clean the registry, so that the new (default) menu entries can be replaced.
Hint:
If there is a function not working well in German, then please try the English
language until the bug is fixed by the developer.
Please send also a message to the developer email address:
simplexnumerica@gmail.com
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7.2 New User Interface (Ribbonbar)
The "Ribbonbar" control was introduced by Microsoft in Office 2007. It's not just a new control - it's a new
user interface ideology.

Ribbon control replaces
traditional toolbars and
Pulldownmenus with tabbed
groups (Categories). Each tab is
logically split into Panels and
each panel may contain various
controls and command buttons.
In addition, Ribbon control
provides smart layout maximally
utilizing the available space. For
example, if a Panel has been
stretched and has no place to display all available controls, it becomes a menu button which can display subitems on a popup menu. Here are some elements from another program.

Fig.7-4: Ribbonbar Controls
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7.3 Add a new Evaluation & Chart
To add a new chart (and an evaluation), you can click on any chart in the left
Thumbnail bar (Nevertheless, a MDI window is available or not). → That’s it!

Nevertheless, here we will call the Pulldownmenu File → New → New Evaluation or
simple use the key <Ctrl + N> to invoke our first empty Graphics MDI window with a
Tab-view on top of the page. That page is called an Evaluation. The file has always the
extension ´*.sx´.

→ Next, use the Ribbonbar category Chart to select a chart in their basic form
(without any setups).

→ To follow the description, please choose the Physics chart (Linear Cartesian).
Below the window, there is a new Tab, right next to the Graphics tab especially for the
data of the new Physics chart (GraphTable).
→ Click on that tab or use key <F3> to swap between the Graphics or Table (GraphTable)
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The chart and table are in relation to each other. The table tab name is equal to the chart name plus the
word “Data”. You can change the name in the chart properties (see chapter 10.8). Swap back to the Graphics
View; use key <F3> again.
For instance, if you copy and paste more charts, then more table tabs appearing with connections to their
charts.
Hint:
If you have more than one chart on your evaluation page, then you can
arrange those with the help of the icon in the Ribbonbar Edit, panel
Alignment Toolbar or use the icon Arrange All Charts from the Ribbonbar
Chart.

Fig.7-5: Arrange Charts automatically (Arrange All Charts)
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7.4 Load Evaluations
To load (or open) an evaluation, please choose the key <Ctrl + O> or use the Pulldownmenu File:
Load Evaluation:

◼ Pulldownmenu File
◼ Menu Load… (Strg + O)
◼ Choose e.g. the path <x:\SimplexNumerica\Examples>
◼ Search for an appropriated ´*.sx´ file and load it...

You can also load multiple evaluations at once. This is called a Project in SimplexNumerica.
Load Project:
1. Choose Pulldownmenu "File | Load | Load Project…".

 Use the Fileselectbox.
2. Choose path and file with the extension ‘*.sxw’.
3. Open the project….
4. To ensure that the project is automatically loaded at the next program
start, please select the menu item:
"File | Project | Load this Project on Start-up".
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You can also use the start-up dialog to load a sample evaluation.
Use the left button in the start-up dialog. Then it opens the
Fileselectbox, it shows you the path to the example folder and subfolders.

Tip
Often used evaluations can be saved into the
Thumbnail window, category “User Evaluations”.
Click with the right mouse button into the
white empty space of the window. Then opens a
popupmenu as shown to the left…
To load it, simply click on its thumbnail

By the way:
There is also a Preview Window available to move and show parts of the view. The red
rectangle is the dimension of the main display. It can be moved and the main display
will be moved, too.
You will find it in the Ribbonbar View.

…
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7.5 What is a Graph?
A graph consists of input (measurement) data (shown by Data Marker); the data behind are called
SampleData plus a (approximation/interpolation) curve; the data behind are called CurveData.
SampleData and CurveData, together they are called GraphData

GraphData = SampleData + CurveData
(GraphData are data arrays behind a graph)
Info:
Each graph can have its own properties for line colors, shadings, math
parameters, etc.

Fig.7-6: Chart with two graphs

•

A Graph is not a chart!

•

A Chart can have more than one Graph.

•

SampleData are shown in form of Data Markers.

•

One marker represents each measurement point.

•

A Graph is called a Series in several other programs (Graph or Series, it is the same term)!

Series = Graph = Sample Points + Curve Points
•

A curve consists on calculated sample data called CurveData.

•

Is there more than one graph in a chart than there is a current (active) one (highlighted).

•

Is there only one graph in a chart than the current one is this.
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7.6 Add a new Graph
Let’s add again a chart from the thumbnail window and then add one or more
graph(s) to this chart.
→Please close all evaluations (pages).
→Please click on this symbol Physics or move it to an empty page.

Then click on the Ribbonbar Graph icon Fill Curve

to let the curve unfilled.

Add a new graph to the chart:
Either use the Ribbonbar Graph, icon New Graph or right-click in the Chart Explorer
on Graphs…

Add a new Graph in the Chart Explorer…

Edit a new graph name…

Use this icon here (Ribbonbar Graph) to modify the active graph
inside the chart.
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Drop the mouse over the chart and…

…hold down the left mouse button on a marker, hold it and move
the marker around.

Left click on the Gold Pin and choose Properties to see where
they are, or
Left click on the Gold Pin and choose Marker & Lines, directly.
After making some style changings in the Properties you can
select the graph in the Chart Explorer.

Select Numerical Algorithm Properties and choose a Cubic Spline
to fit the new data values.

To get something like this…
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Next, we will add a third graph to the chart, but this time with the help of the GraphTable Editor.
To show the data, please press key <F3> or click on the tab.

, but before…

Info
The name of the chart can be different.
If you like, then you can change the name here in the
Properties.

Now, please press <F3>…

After swapping to the GraphTable, please switch off the z-Column for now…

Now, insert a new graph from the
GraphTable Ribbonbar.

→ Edit the new data columns with dummy
values and then switch back to the
Graphics <F3>…
If the Chart Explorer does not show the new added graph, then try
to refresh the entries…

Again a Cubic Spline and change the
chart theme…
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7.7 How to edit a HTML file in SxE?
1. Double-click on the red pin

from a (chart) text label.

2. Click on the button Advanced Editor – SimplexEditor (SxE)

3. Edit the HTML text in the Design Mode of SxE and apply.

4. Double-click afterwards again on the pin o see the HTML text.

5. …and click on the Tab SxE-View
6. Here you can edit the text again but always after the first definition in SxE (without to call SxE
explicitly again).
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7.8 How to import a HTML file in SxE?
You can export, for instance, a GraphTable (table) as an HTML file from the SimplexNumerica File menu (as
described within chapter 13.1.12).

Now, for instance, if you want to show the table (or parts of it) as a HTML label around its chart, then you
can either import the previous saved file in SimplexEditor (SxE) or you can use the new function Add Grid
Label (see next chapter). First, we will show how to import a HTML file with the help of SxE.
1. Right-click on Labels in the Chart Explorer.

or
2. use the Ribbonbar Chart

3. Choose Add Chart Label
4. In the next dialogbox, use e.g. GraphTable (or “My nice Table”) as label name.

5. Click on the button Advanced Editor – SimplexEditor (SxE)
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6. SxE should open…
7. Design Mode in SxE should be activated…

8. Now, load the previously saved HTML file.

9. And press Button Apply or Apply & Ok

10. Click on the label pin

or select the label in the Chart Explorer

11. and click on the Tab SxE-View at the bottom of the page.
12. Use the SxE-View to format or edit the table as you like...

These steps are too fiddly for a normal usage. You can use the Ribbonbar icon Add Grid Label (see next
chapter) to do that in one step.
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7.9 Add Grid Label
Use this menu to add a table (= grid) from the GraphTable to its related chart.

Fig.7-7: Label made by Table

➔ To do that, please select a chart, then press <F3> to swap to the GraphTable and then select or do
not select a data range in the table and afterwards press the icon Add Grid Label in the GraphTableRibbonbar.
➔ If the layout of the table does not fit your needs, then you can use the SxE-View or SimplexEditor
(SxE) to modify its format, size and content.
Here we will demonstrate this in the SxE-View.
1. Use the Physics plot from the Thumbnail-Window.
2. Press <F3>, hide the z-Columns and use icon <Add Grid Label>

Page 45 of 372

SimplexNumerica V21

-46Start-up

3. You will see this:
and maybe find, that
-12 is not well formated. The dash is in the line above. → Change that in the SxE-View:
4. Click on the table pin

(means select the table label)

5. Click on the SxE-View-Tab at the bottom of the page.
6. Click on the right side of the table (Activates the border of it).

7. Move the size of the table…

8. To apply, please click on the Graphics Tab.

The result looks like:
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8 Chart Impression
8.1 Chart Architecture
SimplexNumerica uses a component-based drawing architecture - especially for charts.
Components are display-panel primitives (like lines, rectangle, etc.) that include
attributes that manage background, border, and foreground appearance. Available
components provide background panels, titles, labels, legends, and graph displays.
Charts are constructed by allocating components of various types, setting desired
attributes, and adding the configured components to a list of properties. Data objects
are stored in another list. A serviceable chart can be produced by a few lines manually
or via script code that create display components. SimplexNumerica automatically
configures the chart to fit the data. The axes are properly scaled. Lines, bars, and other
filled polygons are drawn in various colors and styles according to the amount of data
displayed. This configuration is done for each draw cycle, so that the chart responds
instantly to changing data and style settings. More complex, presentation-style charts
or Business Charts can be produced by creating additional components. You can specify
various style settings to enhance the appearance of the chart. Several samples are
provided to demonstrate the various ways to enhance charts.
SimplexNumerica supports a few main basic chart and axes types optimized for speed
and performance. They are called Science Plots and can be found in the Thumbnail
Window, too. To select one of these basic charts, click on any picture in the Thumbnail
Window.
Each chart type may support a limited subset of the available axes types. The more
advanced axes type is the Physics Chart. This is also called a Cartesian-coordinatesystem.
Some chart types require data supplied in a specific format. Furthermore, the chart type
determines what effect the various style objects contained in the display component,
the data lists, and the individual data items have on the graphic elements.
The following topics describe the supported chart types and present some
implementation details. It is convenient to organize the chart types according to the
axes types supported.
The thumbnails images (see left picture) show how data are represented in the basic
chart types. These small pictures do accurately represent the visual quality of normalsized charts produced by SimplexNumerica.
Hint
Be aware that the inbuilt cursor function are made for Cartesian Coordinate
Systems like the Physics charts, only.
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SimplexNumerica supports the following Chart features:
❖

2D and 3D charts

❖

Unlimited number of charts and graphs

❖

Unlimited number of Data Points (SampleData and
CurveData)

❖

Conversion between compatible charts on the fly

❖

Conversion without clearing and adding new data

❖

Ability to display different graph types on the same
chart area

❖

Customizable Data Markers for Data Points

❖

Customizable Data Labels for Data Points

❖

Inclusion of individual Data Points to Legend

❖

Tooltip support

❖

New Labels support

❖

Missing Data support

❖

Nearly Real Time Charting

❖

Data Point values can be modified on the fly

❖

A graph series can automatically remove data points
when the specified history depth is reached

❖

Automatic Coloring of Curves and Data Points

❖

Some charts with its properties like outline, fill and text
colors are automatically colored according to the
currently selected color theme

❖

etc.
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8.2 Chart Thumbnails
The Thumbnail window shows you a chosen part of the chart object library. Everyone
can extend the library. You can put your own objects into the Thumbnail window (→use
right mouse click inside).
To test it, click on the Physics picture of the Science Plots register to activate a new
evaluation view (if not already there) and to put this chart object on top of the view.
The program selects the chart object and you can change the associated properties
inside the Property Window.
Info:
Against other programs like MS Excel, a chart is the main object; data are only part of it.
To show the data, please press key <F3> or click on the tab.

Click on the tab Graphics
to go back to
the chart. The chart is still selected. Now, if you click on another thumbnail picture, then
two possibilities of viewing this new chart are available. First, the new one is going to
exchange the old one or the new one will be put beside the old one. SimplexNumerica
has the following rule: If the old chart is selected, then the new one will remove it and
will be placed on the same position. However, the data will be used from the old one. If
there is no chart selected, then the
new one will be placed beside the old
one and have its own (default) data.
By the very first time of clicking a second chart,
SimplexNumerica will show the following dialog, so that the
user can decide what to do.
Before you press the Default button, please select
so that SimplexNumerica
can make its default rule or let it and press what you want
to do.
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Here are the rules:
Question: Replace selected chart or insert a new chart?
a) If there is no chart selected, then the chart behind this thumbnail would be
added to the page!
b) If one chart is selected, then the selected chart will be replaced by the
object behind the thumbnail!
c) If you drag and drop a chart from the thumbnail window to the Graphics View,
then always the new chart will be placed without to replace the possibly selected
chart on the page!

Use right mouse button!
When you click with the right mouse button inside the thumbnail window, then a popup menu - as shown in
the next picture - appears:
The menu item Open does the same as above described.
Show Thumbnail and Show Text do what they describe.

8.2.1

Add selected Object

Adds a selected chart to the Thumbnail window.
Please select a chart and call this popup menu. Then enter a name for the new thumbnail object:

Now you can see the chart add to the thumbnail window:
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Fig.8-1: Chart added to Thumbnail Window

8.2.2

Add Template Object

Adds the selected chart as a template (without data) to the Thumbnail window. It is the same procedure as
before.

8.2.3

Remove Thumbnail

Removes the object from the Thumbnail window.

8.2.4

Add Evaluation
Adds the evaluation (the whole page) to the Thumbnail window.
You can put that to the thumbnail tab, only.
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8.2.5

Add Template from Evaluation

Adds the evaluation (but without data) to the Thumbnail window.

8.2.6

Soft Reset

Make a Soft Reset. Copy original factory thumbnails back to here. However, it does not remove the userdesigned thumbnails!

8.2.7

Factory Reset

Make a Factory Reset. Remove all thumbnails and copy the original factory thumbnails back to here.
Removes the user thumbnails completely from here.
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8.3 Chart Parts
The following picture shows the main chart parts of a chart.

Fig.8-2: Main chart parts

The following table describes the areas:

Pos.

Description

1

Chart Legend
The legend shows the names and colors of the curves.
By clicking on an item in the legend, you can select the
corresponding curve.
The legend entry is marked out with an asterisk "*".
The highlighted entry is selected, the corresponding curve, too.
The curve is then highlighted in bold (but, see picture to the
left, it depends on the checkmark).
The highlighted curve is now the active on!

 Orientation and position of the legend can be changed
using the mouse or the properties.
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Pos.

Description

2

Chart Background
These can be changed by the shape properties.
Hint:
The yellow background in the above picture is from a shape
object, lying behind the chart!

3

Cursor Line
The cursor line marks the point of the curve or the sample
data.

4

Chart Main Axis (x/y)
The x-axis can have a trend timeline. The start and end times
of the trend can be entered by double-click with the left mouse
button. Do it, double-click on ymin (in picture value 0) or ymax (in
picture value 100).
…xmin and xmax can also set by double-clicking on the
corresponding values.

5

Life Sign
Only for Trending: Indicates the status of the trend:

• Yellow → Trend is started
• Gray → Trend is stopped
• Red → Trend being refreshed
6

Labels
Chart Labels are glued on its chart by red pins. Click on such a
pin, hold down the mouse button and move the label around.
Double-click to open its properties.
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8.4 Chart Toolbar
As you may have already noticed the small toolbar on the top left
corner of the chart and you have wondered what functions are
attached to it. These symbols are used to analyze graphs, but
they also offer functions that can be of interest for the
determination of graphs.

The following table explains the features:

Symbol

Function
Lock Move
Controls whether the chart can be moved.
Enabled:
Chart is prevented from moving.
Disabled:
Chart can be moved.
Lock Ratio
Controls whether the aspect ratio during scaling of a chart
remains the same.
Enabled:
Disabled:

Aspect ratio is preserved.
Chart can be scaled unevenly.

Show Cursor Lines
Controls whether cursor lines can be drawn inside the chart.
Enabled:
Cursor lines are available.
Disabled:
Cursor lines are not available.
Show Graph Legend
Controls whether an additional legend is displayed to the
selected trend curve.
Enabled:
Legend is displayed.
Disabled:
Legend is not displayed.
Use <Ctrl> to set it on the right side
Show Active
Controls whether additional text labels are displayed.
Enabled:
Additional labels are displayed.
Disabled:
Labels are not displayed.
Use <Ctrl> for all graphs
Move Graph Labels
Positions the label.
Enabled:
Labels located to the right side.
Disabled:
Labels turning around.

Page 55 of 372

SimplexNumerica V21

-56Chart Impression

Show/Hide the icons on top of the primary Physics chart.
→ Useful if you overlap a label with such an icon.

Tip

Hold down the shift key <Shift> and click on a Red Pin to
move an overlapped label.
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8.5 Chart Themes
After you have placed a new chart on the view, you can change the theme, if you like.
Click on the left combobox and select another theme. The
program will change the charts (graph colors, text, labels,
etc.) and the background of the page.

Click on the button Next to see again another theme or click
on Yes to except the chosen one. Some themes have more
than one constellation. Use the button Retry to click through
the possibilities…

Black and Gold Theme
SimplexNumerica provides two different chart theme settings. The charts up to SimplexNumerica version 11
can be set as described above in this chapter. The new extended BCGControlBarPro chart have their own
theme property entry.
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Fig.8-3: Chart Themes select in properties for new chart types, only

Which chart which theme setting?
To see which chart used which theme, please select the chart and have a look to
the property entry Chart Theme. If it is available, then use it, else use the
toolbar above.

→ If the Chart Theme is available, then e.g. the graph color is set by the theme and not any longer manually
in the properties.
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8.6 Chart Textures
SimplexNumerica supports for each new chart type (BCGControlBarPro ones) chart textures as one of the
themes.

Fig.8-4: Manhattan Bar Chart with Textures

→ Select the corresponding chart and choose the texture theme in the chart properties.

Hint:
Do not forget to set the right Theme Opacity (transparent elements) between 0 and
100 %.
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8.7 Chart Labels
Chart Labels are glued on its chart by red pins.

Fig.8-5: Chart Labels pinned by red pins

Let’s do:
→ Move a chart and the Chart Labels moving automatically, too!
→ Click on a red pin and move by hand!
→ Double-click to call the Editbox.
→ Simply click on a red pin to show its properties.
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8.7.1

Add a new Chart Label
Let’s add a chart from the thumbnail window and then add one or more chart
labels to this chart.
→Please close all evaluations (tab windows).
→Please click on this symbol or move it to an empty page.
→Please have in mind, that a chart label is always related to a chart, whereby
a text label is independent and not fixed on that.

To add a label to a chart, please right click on the Chart
Explorer list on item Labels and choose the menu item Add
Chart Label to open the following dialogbox:

Follow the steps:
→ Select a pre-defined name (Standard Label) or set a new label name, like “My Label”. The dialogbox
below shows a Standard Label “Header 2” with an edited text…
→ Place the cursor in the edit field and choose a Greek symbol on the right list.
→ Define a tag as placeholder.
→ Use the Advanced Editor… for extra word processing (see chapter 17).
→ Set a Database Link … dedicated to this chart label (see chapter 16.3.4).
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→ Click on OK to leave the dialogbox.

→ Click on the Red Pin, hold down the left mouse button and drag the label around.
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8.8 Chart Axes
Hint:
Please have a look at chapter 13.4.3 ff.

Fig.8-6: Different Chart Axes around the Physics Chart, only

•
•
•
•
•
•
•
•
•
•

An axis can display or hide at its place.
You can customize the range of each axis or by AutoScale.
You can assign each axis to a Graph.
Cursor have small indicators on the assigned axis. You can see which graph belongs to which axis.
Customizable Major and Minor Tick Mark size.
Major and Minor Tick Marks can be hidden.
Cross the Axis.
Display outside the Axis.
Display inside the Axis.
The outline color, size and stroke style of each Axis Line and Tick Marks can be customized

Date/Time Mode
The X axis can be set to the date mode. In this mode it treats the X component from related graph series as
date/time values, calculates the Major Unit and formats the labels accordingly.
AutoScale - Automatic and Manual Scaling
•
•
•

Use AutoScale to calculate min/max range and the required scale.
You can specify a fixed display range for an axis and it will automatically calculate the required scale.
You can specify a fixed Maximum Display Value separately.

Page 63 of 372

SimplexNumerica V21

-64Chart Impression
•

You can specify a fixe Minimum Display Value separately.

Cross Type
•

It is possible to specify where an Axis crosses its perpendicular axis.

Logarithmic Scales
•

Any axis can be set to logarithmic scale.

Reverse Order
•

Any Axis can display values in reverse order

Axis Rotation
•

Any series type can be displayed correctly when X axis is vertical and Y axis is horizontal.

Axis scale breaks.
•

Scale breaks can be generated automatically or added manually.

Fig.8-7: Top and right axis for new charts, only

Fig.8-8: Axes Scale Breaks
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8.9 Chart Legend
SimplexNumerica supports two legend layouts: Horizontal and Vertical.

The Legend formatting includes the following customizable elements:
❖ Legend Position and Visibility
❖ A Legend takes left, right, top, top-right and bottom positions
❖ A Legend can overlap the plot area, or take place outside of the plot area
❖ Legend appearance, which includes outline and fill colors, border width and stroke style, text color,
font family and size for legend entries.
❖ A graph series can specify what content should be included into legend entry
❖ It is possible to specify a custom string to be displayed in the legend entry for each Data Point.
❖ Mouse event support.

Fig.8-9: Vertical and Horizontal orientation
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8.10 Graph Data Marker
Data Marker representing the position of the data points of a Graph (Series). Data Marker are on top or
behind a curve. Please use the next toolbar to switch on and off the marker and some other graph settings.

Use the Chart Properties and click on button
change the marker type (or something else).

right to Marker/Lines to

You can also click on the pin on the right side of the graph...

Use the checkboxes in the dialog to set its style.
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8.11 Graph Data Labels
Data Labels are on top on a Graph.
Its formatting includes the following customizable elements:
•
•
•
•
•
•
•

Visibility
Fill color (set by Chart Theme)
Line color, width and stroke style (set by Chart Theme)
Text color, font size and rotation (set by Chart Theme)
Data Label Position (set in properties)
Drop Line to Data Marker. The Data Label’s box is connected with a Data Marker by line.
Draw Data Label Border Box. If this option is turned off, the border around Data Label content is not
drawn and the bounding rectangle is not filled.

The Data Label position is defined by an angle and distance
from Data Marker.
Set the corresponding parameter of the Data Labels in the
Chart Properties.

Hint:
In addition to this, please have a look on
chapter 13.4.16.
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8.12 Cursors

Let’s have a look to the thumbnail window with the name Science Plots. There
are the native 2D charts, which have been optimized over time for both
functionality as well as performance.
The topmost is the Physics Cartesian Coordinate System (see left picture). The
Physics Chart has been optimized with the most advanced functions,
especially the cursor functions.

→ Cursors are only inside the Physics Charts!

→ The other charts have tooltips, only.

8.12.1 Position Cursor Marking Lines
You can position the horizontal and vertical marker lines only in the Physics Coordinate System. The
marker lines are provided with a label indicating the respective X and Y value. This setting is stored in the
evaluation. The marking lines can be moved using its yellow rhombus handles.
The marking lines can be shown like this:
Procedure:
1. Choose a chart.

 On top of the chart a Toolbar3 appears.

3

Use the Pulldownmenu “View | Chart Icons” to make this toolbar visible or invisible.
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2. Click on the symbol "Show Cursor Lines"

 On each side of the chart appearing yellow dots (handles).
3. Click on one of the yellow dots and slide it down on the chart.

 The tag line is getting visible and it appearing labels on the handles.
The respective X and Y value of the line is displayed.

8.12.2 Show Additional Cursor Legend
You can display an additional legend at the left edge of the diagram. That shows the name of a graph or
trend curve. It displays the name of the (trend) graph, selected by the Chart Explorer.

Fig.8-10: Additional Legend appears.

Procedure:
1. Select a chart.

 On top of the chart, a toolbar is displayed.

2. Click on the symbol "Show Graph Legend".

 The Legend appears next to the Y-axis.
It shows the name of the currently selected curve (the active one).

8.12.3 Show Cursor Label and Position
You can display additional labels to the active graph or to all graphs. The labels indicate the value of the
curve at the cursor position.
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The labels can be positioned on the right side or can be distributed over the whole chart.

Fig.8-11: Additional distributed Labelling

When you move the line of the right label, then the text label jumps to the next marker.

Fig.8-12: Additional label positioned flush right.

Clicking with the left mouse button on a label, so that this graph is getting the active graph (or remains the
one).
Procedure:
1. Select a Chart.

 On top of the chart, a toolbar is displayed.

2. To show or hide a label for one or all graphs, do one of the following.
 Label to one graph
• Click on the Symbol "Show active Graph Label".

 The active label is displayed.
 Label to all Graphs
• Click on the Symbol "Show active Graph Label" and press Control
key
+ Ctrl

 All the labels are displayed in the chart.
3. To distribute the labels inside the chart, click on the symbol "Move Graph
Labels".
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8.13 Missing Values
A so called Missing Value or Missing Data Point is marked with a question mark (?) in SimplexNumerica. The
data point can be set as such in the GraphTable.
Hint to Files from older Program-Versions:
If you will see in your tabble a huge value in a cell, then maybe this is the
referecevalue behind the question mark. Change that value in a question mark.

Some charts shown an interrupted graph line (like above) to exhibit the missing ones.

8.14 Uneven Data Points
That means graph columns with different numbers of data points.

dd

Use the character ~ to mark the end of the graph data column.
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→ You can set that character everywhere.
→ Please have a look at chapter 12.11.6.

9 Chart Types
Next chapters are only an extract from the huge diversity of the SimplexNumerica chart gallery (see
Thumbnail-Window)!

9.1 2D Business Charts

2D Area Chart
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Ternary Chart (Triplot)

2D Combined Chart
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2D Business Bar Chart

2D Range Area Plot with the help of the z-Axis
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2D Horizontal Clustered Bar
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9.2 What are Business Charts?
What are Business Charts? I do not know whether this is a fix term. In SimplexNumerica it is simply a chart
without to use the x-columns. Instead it used the (left) Legend column from the GraphTable. Here an
example:

Fig.9-1: Business and Normal Chart

Please use the chart properties to set a diagram to a Business Chart so that SimplexNumerica can use its
Business Graphic routines.

→ Set item Business Chart Graphic to On:

Business Chart

→ Set item Business Chart Graphic to Off:

Normal Chart
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9.3 3D Business Charts
Since SimplexNumerica V12 many new charts were implemented. In particular, the BCGControlBarPro chart
library with its Business Charts in 2D and real 3D form is worth mentioning.

Fig.9-2: Manhattan Bar Chart

Fig.9-3: Stacked Column Chart
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Fig.9-4: Horizontal Stacked Bar Chart

Fig.9-5: Horizontal Manhattan Bar Chart
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Fig.9-6: 3D Area Chart

Fig.9-7: 3D Line Chart
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Fig.9-8: 3D Combined Chart

Fig.9-9: Range Area in 3D
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9.4 Physics Cartesian Coordinate System
The in SimplexNumerica so called Physics Chart is a Cartesian
Coordinate System. It shows you a chart with classic axes. It is divided
into the following axes types:
•

x-linear/y-linear

•

x-logarithmically/y-logarithmically

•

x-linear/y-logarithmically

•

x-logarithmically/y-linear

Hint:
To get more information, please have a look at chapter 0

In addition, the following axes can be displayed:
•

2D Bottom x-Axis {Abscissa}

•

2D Left y-Axis {Ordinate}

•

2D Bottom x- & Left y-Axis

•

2D Top x-Axis {Abscissa}

•

2D Right y-Axis {Ordinate}

•

2D Apart Bottom x-Axis {Abscissa}

•

2D Apart Left y-Axis {Ordinate}

•

2D Apart Right y-Axis {Ordinate}

The classic axes types are used to plot data along the scaled vertical and horizontal axes. Sometimes they are
called Scatterplot. The Scatterplot ordered pairs of data values against appropriately scaled x and y-axes. The
data from one or more records are plotted as a series (in SimplexNumerica called Graph).
Info:
Series = Graph in SimplexNumerica

In SimplexNumerica, there are special Business Diagrams only for y-axes columns.
A Contour Plot or a Contour Map like the next figure use the Cartesian axes with color shading.
The axes can be automatically scaled with the AutoScale function to fit the data values on the coordinate
system. The axes limits can be set to specific values in the properties window. In addition, the appearance of
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the axes can be modified using properties. All axes can completely set to hidden by setting this in the
properties.
The Line graph draws a line connecting the data points of a SampleData record in form of a polyline curve, or
polygon to a closed curve. The data points can be optionally covered by marker or point objects.
Also Vertical Bar Graphs belonging to the physical charts. Their axes types are used to plot data values as
bars, which extend vertically. The bars are spaced evenly across the horizontal axis.
You can show also an isographic pseudo three-dimensional look to the bars in the 2D-Window like these two
Business Charts:
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9.5 Math Chart (Mathematical Chart)
A Mathematical Chart is also based on a Cartesiancoordinate-system. In distinction to the Physics Chart, the
axes cross go always through the zero point.
Some graphical and interactive functions are not supported
for this chart. For manipulation of a chart use the Physics
Chart and afterwards go back to this one.

9.6 Polar Chart
The Polar Chart is a special form of the
mathematical coordinate system. The Polar
chart type is a circular graph on which data
points are displayed using the angle, and the
distance from the center point. The X-axis is
located on the boundaries of the circle and
the Y-axis connects the center of the circle
with the X-axis.

9.7 Radar Chart
A radar chart is a graphical method of displaying
multivariate data in the form of a two-dimensional
chart of three or more quantitative variables,
represented on axes starting from the same point.
The relative position and angle of the axes is
typically uninformative.
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9.8 Ternary Chart (Triplot)
The Ternary Chart is e.g. used if one has a mixture
of three chemical components and likes to see the
coherencies in only two dimensions.
A Ternary Chart can be called Triplot; it is a
triangular coordinate system, in which three
different axes are available. These axes are
however not completely independent from each
other. The following relation applies to it (with
format of numbers in percent):

1. If the third axes are given, then the sum of the 3 axes corresponds to 100%
2. If only 2 axes are given, then results the third from xC = 100 - x A - x B
In the properties you can set the specific parameter of a Ternary Chart.
To Pt. 1:
SimplexNumerica calculates the sum and divides these afterwards by 100 from the 3 columns:
Value% = {Column1(i) + Column2(i) + Column3(i)} / 100
Then each column is set to:
Column 1 % (i) = Column 1 (i)/ Value%
Column 2 % (i) = Column 2 (i)/ Value%
Column 3 % (i) = Column 3 (i)/ Value%
To Pt. 2:
SimplexNumerica calculates the third column and from 2 columns:
Column 3 (i) = 1 - Column 2 (i) - Column 1 (i)
To Pt. 1 and 2:
•
•
•

Column 1 is equal to x-Axis.
Column 2 is equal to y-Axis.
Column 3 is equal to z-Axis.
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9.9 Line Chart
A Line Chart has the following features:
•
•
•
•
•
•
•
•
•
•
•

2D and 3D modes
Simple Line
Stacked Line
100% Stacked Line
Stacked groups
Curve Lines
Step Line
Reversed Step Line
Auto Coloring of individual lines
Closed Shape with fill
Theme Support

Fig.9-10: 3D Line Chart

Fig.9-11: Step Line Chart

Fig.9-12: Stacked Line Chart
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9.10 Area Chart
An Area Chart or area graph displays graphically
quantitive data. It is based on the line chart. The
area between axis and line are commonly
emphasized with colors, textures and hatchings.
Commonly one compares with an area chart two or
more quantities. Area charts are used to represent
cumulated totals using numbers or percentages
(stacked area charts in this case) over time. Use the
area chart for showing trends over time among
related attributes. The area chart is like the plot
chart except that the area below the plotted line is
filled
in with
color
to indicate volume. When multiple attributes are included, the
first attribute is plotted as a line with color fill followed by the
second attribute, and so on.
An
Area
Chart has the following features:
•
•
•
•
•
•
•
•
•
•

2D and 3D modes
Simple Area
Stacked Area
100% Staked Area
Range Area
Stacked Groups
Curve Area
Auto Coloring of individual Data Markers
Area Origin (area base line differs from zero)
Theme Support

Fig.9-13: Different Area Charts
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9.11 Pie Chart
A Pie Chart (Circle, Doughnut or Torus Charts) is a circular statistical
graphic, which is divided into slices to illustrate numerical
proportion.
In a Pie Chart, the arc length of each slice is proportional to the
quantity it represents. While it is named for its resemblance to a
pie that has been sliced, there are variations on the way it can be
presented.
Pie Charts have the following features:
•
•
•
•
•
•

Chart rotation (ability to specify starting position of the first pie in 0-360 degrees range)
Pie explosion
Individual explosion for each Data Point
Customizable height of pie (for 3D Charts)
Customizable angle
etc.

Fig.9-14: Different Pie Charts
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9.12 Bar Chart
A Bar Chart or bar graph is a chart with rectangular bars with
lengths proportional to the values that they represent. The
bars can be plotted vertically or horizontally. A vertical bar
chart is sometimes called a column bar chart.
A Bar Graph is a chart that uses either horizontal or vertical
bars to show comparisons among categories. One axis of the
chart shows the specific categories being compared, and the
other axis represents a discrete value. Some bar graphs
present bars clustered in groups of more than one (grouped
bar graphs), and others show the bars divided into subparts to show cumulative effect (stacked bar graphs).
Bar Charts have many advanced variations:
•
•
•
•
•
•
•

2D and 3D modes (incl. Manhattan Charts)
Simple Bar Chart
Stacked Bar Chart
100% Stacked Bar Chart
Range Bar Chart
Side-by-side stacked (stack groups)
Side-by-side 100% stacked (stack groups)

Settings
•
•
•

Set the Column and Bar distance
(specifies how the columns or bars fit the major unit)
Column and Bar separation and overlap
…and much more properties to set…

Science Bar Chart

Fig.9-15: Different Bar Charts
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9.13 Trending Charts
A Trending Chart is a graphical representation of
time series data (information in sequence over
time) showing the trend line or curve that reveals a
general pattern of change.

Fig.9-16: Trending Chart

9.14 Box-Whisker Charts
A Box Plot or Boxplot is a way of graphically depicting
groups of numerical data through their quartiles. Box plots
may also have lines extending vertically from the boxes
(whiskers) indicating variability outside the upper and
lower quartiles, hence the terms box-and-whisker plot and
box-and-whisker diagram. Outliers may be plotted as
individual points. Box plots are non-parametric: they
display variation in samples of a statistical population
without making any assumptions of the underlying
statistical distribution. The spacings between the different
parts of the box indicate the degree of dispersion (spread) and skewness in the data, and show outliers.

9.15 Bubble Charts
A Bubble Chart is a type of chart that displays three
dimensions of data. Each entity with its triplet (v1,
v2, v3) of associated data is plotted as a disk that
expresses two of the vi values through the disk's xy
location and the third through its size. Bubble
charts can facilitate the understanding of social,
economic, medical, and other scientific
relationships. Bubble charts can be considered a
variation of the scatter plot, in which the data
points are replaced with bubbles. This type of chart
can be used instead of a Scatterplot if your data
has three data series, each of which contains a set of values.
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9.16 Scatterplots
A Scatterplot (or Scatter Graph) is a type of
mathematical diagram using Cartesian coordinates
to display values for two variables for a set of data.
The data is displayed as a collection of points, each
having the value of one variable determining the
position on the horizontal axis and the value of the
other variable determining the position on the
vertical axis.

9.17 Pyramid, Cone & Funnel Charts
These charts are often used to represent stages in a sales
process and show the amount of potential revenue for
each stage. This type of chart can also be useful in
identifying potential problem areas in an organization’s
sales processes. A funnel chart is similar to a stacked
percent bar chart.

Fig.9-17: Pyramid, Cone & Funnel Charts

Page 90 of 372

SimplexNumerica V21

-91Chart Types

9.18 Contour Plots/Maps
A Contour Plot of a function of two variables is a
curve along which the function has a constant value.
It is a cross-section of the three-dimensional graph
of the function f(x, y) parallel to the x, y plane. In
cartography, a contour joins points of equal
elevation above a given level, such as mean sea
level. A contour map is a map illustrated with
contour lines, for example a topographic map, which
thus shows valleys and hills, and the steepness of
slopes. The contour interval of a contour map is the
difference in elevation between successive contour
lines.

9.19 Surface Plot
Surface Plots are used to visualize arbitrary rectangular
grids of points in 3D space. Each element in the grid
gets a point in 3D space assigned. In the simplest case,
only the Z coordinates of the points are defined.

Fig.9-18: Surface Plots
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9.20 Smith Diagram
In electro-technology, particularly in the high frequency and microwave engineering, the Smith diagram is
very often used.

Fig.9-19: Smith Diagram

The Smith diagram is the result of the mapping of the right Gauss' number level into a circle area.
The input of the data is automatically standardized on the reference resistance (e.g. 50 ohms). Therefore, for
the point (1,0) an input of x = 50 and y = 0 are necessary. The points are marked by the markers in the Smith
diagram. The point (50,0) corresponds to the origin of the coordinate system in the w-level. They can
represent all points of the right z-half plane in the Smith diagram.
The Smith diagram is one of the most useful graphical tools for high frequency circuit applications. The chart
provides a clever way to visualize complex functions and it continues to endure popularity decades after its
original conception.
Additional information can be found here: http://en.wikipedia.org/wiki/Smith_chart
Specific information follows next…
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From a mathematical point of view, the Smith diagram is simply a
representation of all possible complex impedances with respect to
coordinates defined by the reflection coefficient.

The domain of definition of the reflection coefficient is a circle of radius
1 in the complex plane. This is also the domain of the Smith diagram.

The goal of the Smith diagram is to identify all possible impedances on
the domain of existence of the reflection coefficient. To do so, we start from the general definition of line
impedance (which is equally applicable to the load impedance)

This provides the complex function

we want to graph. It is obvious that the result would be applicable only to lines with exactly characteristic
impedance Z0.

In order to obtain universal curves, we introduce the concept of normalized impedance

The normalized impedance is represented on the Smith diagram by using families of curves that identify the
normalized resistance r (real part) and the normalized reactance x (imaginary part)

Let’s represent the reflection coefficient in terms of its coordinates
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Now we can write

The real part gives

The imaginary part gives

The result for the real part indicates that on the complex plane with coordinates (Re(Γ), Im(Γ)) all the possible
impedances with a given normalized resistance r are found on a circle with
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As the normalized resistance r varies from 0 to ∞, we obtain a family of circles completely contained inside
the domain of the reflection coefficient | Γ | = 1.

The result for the imaginary part indicates that on the complex plane with coordinates (Re(Γ), Im(Γ)) all the
possible impedances with a given normalized reactance x are found on a circle with

As the normalized reactance x varies from -8 to 8, we obtain a family of arcs contained inside the domain of
the reflection coefficient | Γ | = 1 .

The Smith diagram can be used for line admittances, by shifting the space reference to the admittance
location. After that, one can move on the chart just reading the numerical values as representing
admittances. Let’s review the impedance-admittance terminology:

Impedance = Resistance + j Reactance
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Impedance, denoted by Z, is an expression of the opposition that an electronic component, circuit, or system
offers to AC (alternating current). Impedance is comprised of two independent scalar (one-dimensional)
phenomena: resistance and reactance. Both of these quantities are expressed in ohms.

Admittance = Conductance + j Susceptance

On the impedance chart, the correct reflection coefficient is always represented by the vector corresponding
to the normalized impedance. Charts specifically prepared for admittances are modified to give the correct
reflection coefficient in correspondence of admittance.
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Since related impedance and admittance are on opposite
sides of the same Smith diagram, the imaginary parts
always have different sign. Therefore, a positive
(inductive) reactance corresponds to a negative (inductive)
susceptance, while a negative (capacitive) reactance
corresponds to a positive (capacitive) susceptance.
Numerically, we have the left relationship.

9.20.1 Program Parameter
Please use the program properties to setup the right Smith Diagram parameters.
The scaling factors are used for multiplying the geometry
with a real value.

The diagram properties are used to change the look of the chart.
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10 User Interface
The following figure shows the typical structure of the user interface of SimplexNumerica. In the example,
the toolbars and windows are arranged highhanded. After that, it was clicked on the left thumbnail picture
with the name Functionplot (see no. 4).

Fig.10-1: User Interface with different areas

The program is divided into the following areas:
No.

Description

1

Ribbonbar with its Toolbar
This area shows the Ribbonbar Tabs and their toolbars.

2

Chart Explorer
The Chart Explorer displays the name of the graphs and the other elements of the
diagram. It offers the possibility to hide individual graphs or components.

3

Chart Properties / Output Window
In this area, there is a window "Chart Properties" and "Output window". Between these
windows, you can switch the tabs at the bottom of the window.

4

Thumbnails
Thumbnails are sample objects, mostly charts, but also evaluations, templates and
template objects that were stored.

5
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No.

Description

x

Tab-view (Graphics View or GraphTable)
This is the main output window of an evaluation. An evaluation can contain several charts
or shapes, and text objects.
In the lower part of the window, you can switch between chart and table. Between these
windows, you can switch either with the tabs at the bottom of the window (where x is
pointing) or by pressing <F3>.

10.1 Evaluations
An evaluation is the sum of the content of all layers within a page inside a MDI window with its bottom tabs.
The left Ribbonbar Pulldownmenu File can be used to
◼
◼
◼
◼

Make a new evaluation
Load an existing evaluation
Reload an existing evaluation
Save, open and close evaluations

◼ Store reports in the thumbnail window (use <F7> to show)

Fig.10-2: Evaluation Page
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10.1.1 Sample Folder
Please have a look to the sample folder (e.g. path for x64):
C:\Program Files\SimplexNumerica64\Examples

There are many simple examples for different purposes.
You can use the key <F1> or the toolbar icon
path.

to call the start-up dialog with a button to the example

10.1.2 Load an existing Evaluation
You can always load (open) another evaluation. It will be loaded and added right to the other tabs.
Procedure:
1. Select the menu item "File | Open…" (Key: <Strg + O>)

 The "Open" Fileselectbox will appear.
Evaluations have the extension *.sx.
2. Enter the path and file name in the Fileselectbox.
3. Click the "Open" button.

10.1.3 Reload Evaluation
You can load an already open evaluation again. This can be useful for example, if you have made any
accidental changes and want to restore the original state in a simple manner.
Procedure:
1. Select the menu item "File | Open | Reload" or press the
key combination <Ctrl + R>.

10.1.4 Save and Close Evaluations
SimplexNumerica offers you a number of clever ways for saving and closing evaluations.
◼ Save
Saves the evaluation under its name.
◼ Save As…
Saves the evaluation with a different name.
◼ Backup (Save Copy As…)
Saves a backup of the evaluation with a different name.
◼ dto., but opens it in a new Tab.
◼ Save All
Save all evaluations.
◼ Save and Close All
Save and Close all evaluations.
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◼ Save and Close All but this
Saves all evaluations except for the active one.
◼ Close
Close the active evaluation.
◼ Close All
Close all evaluations
◼ Close All but this
Close all evaluations except for the active one.

10.2 Evaluation Window
The evaluation page shows the content of an evaluation (charts, shapes, text, etc.) in the Graphics View and
the data table in the GraphTable View.
Between the two views of representation - Graphics and GraphTable - can be switched with the function key
<F3> or the tabs at the bottom of the window.
The name of the GraphTable tab is equal to the chart name plus the word Data.

◼ Tab "Graphics"
Shows the graphical representation of the evaluation.
◼ Tab <Name of the Chart> plus the word Data
Invokes the data representation of the corresponding chart in form of a
table with arrays, so called GraphData.
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10.2.1 Graphics View
In the evaluation window, several charts can be available, simultaneously. An evaluation can also consist of a
rectangular shape without any data, e.g. only a simple rectangle.

Fig.10-3: Main Window and Tabs for the Evaluation

The following table describes the areas:
No.

Description

1

Tabs for open evaluations → Project
With these tabs, you can switch between the evaluations. The sum of all
available evaluations is a project. → However, if it is just being stored as
such. If it has been stored, it can (of course) be used as such and also
reloaded.

 Several evaluations can be saved together as a project.
2

Evaluation
Graphical representation of an evaluation. An evaluation can contain
different numbers and other types of charts and shapes (rectangles,
images, etc.).

3

Different Charts
Inside the charts, the data is displayed as each individual graph. A graph
consists of measurement data (SampleData) and curves (CurveData).

4

Tab of the GraphTable(s)
With these tabs, you call the tables and switch between them in order. An
evaluation owns for each chart a table of data.

5

Tab of the Graphic
With the tab "Graphics“, you get the Graphics View in the foreground.

Use the tabs above to change between the evaluations:

The next chapter shows some parts of an evaluation window.
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10.2.2 GraphTable View
In this view, you can edit the table data related to just one chart. Use the icons of the Ribbonbar
GraphTable. Remember: In early program versions was the table called DataSheet.
Hint
Has an evaluation several charts included, then there is a GraphTable (view) for
each chart.

Fig.10-4: GraphTable View.

The current graph data (in this case, the measurement data) by default, when switching from the graphics to
the table, will be selected (highlighted in blue).
If the box is checked on View (→Data View Mode), the table shows only a view (you
maybe knows that from a database) to the actual data. This means that the data
displayed (and only the displayed ones) were quickly brought out of a large buffer.
However, in the view mode, the tables can be edited only limited compared to the
actual tables mode (View is unchecked).
In TableMode (no cross in front of View), the data can be processed similarly as in Excel. For example, the
cursor is in the last line, a new line can be inserted below with simply pressing the return/enter key.
Info
SimplexNumerica has two modes for entering data within the same worksheet. The
TableMode as an easy editing mode compliant with Excel and the ViewMode for fast
presentation (especially with many measuring data) and for easy data entry.

The following table describes the fields marked with numbers in the above image:
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Pos

Description

1
Ribbonbar
GraphTable

The name of the chart is on top (here “My Chart”).

2

Ribbonbar Entries
Provides functionality to edit the table.

3

Table

 See different chapters for this
 The Z-table columns can be hidden.
4

Tabs
With these tabs you can switch between:

• GraphTable and Graphic
• Other tables of the same evaluation.
• Use key <F3>

• Use Icon
➔ Please switch back to the Graphics display → Press <F3>
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10.3 Projects
A project is defined as the sum of all open evaluation and script Tab-views. Tab-views can only be added to a
project if they are open, and removed if they are not available when you save the project, again.

A project can only be created by giving it a file name. Projects are saved into the file that you specify which
may be located anywhere on your hard drive. Project files use the extension ".sxw" (w: workspace).
Once you have created a project, you may open it later using the command on the File menu. There is also
an option to reload the last project when SimplexNumerica starts.
Other commands, on the Project submenu of the File menu, allow you to close a project or to save it under a
different name.
When you close a project using the Close command, you will be asked if you want to save any changes. If you
open another project without closing the current one, it will be added to the others.

Fig.10-5: Project Menus.
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10.3.1 New Project
Before we want to explain the Projects in SimplexNumerica, we need to load some evaluations, e.g. from the
Example folder. Press key <F1> and choose some examples and a few scripts in the Start-up dialog.
Then use the menu from the Ribbonbar →File,
→Project, →New Project…

Now, select (set checkmark) in the upcoming dialog…

…all evaluations and scripts that you want to put into the Project file; or use
to do that what it says.
Enter a path and filename for the Project. Press Save Project.
That was one possibility to make a project file. If you always want to put all open evaluations/scripts into a
project file, then you can use simply the next chapter…
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10.3.2 Create a Project
From the File menu, choose Project, Save Project.... The
Save As dialog box will be displayed, with the project
name with extension [*.sxw], initialized to the current
folder.
If necessary, change the name to something more
appropriate, and browse for the folder you want to save
it.
Click Save.

Hint
When you choose Save & Close Project, then all the evaluation files will be
closed, after saving.

10.3.3 Load Project
It loads all previously saved evaluation files (as a new project) into the workspace.
To open a project:
1. From the File menu, choose Project, Load Project... The Open File dialog box will be displayed.
2. Browse for the project file you want to open.
3. Click Open.
Note:
If you have already evaluations tabbed, then the program will add the new files
to the Tab rows.
If the program cannot find the absolute path from each evaluation, as specified
by the project, then it starts searching from the root folder downwards.

10.3.4 Save Project
It saves all evaluation files as a new project. To save an existing project, choose the Project → Save Project...
command from the File menu.
Note:
The program will save the absolute path from each evaluation inside the project
file.
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10.3.5 Save & Close Project
Use this menu item to save all evaluation and script files as a new project and to close all windows.

 To close a project, choose this command from the File menu. You will be asked if you want to save any
changes, then the project and all evaluations in it will be closed.

10.3.6 Load this Project on Start-up
It loads all previously saved evaluation and script files during the start-up of the application.

10.4 Extended Keyboard Navigation
There is a new function to switch between MDI windows in SimplexNumerica:
→The extended application keyboard navigation.
Implemented in SimplexNumerica is a Microsoft Visual Studio-like MDI Windows Navigator.
The keyboard shortcuts <Ctrl + Tab> and <Ctrl + Shift + Tab> can be used to invoke the left menu.

Fig.10-6: Extended Keyboard Navigation

Click on an item will open the corresponding window.
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10.5 Layers
You can separate your canvas (→ content of the evaluation page) in several layers. You can think of a layer
as a stack of transparent sheets of paper, to which you can attach charts, shapes and drawings. Then, you
can change the order of the “stack” to view and work with a different set of items. Layers provide a way to
keep items separated so that they cannot interact with each other, and so that you can hide an entire set of
items from view with a single click. Although most visuals do not require the use of layers, there are several
common applications. For more than one chart on screen, it may be desirable to place each on a different
layer.

10.5.1 What is a Layer?
Another example to above: You can imagine the Graphics View consisting of transparent foils lying over each
other, but here the foils are called layer. Each object (chart, shape, etc.) can be set on different layers. To
show that, invoke the Layer Window (key <F8>):

Fig.10-7: Layer Window beneath the evaluation page

Here, in the picture above, the cylinder shape lies on layer “Frame” and the text shapes are lying on the so
called “Calc” layer. The names can be renamed in the Layer Window itself or in the shape properties. To
place a chart/shape on a different layer, use the properties or related toolbar.
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Use the buttons in the Layer Window to Activate/Delete/Move (Up/Down) or to make a New Layer. The
appropriated layer has to be selected. Do not use the name cell for selection, because it is for renaming a
layer.
Hint:
Parallel to the movements here in the layer, certainly objects can be set in
position with the Ribbonbar Edit, Toolbar Format. You can set objects (= charts &
shapes) in different z-order
Note:
Only shapes or free text can be rotated. To rotate labels inside charts, please
use their properties.
Use the Zooming toolbar to zoom the display inside the view or the magnifier for
details.

Use the properties to put a shape on another layer.

Please have a look to next chapter for more information…
Click on an object and change its z-order with the help
of the Edit Ribbonbar toolbar.

Note:
You can set the z-order via the Format toolbar, but always on the same layer,
only.

Please have a look to the Selection Toolbar (next chapter). You can display either the layer from the selected
shape or the active layer, respectively. Use the next icon to swap its functionality.
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10.5.2 Ribbonbar with Layer Icons
Two toolbars are helpful when working with layers. The first is the View Toolbar, where you can
find the icon to display the layer window.

The second is the Selection Toolbar. It has two icons for switching between the
currently ‘Active Layer’ and the associated ‘Layer of selected object(s)’. In
addition, it has a combobox to switch between the available layers (and set this layer to the selected object).
If this Icon is selected, then it shows the layer name of the selected chart/shape in the combobox.
Change the name in the combobox will move the selected shape in another layer.
If this icon is selected, then it shows the active layer name in the combobox. Change this name will
activate the other layer.
Info:
A shape cannot be assigned to multiple layers.

Left icon selected. Use this combobox to select the active layer.

Right icon selected. Use this combobox to place the selected shape to this
layer.

10.5.3 Layer Window
You can open/close the layer window with the icon
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When you select a shape in a drawing, the layer, to which that shape is assigned, appears in the combobox
of the above-described toolbar. You can see the name of the shape also in the right column of the layer
window.

Adding a Layer
When the page you are using does not include the layers you want, you can create layers of your own.
Suppose your drawing contains a layer called AroundChart1. You might want to refine that further by
creating a layer called AroundChart2. That way, you could easily distinguish chart1 related objects from
chart2. The following steps describe how to add a layer:
1. Show the Layer Window (use <F8>)
2. Choose New in the Layer Window.
3. Double-click on the name to rename it.

Activate a Layer
SimplexNumerica puts new objects always on the active layer!
To activate a layer
1. Select the layer in the toolbar

or

2. Click in the corresponding row in the Layer Window
3. Click on the button

in the Layer Window.

Rename a Layer
You may want to change the name of a layer that you create to
something that better describes the shapes or charts that it contains.
Even though SimplexNumerica lets you rename predefined layers, it is
best to use this option when you are working with layers that you
create.
→ Simply double-click on the name in the left column in a cell of the
layer window.
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Assigning Shapes to Layers
The Layer Window will show you which shapes/charts
are belonging to the different layers.
Now, if you like to change the layer for a shape, then
you can do it as described above in the toolbar
or in the shape properties.
You can see in the left picture the entry “Put on Layer”.
To the right is a combobox where you can see the
actually layer of this selected shape and where you can
change it to another layer.

Protecting Layers from Changes
After you go to all the trouble of defining layers and adding shapes to them, nothing is worse than another
user (or yourself) accidentally deleting or changing them. You can protect a layer from changes by locking it.
After you lock a layer, you cannot move, change, or delete shapes — you cannot even select them. You also
cannot add shapes to a locked layer.
The following step describes how to lock a layer:
➔ Simply uncheck the column Selectable in the row of the layer that has to be
deactivated.

Hiding a Layer
One of the big advantages of using layers in a drawing is that you can turn them off when you do not want to
display their shapes. Suppose that you want to work on the placement of movable charts in your layout. You
will want to display the layers that contain the legends or arrows to data points or in another scenario; you
might know that some shapes are covering other shapes.
The following step describes how to hide a layer:
→ Simply uncheck the column Visible in the row of the layer that has to be hidden.
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Inhibit a layer
Text Shapes placed on inhibit layers will be ignored during calculation (see Ribbonbar Interface, Recalc
Labels).

They will be also separated inside the Chart Explorer.
In this example, Rectangle.2 and Rectangle.4 are lying on an
inhibited layer (not necessarily the same layer).
Tip
If you have a lot of shapes lying on different
layers on a page and some of the shapes (like
lines, legends) are not used for recalculations or
database queries, then it is better to separate
these from the essential ones.

Move Up/Down
Use the layer window buttons up and down to bring individual shapes on top or behind other ones.

Tip:
To change the order of shapes you should use this toolbar, first:

With these icons, you cannot move to another layer!
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10.7 Chart Explorer
The Chart Explorer lists the charts and shapes (rectangles,
connectors or others), labels, axes and frames.
The left picture shows two main notes: Charts and Shapes. Here in
this picture, the shape note is empty (nothing in there), but chart
note is filled with one chart (SimplexChart.3) and this with one
graph (Data 1).
→ You can change the name of the chart also in the properties, e.g.
in "My Chart".
Then “My Chart” has Graphs, Labels, Shapes and Frames as knots.
Each Graph has data points (Marker) and one curve. Both can be
hidden, too.
The left picture shows only one Graph: "Data 1".
You can open the Chart Explorer window with the menu item Ribbonbar View | Chart Explorer" or the
function key <F4>.
Here another example:

In the upper part of the Chart Explorer is a toolbar with the
following functions:
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Symbol

Funktion
Refresh of the Tree-control
If it happens that the program does not automatically update
the content of the tree control, then you can do it manually with
the help of this icon.
Expand all trees below.
Adds a new graph.
Makes a new graph inside the active chart.
You can edit the name of the new graph in an in-place opening
edit field.
Bring active graph on top.
Moves the graph to a next higher level.
Moves the graph on the next lower level.
Bring active graph behind.
Search Graph or Shape Entry.
Rename all Graph entries.
Rename all Shape entries.
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10.8 Chart Properties
You can open the Chart Property window with the menu item "View | Chart Properties" or the function key
<F5>.
The above Chart Explorer shows the name of the charts (like
SimplexChart.3). Click on this and activate the Chart Properties in
the window beneath to it. Here is also a good place to rename the
chart.
The properties are separated into categories. Each category has its
own attributes, settings and user actions.
Only for Experts:
To change the name of the chart via script, write
SetProperty(). Left mouse click on den box right to Chart
Name opens a popup menu

Use this and write a small script:
/*********************************************
SimplexNumerica - Sample Script
*********************************************/
#pragma extension "corelib"
void main()
{
Application app("Simple App");
app.NewEval();
Chart ch = app.MakeChart("My Chart",idChartTypePhysics,100,100,400,300);
ch.SelectPropertyGroup("Chart Properties");
ch.SetProperty(idChartName, "My Chart");
app.SelectChart("My Chart");
}

We cannot describe all properties here. You can click on it and can see below a short description and the
name of the script function.
Use the icons in the toolbar to invoke the categories and other functions. The corresponding properties are
displayed and can be edited.
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The categories can also be accessed from the combo box above the toolbar:

Are too many properties available, so you can search for...

The following table explains the functions of the Property toolbar:
Symbol

Funktion
Categorize
Sorts the properties by category.
Browse Alphabetically
Sorts the properties alphabetically.
Expand All
Minimized or maximized the list of properties.
Page Format
Shows some properties around the page (canvas).
Graphs
Displays the category "Graph Properties".
Algorithm
Calculations and algorithms especially for this active graph.
Scaling
Shows the category "Scaling and Interval".
Charts
Shows the category "Chart Properties".
Label
Shows the category "Label & Text":
Trending
Shows the category "Trend Properties".
Import
Shows the category "Import Properties".
(Repeat) Last Edit (for all others)
Transmits last settings on all other graphs.
Recalculation of all graphs
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Symbol

Funktion
Swap between SampleData and CurveData
Swaps the SampleData with the CurveData for the current
graph.
SampleData: Measuring data represented as marker.
CurveData: In general, the real data of the calculated curve
points.
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10.9 Output Window
The Output window displays the program outputs. For example, the
information on the communication with a data source or the calculation
results of an algorithm.
This window is usually in the background of the window "Chart
Properties". It is displayed by clicking on the tab "Output". If the window is
fully closed, then use the menu item [View | Output Window] or press
<F10>.
Fig.10-8: Output Window

10.9.1 Output from Scripting Engine
If a fault has occurred, then the Output Window will be opened by the program and shows you the relevant
row in the text editor. Double click on this line in the Output Window to select the line in the code editor.
You can use the Output Window also via script:
app.Output([string]);
app.Error([string]);
app.Print([string]);

Please have a look to the scripting engine reference for more details about scripting.

Fig.10-9: Script Editor in SimplexNumerica
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10.10

Profiles
A profile is a snapshot of the actual
workspace (environment) of the application.
You can save such a snapshot each time (on
the fly) or when you quit the program (on
exit). Last state, made on the fly, would be
load again. A profile that was saved at the
end of the program can only be loaded during
the start-up of the application.
The next chapters describe some work cases
appropriated to profiles.

Info
Be aware that the content of the profile is saved to the registry. Depending on
your windows operating system security levels, a dialog, to ask for an
administrator password, appears.

10.10.1Load State (on the fly)
Loads the previously saved state of the program environment.

10.10.2Save State (on the fly)
Saves the actually state of the program environment.

10.10.3Save Profile on Exit
Before you can use this menu, uncheck "Auto load/save Profiles" and check the others. To test this menu,
please save everything important to disk and quit the program.
In profiles, the dimension, arrangement of windows and toolbars are saved.
You can do with profiles:
◼ Load profile at startup.
◼ Automatically load profile.
◼ Save profile during the lifetime of the program.
◼ Save profile when you exit the program.

◼ Replace profile at runtime.
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10.10.4Load Profile on Start-up
You can select a profile when you start SimplexNumerica. The precondition for this is that you have already
stored a profile and have not hidden the associated selection dialog.
To test the profiles, please check this menu item and re-start the program.
During re-start, the dialog Open Profile appears.
Tip:
If you do not want to be prompted each time the program is started by the profile
dialog, then you can hide the dialog.
→ Check the entry: Don’t show this again.

Procedure:

1.

Please (re-)start SimplexNumerica.

2. Dialog "Open Profile" appears
(only if you saved a profile in previous session).
3.

Select a profile from the listbox.

4.

Click the "Open" button.

5. SimplexNumerica starts and selects the environment with the
profile settings.

10.10.5Automatically load specific Profile
You can also specify that a specific profile is automatically loaded at startup and saved when you quit the
program.
Procedure:
1. Load the profile that you want to.
2. Select the menu item "File | Profile | Save Profile on Exit".
3. Select the menu item "File | Profile | Auto load/save Profiles".

10.10.6Manually load specific Profile
You can also specify that a specific profile should be manually loaded at startup and automatically saved
when you quit the program.
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Procedure:
1. Load the profile that you want to.
2. Do not select the menu item "File | Profile | Auto load/save Profiles".
3. Select the menu item "File | Profile | Save Profile on Exit".
4. Select the menu item “File | Profile | Load Profile on Start-up”

10.10.7Keep Profile up-to-date
To help you remember to save the final adjustments, let SimplexNumerica remind yourself. Then you will be
asked if you want to save the profile.
Procedure
1. Select the menu item "File | Profile | Save Profile on Exit".
2. When you close the application, a message box will appear.

3. Follow one of the three statements:

→ Save Profile:

Profile will be saved into the registry.

→ Quit Program:

Nothing will be saved.

→ Cancel:

Stop the action.

Hint
Depending on your security levels, a dialog, to ask for
an administrator password, appears, because
SimplexNumerica writes the info into the windows
registry database.

10.10.8Replace Profile at Runtime
SimplexNumerica has loaded a profile, but you will want to use another one. As far as no project or
evaluation is open, you can load a different profile.
Procedure:
1. Select the menu item "File | Profile | Load Profile..."
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 It appears the dialog "Open Profile".
2. Chose a Profile.
3. Click on the button "Open".

 The profile is loaded.

10.10.9Show dialog "Open Profile" again
As already mentioned, there is a possibility to permanently dismiss the dialog by selecting "Do not show this
(dialog) again" in the above dialog. → Bring it back with File | Profile | Load Profile on Start-up.
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11 SimplexGraphics Framework
You can learn here the basics of SimplexNumerica's graphical framework called SimplexGraphics (SxG).
It provides basic elements like line, rectangle, circle and their Properties like pen, brush, font, arrow,
shadow, etc.
Here,
•
•
•
•

you can learn the shape types of SimplexGraphics…
use (HTML) Text, Labels, Legends and more…
All about Connectors…
All about Groups…

11.1 What is SimplexGraphics?
SimplexNumerica based on the new sophisticated rendering engine called SimplexGraphics (SxG), which
produced astonishing graphics and layouts.
SimplexNumerica is also based on the scientific part of the visualization library SimplexGraphics, a C++ library
for 2D graphics objects management (creating, editing, and viewing) and vector image publication.
The SimplexGraphics library is designed as a framework to develop vector based application. It offers a set of
classes that abstract most commonly used shapes and allow user to define/add new building blocks as
shapes. These shapes can be as complicated as a connector (link) that knows how to layout itself when
connecting different components. It can also be as simple as a rectangle or ellipse shape.
SimplexGraphics library also offers many different GUI components to access graphics object's properties,
such as size, rotation angle. It also offers an unlimited redo-undo framework that allows creating a userfriendly application. SimplexGraphics abstracts 2D graphic objects or its derivatives. SimplexGraphics
components support serialization in binary form.
SimplexGraphics allows user to move,
resize and rotate components through
mouse actions. It also allows user to
nudge (change the position by finite step)
using keyboard. All these operations are
abstracted as actions with undo/redo
support.
To visualize the process of moving, sizing
and rotation smoothly, these processes
are decomposed to a serial of smaller
process. The smoothness of the
visualization is decided on the interval
between two mouse move events. If user drags the handle more slowly, the component will be sized or
moved more smoothly.
SimplexGraphics redraws components at the same time user moves/size/rotate the components. This
redraw request is send to all components intersecting with this component under modification.
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11.2 Shape Styles
There are standard shape properties similar to the Microsoft Office packet. We do not like to blow up this
manual with all shape variations and properties. Please feel free to find out what is available…
Here some of the styles:

Arrow Styles
Adding arrow to both or one end of a line or curve is easy to
implement. The library has predefined eight type different arrows.

Pen Styles
Line Cap
Line cap defines all the cap of a line is drew.

Line Join
Line join defines all the join of a poly line/curve is drew.

Brush Styles and Hatch Pattern
Brush property stores all the data that describe brush object or fill property. Use complex gradient and
hatch pattern for filling or simpler pattern to store solid brush, which has one color. This basic brush is
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suitable for cases that thousands or even more objects are
visualized at real time, because gradient fill and hatch fill are
time consuming.

Dash Style
SimplexGraphics supports five dash style and
also allow user to define its own dash pattern.

Dash Cap
Dash cap defines the line's cap in the dash line.
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Compound Pen Style
SimplexGraphics addresses the needs of compound pen
style. It has defined the following special line style.

Line Offset
When drawing a polygon, if using pen width more than 1
pixel, user can choose different inset value (0, 1). If inset
offset is set to be 1, the poly line will be inset. See following
example of a rectangle, which the red dash line is the logical
path of this rectangle.

Using brush in a pen
Default pen use a solid brush to rend the path. It is possible to use any sophisticated rendering brush
(gradient, hatch or texture) brush in rendering a curve. Following examples are simply a rectangle and ellipse
component, we use different gradient brush to rend the path (the rectangle) and the inner region. It gives a
visual effect of button.

Using Arrow/Anchor
An arrow property can be attached to pen property to define the arrowhead in both end. A pen property can
create the pen without arrow in both end. The brush to fill the arrowhead will be inherited from the pen
property, so the arrowhead and the line/curve are uniform.
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Shadow Property
The rendering engine allow different style of shadow effect. A shade is the projection of the region that
component occupies. Since SimplexGraphics library is a 2D vector-drawing package, the projection is not a
perspective transformation but an affine
transformation. Although, there is not
limitation of the brush used to fill shadow,
gray solid brush (50% percent
transparency) is default shadow brush.
Following are the shadow type that
SimplexGraphics currently support. User
can set the transformation matrix to
create different shadow effect. A filter
property can also be applying to Shadow
property to transform the color or visual
effect.

Shadow Offset
You can offset the shadow by setting the X-offset and Y-offset of the shadow. Shadow Fill can be filled by any
brush and property, which will used create the brush property to fill the shadow.
A component finds the outline (boundary) of the shape, so that different pen and fill style could apply.
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Outline Property
An outline property brings interesting effects to SimplexGraphics objects. Outline property will force
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Edit/Add/Remove Points from Polygon
It is convenient that end user can add edit/point/remove using graphics user interface. SimplexGraphics
gives the end users the capability to edit a poly object using mouse. When the tool is activated, use can
choose either adding/moving a point or deleting a point. If user chooses to delete the point, and mouse is
clicked on one current point, this point will be removed. If user choose to add/move point, and user click the
mouse on a point that currently exists, then user can drag the point to another location. If the mouse is not
clicked on a current existed point, but on the straight line connecting two existed points, then a new point
will be added between these two points.

11.3 Inbuilt Shapes
Shapes in SimplexGraphics are extended objects
from the basis forms like lines, rectangles, etc.
The difference between basis objects and general
shapes is that shape typically has one or more
free drag handle. A free drag handle (shown as
yellow diamond) is a handle that user can use to
adjust the shape, like the roundness of a round rectangle. Some objects only use its handle for resizing.

Basic shapes
Most basic shapes has 1-3 free handles that allows user to adjust the shape with mouse.

Block Arrows
All the block arrow has 1-3 free handles that allows user to adjust the
arrow shape with mouse.

Star and Banners
The number of vertices of a star or normal polygon could be any integer greater than 3.
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11.4 Connectors
Connector is a line (curve) object that links two or multiple components or shapes. The most important
feature of connector is that a connector is aware of the position change of the component it connects and it
can automatically adjust its position to fit the new location of those components. A connector automatically
re-compute its path to make the layout have optimized visualization effect.
Important note:
SimplexGraphics' connectors does not allow self-connecting. It does not connect another objects either.
When a connector is not in group, it doesn't allow rotation or flipping. However, if a connector is grouped
with other components, rotating or flipping group will rotate or flip the connector correspondingly. Ungroup
a group which has connector inside will trigger the layout (if the connector should be automatically layout)
and normalization (if the connector is not normal) of that connector.
When a connector is connected to a component, move the component will update the connector (Fig. 1).
Move the connector will break the connection (Fig 2). Drag the ends of connector can create or break
connection (Fig. 3). Drag the free handle (not the ends) will adjust the path (Fig. 4).

Connector and Layer Components
Connector and Layer Components can be located on different layer. A connector, as a component, can be
located on different layer where the components it connects are. The components that are linked with a
connector can also on different layer. If all components for connecting are on layer 1, and all the connectors
are on layer2, change the z-order of layers will cause all the component are draw before connector or visevisor, and if the component are not transparent, it can easily hide the part of connectors that is inside the
components it links. Of cause, if the component is not transparent, this way does not work, but
SimplexGraphics allow to only showing the connector outside the component. It is not simply clipping, but
SimplexNumerica V21
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recalculate the endpoint of connector based on the component's region, and it will draw the arrows near the
edge of component. Connector does not support cross-canvas link.

Connector with Two Ends
In many cases, a connector with two ends satisfies user's requirement well. The current mouse curser
position will query the document to find the component that can be connected. User can introduce different
logic to choose the connectable component. SimplexGraphics support automatically layout, if a style bit of
component is set to be one. It also has a parameter to adjust the roundness of the corner. It also allowed
user to edit the path of connector in the same way. Those editing effect will be lost if style layout bit is set to
be true.

Anchor Point
By default a component has five preferred points that can be used for connection. These points are called
anchor point. For symbols, user can define any numbers of default anchor points in SimplexGraphics. For
example, a pump component may have two anchor point to represent the inlet and outlet. A component
could be connected to any point.

Auto Layout
SimplexGraphics supports auto layout. Once the anchor point position is changed, connector will be
recomputed with the best route to connect the objects. The relative position of components and the size of
the component all affect the layout output. If a connector is in a group, it will be prohibited for auto layout.
User has the following option to adjust the layout effect.
1. Preferred Initial direction
For the anchor point, it has a preferred the direction (left, right, up and down) to connect a
connector object. For the center anchor point, the preferred direction could be any direction.
2. Initial Minimum Distance
Defines the initial distance that connector has to extend along the preferred initial direction. Default
value is 10.
3. Connect edge instead of anchor point
Connector usually connects to the anchor point. SimplexGraphics allows to hide the part of
connector that is inside the component it connects. The effect will be connecting to the edge instead
of an anchor point, if it is inside the shape.
4. Adjust Path Using Free Handle
Connector supply drag handle that allows user to adjust the layout after the automatically layout is
done. Once auto layout is redo, the effect of adjusting will be lost. SimplexGraphics maintains the
pointer to connector and component, as well as the index and position of anchor point on which
they are connected.
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11.5 Text, Labels and Legends
SimplexNumerica has three levels of text support. The first option is using SimplexGraphics normal text
objects, the second option is the label and legend support connected to a chart. Both using the
SimplexGraphics text formatting and drawing functions. The third option is using SimplexEditor as an Inprocess Server for HTML text support, which needs SimplexEditor to be installed in the same machine and
directory of SimplexNumerica executable.
There are different advantages for these three ways. HTML text support is very simple to use because
SimplexEditor takes cares of almost everything. There is no shortcoming at all. However, the most native way
in SimplexGraphics for text support is using standard text boxes like rectangles and lines and the labels
connected to a chart. Text or label components are treated as a property of components in SimplexGraphics.
The different of text property and label property is:
1. Absolute position to a component like a chart cannot be changed by the user. SimplexNumerica
implement a drag handle (Pin) allow user change label position by mouse dragging and dropping
only relative to the chart.
2. Text will transform with the component. If you rotate/flip/shear components, text will
rotate/flip/shear with it. SimplexGraphics Label property will not transform with component. Use
text with different style of text trimming, wrap and alignment.
SimplexGraphics also support fit the boundary to the text so it tightly bounds the text and drawing text with
gradient/hatch/texture brush.
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11.6 Groups
It is convenient to select multiple components (Shapes, Charts, etc.) and change the properties
simultaneously. The Group mechanism gives user also the possibility to manipulate multiple properties in
the similar way user does with a single component. SimplexGraphics allows multiple components in the
same layer are grouped. It is enforced in SimplexGraphics that one component can only belong to one
group, while a group, as can belong to another group. SimplexGraphics allows multiple level grouping.
It is different to rotate a group object comparing to rotate multiple component at a time. In the latter case,
all components rotate with its own center and will not change the position. A group object will rotate with
its center, then the components in this group are actually changing it position.
Components can be located on different layer for grouping. A group, as a component, can also be located on
different layer.
If you change the group's layer location, the components inside of the group are not changed. However,
developer can explicitly change the location of all components to the layer where group is located, if this is
desired.
SimplexGraphics implements two action related to grouping and ungrouping. If ungrouping a group, which
includes connector, the up group action will trigger the normalization of this connector (if it is rotated or
flipped) or automatically layout this connector.
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11.7 Use of the Shapes
SimplexNumerica has a Shape Explorer (→ Chart Explorer) to list all shapes and a property list window which
allows to set the properties for each individual object (shape).

Fig.11-1: User-Interface for Shapes

Info
→ Each shape is placed by its name into the hierarchy of the Chart Explorer
under the rubric Shapes.
→ Click on one of this shape names opens the related properties in the window
called Shape Properties

Tip
The color control inside the property window has more options as it look like…
Change a shape to its appropriated color and style, and then set it as default
for the next drawings.
As already told before, lines are snapping like a magnet if they see another…
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11.7.1 Shape Toolbox
Activate the Shape Toolbox with the help of the Ribbonbar Icon to the left.
You can find it here:

Or you can find it here:
To find fix a shape, please use the search field on top of the list.
To use it, please select a shape, then click on the page to expand it.
Or, drag and drop a shape from the list to the page and expand it
afterwards.

Tip
Hold down the <Ctrl> key to repeat the selected drawing
shape inside the page.
When you have pressed the <Ctrl> inside the page, then
you can paint the same shape multiple times around.
Press right mouse to stop.

The following table explains the functions of the Ribbonbar Edit, panel Shapes and the Toolbox.
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Symbol

Function
Pan Page Content
Pan or move the content of the page inside the scrolled
window.
Select Object
Select an object (or more) and use the properties to modify it.
Or select in the Chart Explorer a name of an object. The object
on screen will be selected, too.

Polylines

. Outline Polylines

Geometric Shapes
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Other Shapes

Arrows
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Insert Text Label*
Edit on screen: Double-click > Edit directly in Text field,
Ctrl + Double-click > Call Text dialog
Insert Image.
Insert picture/image/bitmap from disk.
Use the Fileselectbox to choose the right format in its integrated
combobox

Stars

Connectors

Outline Connectors
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11.7.2 Shape Objects
The focus on this category is concentrating on shape objects. Charts and shapes, they have the same object
oriented graphics framework, called SimplexGraphics (SxG). Please have a look at last chapter for more
information.
Def.:

Object

=

Single Shape (like Rectangle, Circle, etc.).

Object

=

Shape behind a Chart.

Chart

=

Shape + Chart Form, Scaling, Graphs, etc.

Selecting Objects
Before any operations, such as resizing and color changing, the objects must be selected. The Handles of the
selected objects will be shown as the following figure, where the most recently selected object has the Blue
handles and other objects have Gray handles. The object with Blue handles is also called Target object,
which is used by some operations (i.e., Align and Same Height) as the reference object.
Target Object

Lock an Object
You can lock an object so that it cannot be moved around.
It is fixed on the locked place.
→ Right mouse click on an object opens the Popupmenu
where you can select this menu item,
or use the toolbar icon to
lock/unlock an object.
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Lock/Unlock Chart
Click with the right mouse on a
chart to open the same
Popupmenu as before
or
click on the Lock/Unlock
symbols as shown in the left
picture to select either Lock
Move (checked) or Unlock
Move (unchecked) or Lock
Resizing (checked) and Unlock
Resizing (unchecked).

Select an Object
To select an object, first press the Select Tool button
(if not the default button) on the Ribbonbar Edit,
then click the object. For the objects filled with the transparent color, their borders should be clicked
instead.
To select multiple objects, after selecting an object, hold down Ctrl key and click on other objects, one by
one. Click the selected object with Ctrl key held down would de-select the object, again.
You can also use the mouse to drag a region to select all the objects in that region. To drag the mouse, hold
the left mouse button down and move the mouse. When the mouse is moving, a temporary dotted rectangle
is used to represent the region. When the left mouse button is up, all the objects that are completely
enclosed by the rectangle region will be selected. To add the dragging selection to an existing selection, drag
the mouse while Ctrl key is held down.
To select all objects, use the Select All (or Ctrl + A) command from the Pulldownmenu Edit.

Moving Objects
To move an object (or several objects) to a new position, you need to select it, first. See previous chapter
Selecting Objects on how to select objects.
Move the mouse on the selected object, the mouse cursor changes to a four-directional cross and you can
click and drag the selected object to a new position as illustrate below.
You can also change the position of the selected object by changing its X and Y coordination within the
Property Window.
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Resizing Objects
To change the size of an object, you need to select it first.
See previous chapter Selecting Objects on how to select
objects.
Move the mouse over the selection handles of the
selected object, then click and drag the mouse to an
appropriate size you wanted as illustrated below.
You can also resize the selected object by changing its X
and Y coordination as well as its Width and Height within
the Property Window.

Rotating Objects
To rotate an object (or several objects), you need to select it, first. See Selecting Objects on how to select
objects. Unfortunately, you cannot rotate a chart.
Click the Rotate Button
in the toolbar, then move the mouse over the selection handles of the selected
object, then click and drag the mouse. The select object (charts are not possible to rotate, yet) will rotate
according to its center with an appropriate angle as illustrated below.
You can also rotate the selected object by changing its rotation angle within the Property Window.

Flipping Objects
To flip an object (or several objects), you need to select it first. See Selecting Objects on how to select
objects.
After selecting the object (s), click the Flip Buttons in the toolbar to flip it (them).
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The effect of flipping corresponding to rotation with specific angle (90, 180, 270 etc.). Therefore, you can
also specify the selected object's rotation angle within the Property Window.
Most of these menus are standard on Windows so please refer e.g. to Microsoft Office package help.

Insert Image
You can import any bitmap from disk to insert into the evaluation page as a single shape object. The most
popular formats that can be used inside SimplexNumerica are:
•
•
•
•
•
•
•
•

Portable Graphics(*.png)
Windows Bitmap(*.bmp)
Windows Enhanced Metafile(*.emf)
Windows Independent Bitmap(*.dib)
Graphics Interchange Format(*.gif
JPEG(*.jpg;*.jpeg)
Tag Image File Format(*.tiff)
Windows MetaFile(*.wmf)

Select the format in the combobox of the Fileselectbox.
Another possibility to insert a picture is to use the shape properties, instead.

Fill a Shape with an Image
→ Please draw or select a shape.

As far as you select a shape, its properties will be listed in the Property Window.
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Scroll down to Fill Art Style and click on Fill Effect… to open an Effect dialogbox. Change to Tab Picture and
select your choice on disk…

Draw Shapes
These here are the normal geometric shapes.
Hint
If you need more shapes, then please have a
look at chapter 0.

→ Draw a shape and use the properties to set its style.
→ The Text Label has more functionality. Please have a
look at chapter 16.3.4.
→ Exit a Polygon or Closed Curve line chain with Right
Mouse Button or double-click with the left button.

Locked Shape movable
Use this menu item to activate some icons in the Alignment Toolbar, so that you can also move locked
shapes.

Set this as Default
Sets the style of the selected shape as the default style for all next new
shapes until you set another shape to the default.
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Trim all Lines
This menu works only for Straight
Lines.
It can close all near gaps between
orthogonal lines.

Hint
→ When you draw a Straight Line and this line comes near to another line, then
it automatically extents its length, so that it touched the other. To avoid that
behavior, please press the key <Shift> in that zone.
→ Holding down the <Ctrl> key during drawing a line will snap-in the line at
practical angles.

Group/Ungroup
Objects can be grouped as you know it from a lot of drawing programs…

Merge Objects
Use this menu item to make from selected shapes one single shape.
Info
Please use group/ungroup to merge shapes temporarily together.
If you have done this, then you cannot undo it to a later time.
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Objects z-Order
These are standard icons in a vector editing program. You can bring objects (charts &
shapes) in front of another or look to the tooltips:

Polylines
A Polyline is a chain of single straight lines. A Polygon is a closed Polyline.
Use this menu items to Add/Move/Delete points among this chain links.
If the polyline has a lot of knots, then it makes sense to simplify it.

Convert to Path
Herewith you can convert e.g. a polygon into an integral whole that can be filled.
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12 Ribbonbar Overview
Please take a short look at chapter 7.2 for the elements of a Ribbonbar.
A Ribbonbar cannot be moved around the main frame of the application like toolbars. But it can be set
hidden and shown again, use that symbol here:
Unfortunately, like in Microsoft Office, the panels and icons of a Ribbonbar cannot be changed by the user.
But on top, there is a small toolbar called Quick Access Toolbar, that can be modified by the user with the
help of an option dialog.

Fig.12-1: Option Dialog to modify the Quick Access Toolbar

You can find this dialog here:

Go to File, Button Options.
Tip
Use edit field “Search Commands” to list the functional Ribbonbar entries.
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12.1 Ribbonbar File
The Ribbonbar File appears underneath the left upper corner of the program mainframe. It behaves like a
Pulldownmenu - but sure if you click on it.
Right to the menu, you can see the most recent
document list. If you like to have entries
permanently, then use the pin on the right side.

The following table explains the commands and
functions of the Ribbonbar File with the larger
Ribbonbar Icons.

These are the commands inside the Ribbonbar File:
Icon

Key

Function

Description

New Evaluation

Open up an empty Evaluation window

Ctrl + M

New Scripting Host

Open up a new window for scripting

Ctrl + K

New Spreadsheet
(short Table)

Open up a new table window

Open an existing Evaluation, Table or Script

Ctrl + R

Load
Evaluation/Table/Script
Reload Evaluation

Ctrl + T

Load Template

Load a new Template

Ctrl + Shift + O

Load Project

Load a project file from disk

Menu Item New
Ctrl + N

Menu Item Load
Ctrl + O
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Menu Item Save
Ctrl + S
-

Save
Evaluation/Table/Script
Save As

-

Save Copy As

-

Save Copy As Open It

-

Save All

Save the active EvaluationTable//Script under a new
name
Save a copy of the active document with a new
name
Save a copy of the active evaluation under a new
name and open it
Save all open evaluation windows

-

Save Close All

Save All and Close

-

Save Close All but this

Save ALL Tab windows and Close it, except this one

-

Encrypt before saving

Use secure password for evaluation

-

Save Evaluation as Image
Save Evaluation as
Template
Save All Evaluations as
Project

Export Chart as Bitmap
Save a Template (= Evaluation without data) to disk

Close Window

Close the active Evaluation/Script window

-

Close All

Close all evaluations/scripts

-

Close All but this

Close all windows - but not the active one

Load last project on startup
Save All Views Project
then Close

Load last project on start-up

Load Profile (on the fly)

Load program GUI on the fly

-

Load Profile on Start-up()

Load Profile on Start-up

-

Save State (on the fly)

Save program GUI on the fly

-

Save Profile on Exit()

Save Profile on Exit\

-

Auto save Profiles

Load always last profile

Load Object

Load an object (chart or shape) from disk

-

Menu Item Close
-

Menu Item Project
-

Menu Item Profile
-

Menu Item Object
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-

Load Template Object

-

Change Chart Dimensions
Change Page Size
Save Object

Load a Template from disk. The data and labelling
will be used from the active evaluation!
Open a dialog to change the chart dimensions, too
Open a dialog to change the page size
Save the selected object (chart or shape) to disk

-

Save Object(s) as Image

Export Chart Object as Bitmap

-

Save Template Object

Save a Template (= Evaluation without data) to disk

Import Table Format
[*.csv]
Import Table Layout File
[*.tbl]
Import Table Default
Layout File [Default.tbl]
Format Properties

Import Comma Separated Table Data (*.csv)

Import Excel [*.xls] or
[*.xlsx]
Import Excel with Filter
[*.xls] or [*.xlsx]
Import Database

Import Table from Excel (*.xls)

Import DBase III Format
[*.dbf]
Import CitectScada
[Tr}.dbf]
Import DSP File

Import Table from DBase (*.dbf)

Menu Item Import
Ctrl + L
Ctrl + 9
Ctrl + E
Ctrl + D
-

Load Table Layout File [*.tbl]
Load Default Table Layout File [*.tbl]
Import/Export Format Properties

Import Table from Excel (*.xls)
Import Database

Import Table from Citect
Import Table from DSP File

-

Import Short Wave File
Import Table from Wave File
[*.wav]
Import ASCII Text, Import Comma-separated values

-

Import Comma-separated values

-

Import Sietronics Sieray '*.CPI'

-

Import Siemens/Bruker Diffrac-AT '*.UXD'

-

Import Rigaku '*.DAT'

-

Import Siemens/Bruker '*.RAW'

-

Import VAMAS ISO-14976

-

Import Philips '*.UDF'

-

Import Princeton Instruments WinSpec

-

Import Powder Diffraction '*.CIF'
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-

Import Philips RD Raw Scan '*.V3'

-

Import Canberra '*.MCA'

-

Import Canberra '*.CNF'

-

Import XFIT '*.XDD'

-

Import RIET7/ILL_D1A5/PSI_DMC '*.DAT'

-

Import DBWS data file

-

Import ChiPLOT data

-

Import Spectra Omicron/Leybold

-

Import Weisang RingBuffer

-

Import Weisang RingBuffer Extended

Menu Item Export
-

Export Table [*.csv]

Export Table Data (*.csv)

Export Excel [*.xls] or
[*.xlsx] File
Export HTML Table
[*.html]
Export Table Layout File
[*.tbl]
Default Table Layout File
[Default.tbl]
Export Wave File [*.wav]

Export Table to Excel (*.xls)

Print

Print the active page

-

Print Setup

Change the printer and printing options

-

Print Preview

Displays the page to prepared for printing

-

Page Setup

-

Page Units

Change the page dimensions and margins of the
page
Setup the Page Units

-

Canvas Size

Setup the Canvas (page content) Size

-

Copy the Evaluation, then
set e.g. DIN-A4, adjust
(rescale) and print it

Menu Item Print
Ctrl + P

Bottom Band
Ctrl + Q
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12.2 Ribbonbar Edit
The Ribbonbar Edit is a fix tape, sorted by the Tab with the name “Edit”.

These are the commands inside the Ribbonbar Edit:
Icon

Key
F3

Function
Swap Graphics/GraphTable

Description
Swap between Graphics and GraphTable (Grid)
page

-

Kill Top Object

Remove and delete topmost selected
Chart/Shape and its data from memory (No
Undo!).

-

Lock/Unlock

Lock/Unlock movement of a chart/shape

Ctrl + V

Paste

Insert Clipboard contents

Ctrl + A
Ctrl + X
Ctrl + C
Ctrl + Entf

Select All
Cut
Copy
Copy As Bitmap To Clipboard
Remove selected Objects

Ctrl + F
Ctrl + Shift + F
-

Rename Graph
Find
Repeat
Replace

Select the entire document
Cut the selection and put it on the Clipboard
Copy the selection and put it on the Clipboard
Copy selection as bitmap to clipboard
Remove all selected Charts/Shapes and put them
into an Undo buffer (at the expense of memory).
Rename specific graph text with different text
Find Text
Repeat the last action
Replace specific text with different text

-

Fontname

Fontname of the selected text

-

Fontsize

Fontname of the selected text

-

Properties
Shrink Text
Grow Text
Bold

Text Format Properties
Shrink the selected text
Grow the selected text
Makes the selection bold (toggle).

-

Italic
Underline

Makes the selection italic (toggle)
Formats the selection with a underline (toggle)

-

Foreground Color

Formats the selection with a foreground color

-

Background Color

Formats the selection with a background color.

-

Align Left

Left-justifies paragraph
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-

Center
Align Right

Center-justifies paragraph
Right-justifies paragraph

-

Fit Horiz. Text

Fit the Shape to bound horizontal text

-

Fit Vert. Text

Fit the Shape to bound vertical text

-

Font Dialog
Insert Text Label

Show the Font dialog box.
Click on entry:
Doubleclick → Edit,
Ctrl + Doubleclick → Dialog

-

ID_VIEW_ALWAYS_TOOLBOX Shape Toolbox

Ctrl + I

Insert Picture

Insert picture/image/bitmap from disk

-

Pan
Select Object

Pan the current page
Select an object. Have a look to its properties!

-

Set default fill and pen effect

Set the fill and pen property of select component
as default

-

Rotate Objects

-

Merge Objects

-

Unify Object

-

Rotate -90

Rotate (all) selected object(s). Drag the mouse on
any object handle!
Merged two or more selected objects (but no
Chart) to one object
Unify selected object (polygon preferred) to one
object path
Rotate Selection by -90 Degree

-

Rotate +90

Rotate Selection by +90 Degree

-

Horizontal Flip

Horizontal Flip

-

Vertical Flip

Vertical Flip

-

Shear Tool

Apply shear transformation

-

Transform

Apply warp transform to path.

-

Perspective Transform

Apply perspective transform to path.

-

Bring to the Front
Bring to the Back

Bring Object to the front on the same Layer
Bring Object to the back on the same Layer

-

One Step Forward

-

One Step Backward

Ctrl + G

Group

Bring Object one step forwards on the same
Layer
Bring Object one step backwards on the same
Layer
Group the selection
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Ctrl + U

Ungroup

Ungroup the selected group

-

Rescale to page

Rescale to fit into page

The following table explains the functions of the alignment toolbar*.
Symbol

Function*
Align to Left
Align objects to the left side
Align to Right
Align objects to the right side
Align to Top
Align objects to the top side
Align to Bottom
Align objects to the bottom side
Align Center Vertical
Align object to center on a vertical line.
Align Center Horizontal
Align object to center on a horizontal line.
Even Horizontal
Evenly Space between Objects
Even Vertical
Evenly Space between Objects
Same Width
Make objects same width
Same Height
Make objects same height
Same Width and Height
Make objects same width and height
Page Width
Make object same width as page
Page Height
Make object same height as page
Center Object Vertical
Vertically center object in page
Center Object Horizontal
Horizontally center object in page
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*Use key Shift to move objects proportional.
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12.3 Ribbonbar View
The Ribbonbar View is a fix tape, sorted by the Tab with the name “View”.

These are the commands inside the Ribbonbar View:

Icon

Key
Ctrl + N

Function
New Evaluation

Description
Open up an empty Evaluation window

-

Switch Windows

Switch to a different currently open window

F4

Show/Hide Graph Explorer

Contents Charts, Graphs
(= SampleData + CurveData), Labels and
Legends, Shapes and Frames

F5

Show/Hide Properties

Please use the Chart Explorer to work with the
Properties

F6

Show Shape Properties

A shape can be a rectangle/circle or other
graphic object. Each chart was also based on a
shape. These shape(s) can be modified here

F7

Show/Hide Thumbnail Viewer

F8

Show/Hide Layer Window

The Thumbnail Viewer contains objects and
evaluations. Right mouse click on the viewer
to extent it..
Try to use the Layer. It will help you to
organize your objects (like charts and shapes)
among the others..

F9

Show/hide Navigation Window

It shows you the whole page (evaluation) with
a red rectangle. That is the actual area of the
main window

F10

Output

View Output Window

Ctrl + F10

Report-Editor

Open/Close the window of the Report-Editor
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Ctrl + F3

View Shape Toolbox

View Shape Toolbox

-

Toggle StatusBar

Show or hide the status bar

-

Show Chart Icons

Show Chart Icons

-

Print Preview

-

Stretch Full Page

Copy the Evaluation, then set e.g. DIN-A4,
adjust (rescale) and print it
Stretch page to see the whole content

Ctrl + F11

Toggles Full Screen

Toggles full screen mode On and Off

-

Zoom-in 100%

Zoom in by 100 %

-

Zoom Full Page

Zoom to fit the full page

-

Zoom Percent

Set the percentage in the popupmenu

-

Zoom In

Zoom in page

-

Zoom Out

Zoom out the page

-

Zoom Point In

Zoom Point in the page

-

Zoom Point Out

Zoom Point out of the page

-

Zoom by Rectangle

Zoom with the help of a rectangle

-

Use Magnifier

Use Magnifier and keep the left mouse button
pressed and move the mouse
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12.4 Ribbonbar Chart
The Ribbonbar Chart is a fix tape, sorted by the Tab with the name “Chart”.

These are the commands inside the Ribbonbar Chart:
Icon

Key
-

Function
New Chart

Description
Add a new chart (but use
Thumbnails instead)

-

Exchange Chart

Exchange selected chart type (use
Thumbnails instead)

-

Linear Cartesian

-

Mathematical

-

Smith Diagram

-

Ternary (Triplot)

Default Charts:
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-

2D Line Chart

-

2D Bar Chart

-

2D Business Chart

-

3D Business Chart

-

Pie Chart

-

Polar/Radar Chart

-

Contour Plot

-

3D Surface Plot
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-

Angular Meter

-

Misc. Chart

Move Left
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-

Move Right

-

Move Down

-

Move Up

-

Shrink

Move chart inside frame to the left
(Use Ctrl/Shift)
Move chart inside frame to the right
(Use Ctrl/Shift)
Move chart inside frame downwards
(Use Ctrl/Shift)
Move chart inside frame upwards
(Use Ctrl/Shift)
Shrink the chart (Use Ctrl/Shift)

-

Locate Axes

Locate axes on a Physics Chart, only

-

Main Bottom x-Axis,
Top x-Axis,
Apart Bottom x-Axis,
Underlying Bottom x-Axis,
Main Left y-Axis,
Right y-Axis,
Apart Left y-Axis,
Leftist y-Axis,
Apart Right y-Axis,
Rightmost y-Axis,
Axes Properties
Cross Hair

Show the Cross Hair

Ctrl + 3

Expand Scaling

Expand Scaling in chart

Ctrl + 4

Zoom Scaling

Zoom chart scaling
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Ctrl + 5

Zoom In

Zoom in page

Ctrl + 6

Zoom Out

Zoom out the page

-

Scroll Left

Scroll Left (Ctrl: Scroll Up)

-

Scroll Right

Scroll Right (Ctrl: Scroll Down)

-

Zoom Scaling Back

Zoom scaling back to previous scale

Ctrl + 1

AutoScale

AutoScale all Chart Axes

Ctrl + 2

AutoScale Main Y Axis

AutoScale only the main Y Axis on
the left side of the chart

-

Move Graph/Scale X->
Move Graph/Scale Y->

Move Graph/Scale in X->Direction
Move Graph/Scale in Y->Direction

-

Move Graph/Scale XY->

Move Graph/Scale in XY->Direction

-

Floating Scaling

Move x-Axis-Scaling during
movement of a Graph

Ctrl + 7

Save Chart Scaling

Save scaling of the active chart

Ctrl + 8

Load Chart Scaling

Load scaling from (any) last saved
chart
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12.5 Ribbonbar Graph
Here you can do everything around graphs, like activate, highlight or set its properties.
The most of the menu points are make sense for 2D Cartesian Coordinate Systems,
only, like Science Charts, mainly the Physics chart.

The following table explains the features of the Graph Ribbonbar:
Symbol

Function
New Graph
Add a new Graph to the active chart

Select the active Graph from a combobox
The program sets the name of the active graph into the
edit field of the combobox. You can change the active
graph if you like.
Show/Hide Marker
Switch on and off the data marker of the selected
chart’s active graph.
Show/Hide Polygon/Polyline
Switch on and off the polygon (closed) or polyline
(open) of the selected chart’s active graph’s data
points.
Fill or Unfill Polygon
It closed the polyline, if the last data point is not the
same as the first.
Show/Hide Bars
It shows the bars from the data points of the active
graph.
Show/Hide Curve
It shows the curve from the curve points of the active
graph.
Fill/Unfill Curve
It closed the curve, if the last curve point is not the
same as the first.
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Symbol

Function
Highlight Graph
Highlights the selected trend curve - shown in color.
There are three conditions for a graph:
1. Original thickness and color of all graphs.
2. Fatter to see which graph is active.
3. Non-active graph attenuated in gray.

Swap Active Data Points with Curve Points
This menu is to swap the SampleData and the
CurveData of the Active Graph.
Swap All Data and Curve Points
Delete data outside the marked region
Use the mouse to expand a range on the x-axis. The
data outside this range will be removed.

 Undo is not possible.
Capture data from the active Graph with the Lasso
Let’s define a round portion of the active graph with the
mouse. Immediately the data inside the lasso will be
deleted. Only the data from the active graph in this
region will be deleted.
Capture data from all Graphs with the Lasso
Let’s define a portion around the graph with the
mouse. Immediately the data inside the lasso will be
deleted. The data from all graphs lying in this region
will be deleted.

Move Graph in X-Direction (Scala is ossified)
…ditto in Y-Direction
…ditto in both direction
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Symbol

Function

Add Graph
Make a new Graph, then add or move marker points.
New Data Points (Marker)
Clear the active graph’s data points and put with the
help of the mouse new ones into the chart.
Add/Move it
Add or move existing data points from any graph in the
selected chart
Remove Data Points (Marker)
Click on a data point (Marker) to remove it.
Remove Data Points from Active Graph
Draw, with the help of the mouse, a polygon around
the data points. Then afterwards the points are
removed by the program. Does not matter to draw over
not active (other graphs) data points. They will not be
registered!
Remove Data Points from All Graph
…ditto, for all Data Points

Draw a Polyline
Draw an independent poly segment line.
Close it to a Polygon
Close or open polyline.
Simplify the number of data
Reduce polyline with less point.
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12.6 Ribbonbar Algorithm
The Ribbonbar Algorithm is a fix tape, sorted by the Tab with the name “Algorithm”. In version
SimplexNumerica V13 it has exchanged the previous Pulldownmenu Algorithm completely.

The most of the mathematical and numerical functions are to find in this Pulldownmenu.

Note:
You need to have a chart selected to use one of this functions.
Please use e.g. Wikipedia for explanations of SimplexNumerica's enhanced
algorithms.

The previous versions of SimplexNumerica had a separate manual for the algorithm. But in the internet ages,
it makes no sense anymore to maintain such a document.
Nevertheless, for more or less detailed information, please go to chapter
19 Algorithm in SimplexNumerica

Please do not forget that the Algorithm are also accessible from the properties.

To start learning: Please use the Start-up dialog to
test a Cubic Spline function with your data.
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12.7 Ribbonbar Interface
The Ribbonbar Interface is a fix tape, sorted by the Tab with the name “Interface”. In version
SimplexNumerica V13 it has exchanged the previous Pulldownmenu Interface or Reload, respectively.

The wording Interface means interfacing of data, re-calculation of information, trending of measurement
data, database exchange, reporting and so on…
The following table is only an extract of some functions. For more, please look at chapter

Symbol

Function
Requery Text Label
Database Requery of all Text Labels.
Constants Dialog
Call Constants Dialog for this recalculations.
Recalc Text
Recalc all Text Labels.
Exchange Text Label Tags
Exchange all Text Label Tags in Report Window.
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12.8 Ribbonbar Trend
The Ribbonbar Trend is a fix tape, sorted by the Tab with the name “Trend”. It shows only a few icons and
controls especially for trending purposes.

Inside this manual you will find a lot of topics related to trending data from external sources. Please have a
look…
The following table explains shortly the functions of the Trend Ribbonbar.

Symbol

Function
Start Date and Time

Time Span

End Date

Set Actual Time Now
Set actual date and time to the comboboxes.

Get Time from Chart
Get date and time from chart x-axis scaling
and put it into the comboboxes.
Start Trending
Start Trending for all charts.

Stop Trending
Stop Trending for all charts.
Refresh Trending
Refresh Trending means continually
gathering data from source.
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Symbol

Function
Scroll Trend Curve
Scroll all trend curves in the active chart.
Trend Properties
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12.9 Ribbonbar Custom
The Ribbonbar Custom is a fix tape, but can be extended by user defined programs. Here you can change the
program language between German and English. Maybe others in future…

Please have a look to the bottom right corner, you will see the symbol
configuration dialogbox for the external programs.

. Click on it and call the

Fig.12-2: Dialogbox for User defined Tools
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12.10

Ribbonbar C++ Editor

Hint
This toolbar can only be used for the SimplexNumerica Scripting Host! It only
appears when a script MDI window is on top.

The following table explains the functions of the compiler panel.
Symbol

Function
Compile Script
Compile the active script.

Run Script
Run the active script.

Debug Mode
Switch into Debug Mode.

Toggle Breakpoint*
Mark a line in the editor with a breakpoint or remove it.

Remove All breakpoints

Format Code
Try to format the existing code (without to save it)*.

*Formatting the C++ code with the help of a modified version of Artistic Style conform to the Microsoft
Foundation Classes (MFC).
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The following table explains the functions of the editor related panels of the Ribbonbar C++ Editor.
Please open a SimplexNumerica Script (key: Ctrl + M) and use this panel of the Ribbonbar to edit the source
code of the script.
The following table explains the functions of the editor panel.

Symbol

Function
Toggle Bookmark
Inserts or removes a Bookmark

Next Bookmark
Go to the next temporary bookmark
Previous Bookmark
Go to the previous temporary bookmark
Clear All Bookmarks
Clear all bookmarks in the editor window
Find Text
Search for a text passage.
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12.11

Ribbonbar GraphTable

These menu items are for editing and calculating the SampleData from all graphs but of only one (selected)
chart.
Important Information
➔ SimplexNumerica’s GraphTable is more an Array Editor than a Spreadsheet. It is organized in
fix x/y/z columns and a number of Sample Data rows.
Hint
The GraphTable, integrated in SimplexNumerica, is not intended to be a competitor
to Microsoft Excel© or other Spreadsheet programs.
Certainly, you can use your preferred spreadsheet program to copy and paste the
data.

Click on the toolbar icon
the sheet.

or the Pulldownmenu File, New… or press key <Ctrl + N> to clear the content of

Note
A GraphTable is always dedicated to one Chart, only!

12.11.1Swap Graphics / Data Sheet
Change between Graphics and GraphTable View either use:

→ Pulldownmenu GraphTable, Swap Graphics / Data Sheet.
→ Use the toolbar icon
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→ Use the key <F3> .
→ Click on the related bottom tab of the view

.

12.11.2Clear Table
Toolbar Icon

(New) or

.

Use the key <Ctrl + N> .
Cleans the table and the graph structure behind the chart.

12.11.3Table Mode / View Mode
As already described above, SimplexNumerica has two modes for data editing inside the same GraphTable,
Table Mode
for comfortable editing like Excel and the View Mode
but limited editing capabilities.

for real time display,

If you have loaded many data rows, then the View Mode shows you only an extract (exactly the range in the
display) of that data arrays and hence it is much faster as in Table Mode. On the other hand, Copy & Paste
should be used in Table Mode, only.

Note:
Some menus are not available in View Mode.

12.11.4Make Table Read-only
You cannot edit the table if it is read only.

12.11.5Math Function
This menu shows you all the math function in relation with the GraphTable. Description is underneath this
main chapters at chapter 12.11.19 Popupmenu Math Functions, because it blows to much up here.

12.11.6Insert here End of Line (EOL = ~)
As already described above:
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If you need fewer rows, then swap to the View Mode and put
the character ~ in any cell row (or use toolbar icon

).
Table Mode (
unchecked):
Not available! Only for display, see next picture
Data 2.
View Mode (
checked):
SimplexNumerica cuts the rest of the x/y/z rows
instantaneous after Return/Enter.

12.11.7Insert here a new Cell
Table Mode (
checked):
→ If you need more rows, then press Return/Enter key in the last row.
View Mode (
Not available!

unchecked):

If you use this menu here, then a new cell will be adding at the cursor position and all values in this column
are shifted up.

12.11.8How to append a new Cell/Row?

Shows you how to append a new Cell/Row.
Toolbar icon
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12.11.9Remove this Cell
Toolbar icon
Removes the actual cell. The program shrinks the size of the x/y/z arrays, too.

12.11.10 Resize selected Column(s) To Fit
Toolbar icon
Resize the column with to fit the text length of the entries.

12.11.11 Hide Z-Columns
Toolbar icon
Hides all z columns.

12.11.12 Insert new Graph Columns
Toolbar icon
Insert new graph columns
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12.11.13 Select Graph Columns for x/y/z Axis
Use this menu to select either x, y or z columns.

12.11.14 Auto-select active Graph Columns
If you have more than on graph in a chart, then only one can be the active Chart. To show this active graph
automatically when you swap to the GraphTable, then check this menu here.

12.11.15 Insert Row
Toolbar icon
To insert a row, first place the cursor in a cell where you want to insert the row underneath.

12.11.16 Remove Rows

Toolbar icon
Removes a whole row.
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12.11.17 Popupmenu Table Legend
Each chart has only one Legend column in its GraphTable, on

the left side of the table.

Data row legends can be used e.g. for the
x-axis labeling of a chart.
There is a button above the legend rows to
edit the Legend. Click on that and edit the
cells.

The color column can be used for certain
charts. Please edit the color values in
hexadecimal format.
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Leg Column from 1...n
Sets the numbering in the legend column from 1 to n.

Individual Text to Legend Column
See above dialog for individual text in the legend column.

Global Text to Leg Column
Puts the same text in the legend column.
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12.11.18 Popupmenu Format
Next menus are specific to the grid in table mode, only.
Most of the formats are not suitable for the related chart.
Please set the following properties in the chart properties on the Graphics View.
•
•
•
•
•
•
•
•

Number of Decimal places
Format Cells
Lookup Cells
Resize Rows
Resize Columns
Styles
Alignment
Style

12.11.19 Popupmenu Math Functions
Popupmenu Fill
Select in the Popupmenu the following menu items:
•
•
•

Fill n times
Fill incremental
Fill random

Popupmenu Sort
Popupmenu Sort by X-SampleData
Select in the Popupmenu the following menu items:
•
•

Sort active Graph
Sort all Graphs

Popupmenu Sort by Y-SampleData
Select in the Popupmenu the following menu items:
•
•

Sort active Graph
Sort all Graphs
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Popupmenu Sort by Z-SampleData
Select in the Popupmenu the following menu items:
•
•
•

Sort active Graph
Sort all Graphs
Sort separate all selected Columns

Popupmenu Swap
Select in the Popupmenu the following menu items:
•
•
•

Swap active x/y-SampleData
Swap all x/y-SampleData
Swap two selected Columns

Popupmenu Rotate
Select in the Popupmenu the following menu items:
•
•
•
•
•

Rotate active X-SampleData
Rotate active Y-SampleData
Rotate all X-SampleData
Rotate all Y-SampleData
Rotate all selected Columns

Popupmenu Calculate
 *** Use x in Calculator ***
Simplexety is an external calculation program from the author of SimplexNumerica. It is used here for
calculations with explicit formulas. Please select in the Popupmenu the following menu items:
•
•
•
•
•

Calc active X-SampleData
Calc active Y-SampleData
Calc all X-SampleData
Calc all Y-SampleData
Calc all selected Columns

For example, Calc all selected Columns
→ Please select all columns that you want to (re-) calculate.
→ Put a formula in Simplexety with the variable x (x means value of a cell) and set the right constants. Then
press Enter to calculate each cell.
→ Close Simplexety with the Close button on Title-bar.
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Info
Simplexety saves its parameter and initial data in the user folder. If something
goes wrong with the program, then delete this folder.

Popupmenu Normalize
Select in the Popupmenu the following menu items:
•
•
•
•
•
•
•
•

Normalize to Maximum
Normalize to each Z Value
Normalize to Reference Value
Subtract a Reference Value
Set Single Reference Value
Normalize to Reference Array
Subtract a Reference Array
Set Single Reference Column
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Popupmenu Accumulate
Select in the Popupmenu the following menu items:
•
•
•

Accumulate active Y-SampleData
Accumulate all Y-SampleData
Accumulate each selected Column

Popupmenu Transformation
Select in the Popupmenu the following menu items:
•
•
•
•

Polar in Cartesian Coordinates
Cartesian in Polar Coordinates
Smith Chart, z-Level in r-Level
Smith Chart, r-Level in z-Level
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12.12

Selection Bar

The Selection Bar is located on the top right area of the main frame. Here you can show and hide the
Ribbonbar. You can display either the Layer from the selected shape or the current active layer, respectively.
Then you can change the Theme of the chart. Call the Start-up dialog and the Help Pulldownmenu.

The following table explains the functions of the selection bar.
Pos

Symbol

Function

1

Show/Hide Ribbonbar

2

Select the active Layer or assign a
Layer to the selected shape.

3

Active Layer in Combobox
If this icon is selected, then it shows the
active layer name in the combobox.
Change this name will activate the other
layer.

4

Shape's Layer in Combobox
If this Icon is selected, then it shows the
layer name of the selected chart/shape
in the combobox. Change the name in
the combobox will move the selected
shape in another layer.

5

Select a Chart Theme
Select a Program Style/Skin

6

Start-up dialog

7

8
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13 Ribbonbar Reference
SimplexNumerica has optimized Ribbonbars (see last chapter). The content depends on the associated toplevel window. Unfortunately, against Toolbars, the user cannot change the Ribbonbar items during runtime.

13.1 Category File
13.1.1 New Evaluation < Ctrl + N >
Use this menu item to create a new unnamed evaluation page (Tab-view) with a default layer. The new
evaluation may be given a name using the Save or Save As... menu item on this File menu.
To create a new evaluation file:

1. Make a new evaluation.
2. From the File menu, choose Save As… or use toolbar icon
. The Fileselectbox appears.
3. In the directory listbox, double-click a folder where you want to store the evaluation file (or move up
or down a path to the appropriate folder).
4. Type the file name in the File Name box, and click OK. The default extension given to a file is '.sx'.
Please do not specify something else.
5. Click “Yes” on the message box that appears, asking if you want to create the file.
6. Fill the evaluation page with charts and shapes and save again...

13.1.2 New Scripting Host < Ctrl + M >
Creates a new document for SimplexNumerica's AngelScript scripting host.

There is a default script that shows
you some techniques (e.g. the use
of main, strings, call by value, call
by reference, outputs, etc.).
Please refer to separate manual
Programming SimplexNumerica
with AngelScript to get more
details about the inbuilt scripting
languages.
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13.1.3 Open... < Ctrl + O >
Open an existing evaluation or script

1. From the File menu, choose Open. The File Open Fileselectbox appears.
2. Select the drive and folder where the file should be existed. The default path is the current drive and
folder.
3. Set the types of files to display in the Files of Type box. Files with the chosen extension are displayed
in the File Name box. This box serves as a filter to display all files with a given extension. For
example, Evaluation (*.sx) or Script (*.cpp) displays all files with the given extensions. The dropdown box initially lists commonly used file extensions. Alternatively, you can specify wildcard
patterns in the File Name box to display file types. The new wildcard pattern is retained until the
dialog box is closed. You can also use any combination of wildcard patterns, delimited by semicolons.
For example, entering "*.sx; *.c*" displays all files with those extensions.

4. In the File Name box, click a filename, and then click OK.
If the program is properly installed via the setup program, then you can Double-click the *.sx filename in the
Windows Explorer. Alternatively, you can drag & drop from Explorer into the SimplexNumerica window.

13.1.4 Reload < Ctrl + R >
To reload the document from its disk file, choose the Reload command from the File menu. If the document
has been modified, you will be asked if you want to proceed.
You can reload a file if you wish to update the current view of the file (for example, if the file has been
modified) or restore its contents to what is on disk if you have modified the file but not saved. If the file has
been changed on disk by another instance of SimplexNumerica, by default SimplexNumerica will not ask you
if you wish to reload it.

13.1.5 Save as Graphic < Ctrl + B >
The precondition for this is that the Graphics View (Tab "Graphics") is in the foreground (and not the
GraphTable).
Procedure:
1. Please turn on the graphics display if GraphTable is active.
2. Select the menu item "File | Save as Graphic…"

 Use the Fileselectbox...
3. Put in filename and path.
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Hint
Should individual objects (like charts) inserted via clipboard into other
applications, then click with the right mouse button in the Graphics window on a
chart and select from the popup menu the item "Copy as Bitmap".
If instead of the whole page only individual objects should be saved as bitmap or
image, then select the Pulldownmenu “File | Object | Save Object as Image”.

13.1.6 Popupmenu Save
Encrypt with Password
When you checkmark the menu item Encrypt with Password, then all Save
menus asking for a password, before the file want to be saved to disk.

The program always tries to load an evaluation file without
any password. If it failed, then it opens the above password
dialog. Remember the saved password and put this in the
edit field. If the evaluation does not open, then the
password was wrong and you will get an error message like
this.

Save < Ctrl + S >
Procedure

1. Switch to the right evaluation window (Tab-view).
2. From the File menu, choose Save.
3. If your file is unnamed, the Save As dialog box will be displayed. In the File Name box, type the
filename.
4. In the Drives and Directories boxes, select a drive and folder.
5. Click OK.
Note:
If the file has set the read-only attribute, or has been modified by another
process, since it was opened for editing, the Save As dialog box will be
displayed so that you can save it with a different name.

Save As..
To save the active evaluation/script to a new file, while preserving its original file:
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1.
2.
3.
4.

From the File menu, choose Save As. The Save As dialog box appears.
Select the drive and folder where the file is to be stored. The default is the current drive and folder.
In the File Name box, type the filename.
Click OK.

Note:
The active document will CHANGE to the new file name!

Save Copy As...
To save the active document to a new file as copy, while preserving its original file:

1. From the File menu, choose Save Copy As. The Save As dialog box appears.
2. Select the drive and folder where the file should be stored. The default is the current drive and
folder.
3. In the File Name box, type the filename.
4. Click OK.
Note:
The active document will NOT change to the new file name!

Save Copy As & Open It...
To save the active document to a new file as copy and open it again:

5. From the File menu, choose Save Copy As and Open It. The Save As dialog box appears.
6. Select the drive and folder where the file should be stored. The default is the current drive and
folder.
7. In the File Name box, type the filename.
8. Click OK.

Save All
To save ALL documents (evaluations), use this command.

Save & Close All
To save ALL documents and CLOSE each one, use this command.

Save & Close All but this
To save the ALL documents and CLOSE each one - but not the current one, use this command.
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13.1.7 Popupmenu Close
Close
Close an evaluation window

1. Use tabs to switch to the right window*.
2. From the File menu, choose Close. This action closes the active window and any additional views of
the window.
* There is a new function to switch between MDI windows in
SimplexNumerica: The extended application keyboard navigation.
Implemented in SimplexNumerica is a Microsoft Visual Studio-like
MDI Windows Navigator.
The keyboard shortcuts <Ctrl + Tab> and <Ctrl + Shift + Tab> can
be used to invoke the left menu. Click on an item will open the
corresponding window.

Close All
To close ALL documents, use this command.

Close All but this
To close ALL documents - but not the current one - use this command.

Save & Close All
To save ALL documents and CLOSE each one, use this command.

Save & Close All but this
To save the ALL documents and CLOSE each one - but not the current one, use this command.

13.1.8 Popupmenu Project
Please have a look to previous chapter 10.3.
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13.1.9 Popupmenu Profile
Please have a look to previous chapter 10.10.

13.1.10Popupmenu Template
A template is an evaluation file without data and without any data or graph structure, respectively.
Note:
A template can be putting over an existing evaluation, only! You have to have an
evaluation before. You can save a template from this one.

Load Template
It loads a previously saved template file (default extension '*.stx') as a new template evaluation and puts it
over an existing evaluation together in a new window.
To open a template:

1.
2.
3.
4.
5.

Select an existing evaluation window.
From the File menu, choose Template, Load Template... The Open File dialog box will be displayed.
Browse for the template file you want to open.
Click Open.
If you want, then close the "old" evaluation.

Save Template
Stores the existing evaluation without data as a template. The extension is '*.stx'.
Example:
Use a standard thumbnail picture and put that on an empty evaluation page.
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…then prepare the look & feel a little bit or select another theme from the toolbar, so that it looks like...

…no, save that as a template. Then empty the page and use again the thumbnail above. But no, load the
template from disk and it should look like the screen before.
Tip:
Useful when the chart has not the dimension for a desired printer output. Then
you can use a template (i.e. prepared for DIN A4) and put that over it, before
you print the page.

13.1.11Popupmenu Object
An Object is everything loose in an evaluation window. That can be any single chart or shape. A template
object is an object without data.

Chart or Single Object

Load Object...
You can explicitly load any object from disk into an existing evaluation with available objects or into an
empty one. For instance, the thumbnails are objects.

Save Object...
Save the selected object to disk. Hint: If you drag a thumbnail, then its path is on the clipboard!
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Template

Load Template Object...
Pulldownmenu Load Options
A template object needs a selected object to prepare during loading from disk. The selected object will
become new "clothes" but does not lose its data.
Change Chart Dimensions
Is this menu checked, then the chart dimensions of the selected chart will be changed to that from the
template object.
Change Page Size
If this menu is checked, then the page size will be changed to that from the page as the template object was
saved.

Save Template Object...
Save the selected object to disk. Then it will be saved without data and getting a template.

Save Object as Image...
You can use either the right mouse on an object and use that menu item in the popup menu their or use this
menu here to save an object (like a chart or shape) as an image.
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Open the image file in another program to see the result (here in PaintShopPro):
Note:
If you want to have a larger image, then zoom the page in
SimplexNumerica and export it after.

13.1.12Popupmenu Data Export To
Export Table in a *.csv File
Use this menu to export the content of the GraphTable (the whole table)
to a *.csv file.
Given an example:
→ Select the Physics chart and call
this export menu here…
→ Put filename in the Fileselectbox…
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→ Open an external text editor to see
the content of the file…

 Data is the name of the Graph
 G0.x = x-Column of Graph No. 0
 G0.y = y-Column of Graph No. 0
 G0.z = z-Column of Graph No. 0
Columns separated with a Tab

You can change the format with the
Format Properties…

Show Format Properties
Call this menu and the program opens the file import/export properties for you
Remark:
It is the following icon in the toolbar on top:

→ Change the Columns Separator from Tab to Semicolon, to see the result:
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Export Table in Excel *.xls or *. xlsx File
Use this menu to export a GraphTable to a native Excel file format, either *.xls or *.xlsx.

→Open the file in Excel to see the result.

Export in HTML Table (*.html)
Use this menu to export a GraphTable to a HTML file.

Open the file in a browser to see the result.
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Export in Table Layout File (*.tbl)
Use this menu to export a table from the GraphTable to a Table Layout File. In the Graphics View is this
menu disabled.

The file content is binary, so that we cannot read it without a Hex Editor.
→Use this file format to export and import data tables from SimplexNumerica User-A to SimplexNumerica
User-B.

Export in Default Table Layout File (Default.tbl)
The same as before, but with a fix filename. It used here always the fix filename “Default.tbl”. Advantage is
that you can avoid one step.

Export in Wave File (*.wav)
Use this for appropriated signals. Use it together with the extensive Digital Signal Processing in
SimplexNumerica.

→Here you can play a wave file, too.
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Use this menu to export signal data from the GraphTable to a Wave file.
→ Import a small wave file into the program and then export it here…

When you call the menu, then the program shows the following dialogbox for related input parameter:

Double-click in the Windows Explorer on that saved file to hear it (or not) …

13.1.13Popupmenu Data Import From
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You can import data from various formats like separated values (*.csv)
or Excel format (*.xls; *.xlsx).

Table Layout File (*.tbl)
As you can see in the last chapter Data Export, the *.tbl file has a binary format and can be used for data
exchange between different SimplexNumerica user.
→ You can only use it from the GraphTable. In Graphics mode is the entry disabled.

Table Default Layout File [Default.tbl]
The same as before, but with a fix filename.

Import CSV File
Table Format (*.csv)
Use this menu to export the whole table of the GraphTable in a comma separated value (*.csv) file format.
That is an ASCII format, which you can read with any other spreadsheet or text editor.
SimplexNumerica will swap to the GraphTable of the selected chart when you call this menu from the
Graphics View. The format can be set in the Property Window (see Export Format).
CSV files are very popular for storing tabular data because they are simple textual files with a very few rules.
This makes them very interoperable because CSV readers and writers are relatively easy to implement.
Interoperability is, probably, the first reason why someone would choose to save the data in CSV format.
Although rules for writing and reading CSV files are relatively known and widely accepted, one rule is an
exception – determining a character that will be used as a separator. CSV files, as the name Comma
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Separated Values says, should use comma [,] as the separator but there are many CSV files that use
semicolon [;] or horizontal tab [\t] as a separator.
So a program like SimplexNumerica should support
different file filters, so that you can read various *.csv
formats. SimplexNumerica has a common dialogbox for this
filter purpose (described beneath the properties).
The Import Format can also be explicitly set here in the
Data Import Properties!

Format Properties/Data Import Properties
To activate the Data Import Properties from the
Pulldownmenu, please use the menu item File→ Data
Import From→Format Properties, or click on the icon in
the toolbar, or use the combobox:

Here now the entries of the Data Import Properties:
Page 199 of 372

SimplexNumerica V21

-200Ribbonbar Reference

General
•
•

Look for Date and Time
The program tries to interpret the first column as a Date and Time value, e.g. 29.11.2003 20:02
Columns Axes Order
Select two or three axes (x & y columns or x, y & z columns)

Columns-Separation
•
•
•
•
•

Semicolon [ ; ]
Comma [ , ]
Vertical Bar [|]
TAB [ \t ]
Space

Decimal- Separation (e.g. 3.14)
•
•

Comma [ , ]
Dot [ . ]

Header
•
•
•
•

Jump over header rows
Check that entry to jump over the succeeding Number of Header rows.
Number of Header rows
Put in the number data rows that can be jumped over.
Take Graph Name from first row
This check box will change the graph names.
or
Take Header Name from first row
This check box will not change the graph names.

Rows
•
•
•
•
•

Jump over first data row.
The first row in the file will be ignored.
Jump over second data row.
Also the second row in the file will be ignored.
Jump over first n rows.
The first n rows will be ignored.
Skip over each m row.
Each m row will used for the table.
If skipping, then use averaging.
If <Skip over each m row> is activated, then it will average the skipped values and put these in the
table.

Columns
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•
•
•

Put first column in Legend.
The Legend is the left grey column.
Set first column for all x-Axes
Use the first x-Axis for all x-Axes.
Marking Missing Values

Data Import Dialog
If you load an external file from another application and SimplexNumerica cannot recognize the content so it
will automatically call this data import dialog. Set it up so that it can read the content and the next time the
same parameter should be pre-selected.

Import into Main Grid
➔ Updates the main grid (GraphTable).
➔ Closed the dialogbox.

Header
•

Jump over first n rows
Check that entry to jump over the succeeding Number of Header rows.
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•
•

Take Graph Name from first row
This check box will change the graph names.
or
Take Header Name from first row
This check box will not change the graph names.

Columns
•
•
•

Put first column in Legend.
The Legend is the left grey column.
Set first column for all x-Axes
Use the first x-Axis for all x-Axes.
Marking Missing Values

Dimension
•
•

2-D (x / y)
3-D (x / y / z)

Decimal- Separator
•
•

Comma [ , ]
Dot [ . ]

Columns-Separation
•
•
•
•
•

Semicolon [ ; ]
Comma [ , ]
Vertical Bar [|]
TAB [ \t ]
Space

Rows
•
•
•
•
•

Jump over first data row.
The first row in the file will be ignored.
Jump over second data row.
Also the second row in the file will be ignored.
Jump over first n rows.
The first n rows will be ignored.
Skip over each m row.
Each m row will used for the table.
If skipping, then use averaging.
If <Skip over each m row> is activated, then it will average the skipped values and put these in the
table.
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Data Reduction
•
•

Reduce Column.
Reference column to reduce. All other columns will be removed analog to this column.
Tolerance
This is the tolerance value +/-

Replace
•

Replace the text from string 1 to string2.
If you need to replace a tab character, the use the button above the edit field.

Display above N rows
Shows in the preview grid (underneath this entry) only the first N number of rows (if the file is very long,
then that is much faster).

Convert in Number
Converts each entry in a number with the country specific format else it used the entry as it is.

Update Preview
Updates in the preview grid (underneath this entry) with the (new) parameter.

How to transfer this data to the main GraphTable table?
Before you press the button “Import into Main Grid”, please check here the right entry.
•
•
•
•

Overwrite Table
Overwrite behind Column: No.
Insert behind last column
Insert behind last row

AutoScale Axes
If this entry is checked, then after importing the data, the program makes an AutoScale on the chart axes.

Buttons Check / Uncheck All Columns
Check or uncheck all columns in the preview grid. Please be aware, that only checked columns are
transferred to the main grid.
Hint:
Only checked columns will be transferred into the main grid.

Script Dump to Clipboard
As you already know, a lot of functionalities inside SimplexNumerica can be automized via AngelScript. Also
repeating data import from external files makes sense to automate via script.
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To know which parameter to adjust, please use this data import here one times to set up the filters and copy
these ones into the clipboard with the help of this button. You will get e.g.:
// CSV Parameter, Dump for Scripting Host
// Made by button <Script Dump to Clipboard> at the bottom of the Import
Dialogbox
// ======================================
Chart ch = app.MakeChart("My Chart", idChartTypePhysics, 50, 50, 400, 250);
ch.SetColumnsSeparation(1);
ch.SetDecimalSeparation(1);
ch.SetOrderAxesToColumns(2);
ch.SetAppendToGraphMemory(false);
ch.SetJumpOverFirstNRows(false);
ch.SetJumpOverFirstRow(false);
ch.SetJumpOverSecondRow(false);
ch.SetPutFirstColumnInLegend(false);
ch.SetbSetNextColumnForAllOtherXAxis(false);
ch.SetExpectingMissingValues(false);
ch.SetGraphNameFromFirstRow(true);
ch.SetHeaderNameFromFirstRow(false);
ch.SetSkipOverEachMRow(false);
ch.SetUseAveraging(false);
ch.SetJumpOverNumberOfStartRows(3);
ch.SetSkipOverNumberOfRows(2);
ch.SetJumpOverNumberOfHeaderRows(0);
ch.SetJumpOverFirstNHeaderRows(false);
ch.SetColumnsSeparation

Please copy this text into the scripting editor or load the example:
..\Scriptings\Import and Calc Data.cpp
The example is shown here:
/*********************************************
Simplex - Sample Script
*********************************************/
#pragma extension "corelib"
double __min(double a, double b)
{
return ((a < b) ? a : b);
}
double __max(double a, double b)
{
return ((a > b) ? a : b);
}
void main()
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{
Application app("My App");
string simplexAppPath = app.GetSimplexAppPath();
string filename = simplexAppPath + "Examples\\DataPlots\\Spectrum Data.sx";
app.Output(filename);
if (app.FileExist(filename))
{
// Load an evaluation
app.LoadEval(filename); // A chart with the name "First Chart"
// Make a second chart similar to "First Chart" and call it "Second Chart"
app.SelectChart("First Chart");
app.CopyChart();
app.PasteChart();
app.ArrangeCharts(10);
// Copy & Paste a chart brings up an index behind the copied name
Chart ch2 = app.GetChartByName("First Chart.1");
// Rename second chart
ch2.SetName("Second Chart");
// Get the first chart object
Chart ch = app.GetChartByName("First Chart");
// Set the CSV Import Dialog parameter (see function below on this page)
SetCSVSettings(ch);
// Import any data from a CSV file!
ch.LoadCSV(simplexAppPath + "Data\\Sample3.csv");
// Manipulate the data and write it back to the chart memory
for (int i = 0; i < ch.GetNumberOfSampleData(0); i++)
{
int graph = 0; // first graph
double y = ch.GetDataY(i, graph);
y *= 100 / sqrt(2); // Calc anything
ch.SetDataY(i, graph, y);
}
// Now, write the y data from second chart to a script array
array<float> ay(ch2.GetNumberOfSampleData(0)); // 0 = Graph No. 0
for (int j = 0; j < ch2.GetNumberOfSampleData(0); j++)
{
ay[j] = ch2.GetDataY(j, 0);
}
// Next, add this data to the first charts graph data
for (int i = 0; i < __min(ch.GetNumberOfSampleData(0), ch2.GetNumberOfSampleData(0)); i++)
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{
double y = ch.GetDataY(i, 0);
y += ay[i];
ch.SetDataY(i, 0, y);
}
ch.SetLogScaleY(true);
ch.AutoScale();
// Finally update properties on screen
app.UpdateWindows();
}
else
{
app.Error("Could not find the chart");
}
}
void
{
//
//
//
//
//

SetCSVSettings(Chart& ch)
=========================================
CSV Parameter, Dump for Scripting Host
Made by button <Script Dump to Clipboard>
at the bottom of the Import Dialogbox
=========================================

ch.SetColumnsSeparation(4);
ch.SetDecimalSeparation(2);
ch.SetOrderAxesToColumns(1);
ch.SetAppendToGraphMemory(false);
ch.SetJumpOverFirstNRows(false);
ch.SetJumpOverFirstRow(false);
ch.SetJumpOverSecondRow(false);
ch.SetPutFirstColumnInLegend(false);
ch.SetbSetNextColumnForAllOtherXAxis(false);
ch.SetExpectingMissingValues(false);
ch.SetGraphNameFromFirstRow(false);
ch.SetHeaderNameFromFirstRow(false);
ch.SetSkipOverEachMRow(false);
ch.SetUseAveraging(false);
ch.SetJumpOverNumberOfStartRows(3);
ch.SetSkipOverNumberOfRows(2);
ch.SetJumpOverNumberOfHeaderRows(0);
ch.SetJumpOverFirstNHeaderRows(false);
}
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Accompanying Messageboxes
The following dialogboxes accompanying the data import. The first, before the main dialogbox appears, is
next one:

What does it mean?
When you have setup the filters, and then call the import again for another file, then you maybe want to
have the same parameters as adjusted before.
Hence, the question is, where are the filter settings be saved?
The program supports two place to save:
A global one in the registry and an individual one in the chart properties (saved within the evaluation). If you
click the button “Yes, use it”, then it used the global settings otherwise the individual setting.
After the main dialogbox is finish, the next one appears:

What does it mean?
The program asks for changing the line colors and line styles of the graphs.
But if you do not want that, because you intend to set it up for all the next imports, equally, then press the
button “No” here, otherwise press “Yes, adjust it”.
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Import Excel File
Excel (*.xls) or (*.xlsx) File
Use this menu to import a native Excel file format (*.xls) or a newer file format (*.xlsx) in a GraphTable. If the
data in the Excel sheet are formatted in that the program cannot interpret similar to the format in
SimplexNumerica, then use the next menu with filter.

Excel with Filter (*.xls) or (*.xlsx) File
Use this menu to import a Excel file format (*.xls) or (*.xlsx) in a GraphTable with the help of a similar filter
dialogbox like above.

Tip
For the filter settings, please have a look to the previous chapter.
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Steps to go:
1. Put a path plus filename into the edit box or use this icon
file that you want to import.

2. Load the Excel File

to select the right place for the Excel

.

Do not forget to this!
3. Adjust the right filter settings, so that the bottom grid looks fine for you.

4. Press the Button
5. Press the Button
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Import Database
Use this menu to import a database table into SimplexNumerica’s GraphTable, as the main grid editor behind
each chart.
Hint
Please have a look at the Prime Example, Generate Reports in chapter 0

Use this menu to start a wizard and follow them in steps…

1. Select the right database
2. Fill the right database connection parameter (if necessary) or
Fill the database file path (only for Microsoft Access)
3. Press button Connect or
Press Button Access
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Hint
If you get an error like this one

then the Access file is maybe not available or the database driver (Windows
driver) is incompatible or not available. Follow the tip inside the messagebox
for Access and 64-Bit Windows.
______________________________________________________
If you get an error with a database server (like MS SQL Server), then try to find
out the right parameter for the connection and try to find out the security
rights inside the SQL Server.
Maybe the Windows Firewall avoids connections, too.
We try to avoid here the stupid sentences: Please ask your administrator…

Next wizard step:
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Follow these steps:
1. Click in the left tree control on the table text, as stated above in the dialogbox: „Data Table“
2. Type e.g. the following SQL string into the SQL Text Editor (Icon
SELECT TOP 100 * FROM [DataTable]
3.

Store the SQL string for later use.

4.

Perform the database query.

):

5. Adjust the filter settings on the right side of the dialog appropriated to your expectations.
6. Press the button

for redraw.

7. Look to the Preview table, if it is right then…
8. Press the button
related to its selected chart.
9. Finally, quit from the dialog with the button

to save the data into the main grid, the GraphTable

.

Hint
Please refresh the Chart Explorer if some graphs are missing.
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Import Miscellaneous Files
Please refer to the internet for more information about the different file specifications or drop an email to
the support.

Please refer to the internet for help to the several data formats.
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13.1.14Popupmenu Print
Page Setup
Use this command to configure the page margins, the header and
footer for printing of the evaluations.
→ Select the right size of the page (e.g. DIN A4)
→Select Portrait

or Landscape

format.

Page Units
Use this menu to configure the page units. Makes sense, if
you like to adjust your custom page.

Print Preview
Print preview is a feature that allows you to view what a
printed version of the evaluation page would look like on
the screen before printing it.
By using print preview, you can find any errors that may
exist or fix the layout before printing, which can save ink
or toner and paper by not having to print more than once.
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To open the print preview feature, click the print preview icon on the Ribbonbar File, like that shown in the
picture or click the same icon in the Ribbonbar View.

Canvas Size
Use this menu to set the canvas size. Canvas is equal to the
white page in the background.

Hint
Please have a look at the Page Properties.
Also here you can set the canvas width and height.

Print / Print Setup
Use these menus to setup and print the active evaluation.
This command presents a Print dialog box, where you may
specify the number of copies to be printed, the destination
printer, and other printer setup options.

Copy, Adjust and Print
This menu does three steps successively, that means one after another.
1. Page Setup
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2. Rescale to fit into page
3. Print
Imagine you have a paper size for your monitoring of the graphs in wide-screen format.

And you want to print it in a paper format like DIN A4, then it makes sense to have such a function that does
that temporarily formatting for you, automatically.

Hint
The program does not change the original evaluation. If makes a copy in a new Tab
window.
If you like to do that semi-automatic, then use the three menus:

13.1.15Exit
Use this command to quit the SimplexNumerica program. You can also use the Close command on the
application Control menu. You will get prompted to save any documents with unsaved changes. You will get
prompted to leave the app as well.
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13.2 Category Edit
For this menu, there is an interdependence between the Graphics or GraphTable view lying on top,
respectively. Also menus in this Pulldownmenu might be enabled or disabled.
Because of this, we want to distinguish between these two views.

A) If the Graphics View is on top, then the following functions are used…
13.2.1 A) Undo < Ctrl + Z > and Redo < Ctrl + Y >
Some changes you make (except data and graph actions) can be undone, and you can redo changes you
undo.
But everything related to the internal measuring data buffer cannot be undo, because of the fact that this
buffer is not redundant. Has something to do with performance issues and certainly size.
The GraphTable’s native data can be undoing, but they are not used for the real time part (see checkbox
Table view in the main grid editor from the GraphTable).

13.2.2 A) Cut < Ctrl + X >
Cuts the selection from the document and save it on the clipboard.

13.2.3 A) Copy < Ctrl + C >
Copies the selection from the document and save it on the clipboard.

13.2.4 A) Copy As Bitmap
Copies the selection from the page and saves it to the clipboard as a bitmap.
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13.2.5 A) Paste < Ctrl + V >
Use this command to insert the contents of the clipboard. That works only for native content like text or
SimplexNumerica objects and not for bitmaps from outside.

13.2.6 A) Delete < Ctrl + Del >
Delete the selected object from the page. If you want to use the keyboard to delete object(s), then hold
down Control key first (→ Ctrl + Del). That avoids unconsciously deleting actions.

13.2.7 A) Select All < Ctrl + A >
Select all objects, charts or shapes on drawing screen.

13.2.8 A) Deselect All
Deselect all objects, charts or shapes on drawing screen.

13.2.9 A) Find Graph or Shape Entry < Ctrl + F >
Use this menu here or click on the toolbar icon on the Chart
Explorer.
It should be clear what’s going here:
It searched for a graph or shape name and selects this entry
in the Chart Explorer and Property window, if available.
Parallel it scrolled the main window on the right place and
selects the object.

13.2.10A) Find Next
Use this menu to find the next entry.
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13.2.11A) Rename All Graph Entries
Use that menu to rename all Graph entries that matched the entry. You can also click on the toolbar icon on
the Chart Explorer.

As you can see here that we have renamed Data in My Graph Data for all graphs belonging to that chart.

13.2.12A) Replace Individual Shape Entries
Use that menu to replace individual shape entries. You can also click on the toolbar icon on the Chart
Explorer.
Hint
It searched and replaced shapes in the active layer, only!

Do you know?
A chart based also on a shape!
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Please select a label and filter the search options, then press the button Replace All Selected Shapes.
Check the entry

if you like to touch only the selected shapes.

It searched for a label entry and selects this entry in the Chart Explorer and Property window, if available.
Parallel it scrolled the main window on the right place and selects the object.

B) If the GraphTable is on top, then the following functions are used…
13.2.13B) Undo < Ctrl + Z > and Redo < Ctrl + Y >
The GraphTable’s native data can be undoing, but they are not used for the real time part (see checkbox
Table view in the main grid editor from the GraphTable).

13.2.14B) Cut < Ctrl + X >
Cuts the selection from the grid and save it on the clipboard.

13.2.15B) Copy < Ctrl + C >
Copies the selection from the grid and save it on the clipboard.
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13.2.16B) Paste < Ctrl + V >
Use this command to insert the contents of the clipboard. That works only for native content like text or
ASCII data tables, e.g. CSV format.

13.2.17B) Delete < Del >
Delete the selected region from the grid.

13.2.18B) Select All < Ctrl + A >
Select all rows and columns.

13.2.19B) Deselect All
Deselect all rows and columns.

13.2.20B) Find... < Ctrl + F >
Use this menu in the GraphTable to find any number in the column where the cursor is placed.
Hint
The program searched for any matched number in the column where the cursor is
placed, only.

13.2.21B) Replace...
Use this menu in the GraphTable to replace any number in the column where the cursor is placed.
Hint
The program replaced any matched number in the column where the cursor is placed,
only.
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13.3 Category View
This of the same name Ribbonbar hosts menus primarily for the layout of the GUI framework and its
environment.
Notes:
→ The environment can be saved as Profiles in the Pulldownmenu File (…have a look at chapter 10.10).
→ You can close the full screen also with the ECS key.
→ Instead the Tab Window, you can use the key < Ctrl + Tab >
→ Instead the menu Page Zoom, you can use the mouse wheel, together with the keys Ctrl and Shift.
→ Sure, you can use the toolbars, always…
→ Are you knowing, that you can grab each window inside SimplexNumerica’s GUI and dock it anywhere.
Small boxes with arrows will help you to dock while dragging.

→ Are you knowing, that a menu with an icon in front does not check the menu entry, when a window is
visible on screen, instead it highlights the background, only.
→ When you click on a free area to the right, then you can call the
same Popupmenu as here in this, Toolbars.

13.3.1 Full Screen
Removes all dockable windows and shows on top the Pulldownmenu and the Tab-views beneath.
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13.3.2 Tab Window
Please have a look at chapter 10.3 Extended Keyboard Navigation

13.3.3 Chart Explorer
The Chart Explorer is a hierarchy tree view of the objects (charts/shapes)
on the main page and belonging to the active evaluation.
There are two main categories: Charts and Shapes (whereby a chart is
also based on a shape, so that it has also a shape entry).
A Chart is divided in Graphs (Curves and Marker), Labels & Legends, its
Shape and Frame.
Under Shapes are listed the objects like Rectangle, Lines, etc.
If you check/uncheck the tree view, then you can show/hide or activate/deactivate, respectively, some
shapes or categories.
Chart Explorer Popupmenus
When you right click on a Chart Explorer list entry, then you can open an assigned Popupmenu (whereby
some do not have one). Nevertheless, if they do or do not have a Popupmenu, in parallel, the property
window has changed its listing (see sub-chapter below).

Right Click on Graphs
Right mouse click on Graph shows the following Popupmenu.
Its task should be clear and understandable to read…
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Right Click on any Graph entry
Right mouse click on a graph entry shows the left
Popupmenu. Its task is not so clear. It will be described
next…

Text

Function

Clone Graph*

Internal copy and paste of the selected graph
makes a new graph entry as an exact data
copy (clone) of this graph. Then, please
rename the graph name to an unique text
label (→Rename).
Each graph based on its own SampleData.

Clone, but link this SampleData*

The same as before, but…
The cloned graph still based on the copied
graph’s SampleData.

Copy Graph

Copies the graph in an internal buffer.

Exchange Graph*

Exchanged the selected graph with the
buffered graph.
Rename the selected graph

Rename Graph
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*Hint
If the Chart Explorer does not show the new added graph, then try to
refresh the entries…

Right Click on entry Labels
Right mouse click on the list entry Labels shows the left
Popupmenu with the entries:

Description of the entries:
Text

Function

Add Chart Label

Adds a new chart label to the chart.
Opens a dialogbox to setup the label.
→ Please have a look at chapter 0

Requery Database

→ Please have a look at chapter
Pulldownmenu Interface

Requery Database by Date/Time

→ Please have a look at chapter
Pulldownmenu Interface

Recalc Chart Label

→ Please have a look at chapter
Pulldownmenu Interface

Right Click on any Label entry
Info: Behind the entry Legend is no Popupmenu!
Right mouse click on a Label entry shows the left
Popupmenu with the following entries:
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Text

Function

Edit

Calls the labelling dialogbox where you can
edit the text.

Duplicate Label

Makes a copy of the selected label and opens
the labelling dialogbox to edit the text for the
copy.

Rename Label

Rename the label name.

Delete Label

Removes the label from the chart.

Label <selected> Properties

Shows the label properties.

Right Click on any Axes entry
This here is one of the several possibilities to assign a graph to an
axis or vice versa.
It opens the dialogbox below. Please select one or more graphs
that should be belonging to the selected axis.
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13.3.4 Chart Properties
Chart Explorer & Chart Properties are related to each other like
Action & Reaction.
→ Click on a Chart Explorer entry and immediately you will get
the properties to this entry in the property window.
→Have a look on chapter 10.8 to see more about the property
window.
→ When you click on an entry, then you can see a short help
note at the bottom and the property command for the scripting
engine.

As you can see, the list entries on the first column have a small box on the right side. Click on this box to
open the Popupmenu. You can simply read what you can do with the menu entries. As an example we will
show you the use of the menu Copy Script Function to Clipboard.
The picture above grabs the function ~.SetProperty(idLabelText, [string] Label text);
The function will be used like:
Chart ch = app.MakeChart("My Chart", idChartTypePhysics, 100, 100, 400, 300);
ch.SetProperty(idLabelText, “Hello World”);
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Here is another short sample script:
/*********************************************
Simplex - Sample Script
*********************************************/
#pragma extension "corelib"
#define IDYES
#define IDNO

6
7

void main()
{
Application app("Simple App");
string simplexAppPath = app.GetSimplexAppPath();
string filename = simplexAppPath + "Examples\\Curve Fit\\Gauss-Fit.sx";
app.Output(filename);
if (app.FileExist(filename))
{
app.LoadEval(filename);
Chart ch = app.MakeChart("My Chart", idChartTypePhysics, 100, 100, 400, 300);
ch.SelectPropertyGroup("Chart Properties");
ch.SetProperty(idShowGrid, false);
ch.SelectPropertyGroup("Page Properties");
ch.SetProperty(idShowPageGrid, true);
app.SelectChart("My Chart");
app.SaveEval(simplexAppPath + "test.sx");
if (alertYes("Close Evaluation?") == IDYES)
{
app.CloseEval();
}
}
else
{
app.Error("File does not exist!");
}
}

Note:
Use SetProperty() to set the properties (simple to use, but slow) or use the
individual object functions from the scripting host (fast, but more knowledge
necessary).
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13.3.5 Shape Properties
Each object is based on a shape, also a chart has a shape behind. This menu item activates these shape
properties in the property window.

13.3.6 Thumbnails
Thumbnails are small pictures of real charts saved on disk as objects.

Note:
→ Objects can be saved as described in chapter 13.1.11
→ All objects are stored into the SimplexNumerica folder e.g.:
<C:\Users\MyName.MyPC\Documents\SimplexNumerica\TN>
→ Find out more about the thumbnail window in chapter 0.
→ If you want, then you can change every object in this folder.

Inside each of these folders, there are two sub-folders called Bitmaps and Objects.
The files inside these folders must have the same file name (except the extension).
Empty page or no page available
→ Click on a picture in the thumbnail window to activate a new evaluation and the
clicked chart object will be dragged to the page. You can also drag it by hand to the
evaluation page.
Page available, existing chart selected
→ The chart is still selected! Now, if you click on a thumbnail picture, then two
possibilities of displaying this new chart are available:
Either, the new chart will exchange the old one or the new one will be put beside the
old one.
SimplexNumerica has the following rule: If the old one is selected, then the new one
will remove it and will be placed instead (on the same position) of it. However, the
data will be used from the old one. If there is no chart selected, then the new one will be placed beside the
old one and have their own (default) data.
By the very first time of clicking a second
chart, SimplexNumerica will show next
dialog, so that the user can decide what to
do.
Use
avoid this dialogbox.
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13.3.7 Page Layer
This menu hides/shows a Layer Window.
A layer is a group of objects that lay in front of or behind another layer. All of the objects in a layer may be
hidden, locked, or moved in front or behind other layers as a group. Normally, there is just one Layer in a
window, and all objects in a drawing are in this layer. However, for the complex diagrams, where more
charts may be in a different layer to another, multiple layers are preferred. You can use Layer Button
in
the toolbar to activate the Layer Window or use this Pulldownmenu and define more than one Layer in your
drawing (see next picture).

As you can see in the above picture, there are five columns within the Layer Window, which are Layer Name,
Visible, Selectable, Locked and Objects. See Adding/Deleting and Editing Layers on how to use them. There
are four buttons at the top of the window, which are Active, New, Delete, Up and Down. New is used to add
a new layer; Delete is used to delete one unwanted layer; Up is used to move one layer one level up; and
Down is used to move a layer on level down. You can activate a layer by pressing Activate button (but please
avoid the Name column). Rename the layer with click on the layer name cell.

Add a new Layer
To add a new layer, please click the “New” button within the Layer Window, a new layer will be added and
set as activated (layer name shown in bold). You can change the name of the layer by clicking the layer name
and edit the layer name. To make a layer visible/invisible, check/uncheck the visible box for the
corresponding layer. The objects in an invisible layer are hidden and cannot be selected and edited. The
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objects in a visible layer can be selected if the Selectable box is checked for that layer. To make the objects in
a visible layer un-selectable, uncheck the Selectable box for that layer.

Delete a Layer
First, select the layer that you want to delete by click the layer row once (not in the name cell), then click
Delete button within the Layer Window. All the objects in the deleted layer will also be removed. If a layer is
locked, it cannot be deleted.

Changing a Layer's Order
For the layers in the Layer Window: The layer that appears at the first row is the back most one and the
objects within this layer will appear behind the objects in other layers. Correspondingly, the layer appears at
the bottom row is the front most layer and the objects within this layer appear in front of the objects in
other layers. You can change the order of the layers by moving a layer up/down button. First, select the layer
you want to change by click the layer row (not the name cell), then click the Up/Down button to move the
layer one level towards the front/back. The back most layer (the first row) cannot be moved down, and the
front most layer (the last row) cannot be moved up.

Add new objects to a Layer
First, activate the corresponding layer, and then add new objects (Charts, Shapes, etc.) to the activated
layer. Move objects within Layers: Objects reside in different layers. After an object is generated, you can
check to see which layer it belongs to in Object cells.

Move an object to another Layer
You can also move the objects to another layer by choose a
different layer. To check whether the objects are moved or not,
selected the destination layer and make it invisible (uncheck the
visible box), the objects that have been moved should be hided.
To move an object, first, select the object (if more than one object
is selected, then the target object is referred) you want to move, then select the Shape Properties. Use "Put
on Layer" to select another one.

Quickly re-order the objects
You can re-order the objects one by one, see Order the objects. You can also easily re-order several objects
at once. First, consecutively select the objects in the order you want (the first in the back, the last in the
front; hold Ctrl and click the object to select more than one object, see Select Objects); then within the
Property Window, choose the Property Window, “Put on Layer”, choose one layer you want to sent these
objects to (you can even sent them to the same layer as before). The objects will be re-ordered as the order
you select them.
→Have a look on chapter 10.3 to see more about the layer functionality.
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13.3.8 Preview Window
The Preview Window is used to preview and navigate in your evaluation page, especially when the size is
huge.
The Preview Window is implemented as a normal dockable window inside the mainframe. You can
show/hide it by checking/unchecking this menu item or by pushing the icon
in the toolbar.

In this picture, the small white page rectangle shows the size of the drawing page. The red rectangle
illustrates where your view window is over the drawing. The objects within the view window can be seen.
You can click and drag the red rectangle to move the view window over the interesting area in your drawing.

13.3.9 Output Window
The Output Window is used by the program to print out any alarm,
messages or formula results.
This sample shows you the result of a linear regression
calculation.
You can use the Output Window also from Scripting Engine like
bool ret = MyDummyFunction(str, strQuestion);
if (ret)
app.Output(alertYes("You said Ok.\n" + strQuestion));
else
app.Error(alertYes("You said No.\n" + strQuestion));

If there is a compile time error in your code, then double-click on the line in the Output Window to show the
row in the code editor where the error is located.

Use right mouse click in the Output Window to show a popup menu for
more editing options.
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13.3.10Report Window
The Report Window can be used similar to WordPad in Microsoft Windows.

It should not be difficult to find out its functionality, because a description here inflates the manual too
much.
Info
The content of the Report Window will be stored (automatically) each time
together with the evaluation.

The following table explains the functions of the report format toolbar.
Symbol

Function
Properties
Text Format Properties
Font
Shrink Text
Text Height
Grow Text
Bold Text
Italic Text
Underline Text
Superscript
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Symbol

Function
Subscript
Foreground Text Color
Background Color
Align Left
Center
Align Right
Bullet List
Numbered List
Decrease/Increase Indent
Insert Table

13.3.11Statusbar
Displays or hides the status bar.
The status bar shows additional information about the currently active evaluation and consists of individual
sections. The first section shows the status of the program or the certain menu description. During long
operations (e.g. load of long table) a text with the percent of progress is shown here.
The next section shows the x/y value from the mouse cursor position in the drawing window.
CAP tells you the key state (highlighted/disabled) of the upper-/lowercase key (Capslock).
NUM tells you the key state Numlock key.
SCRL tells you the key state Scroll key (not often used).
During long operations, a progress bar shows you the progress in the Statusbar.

13.3.12Shape Toolbox
The Shape Toolbox is described in chapter 0.
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13.4 Category Chart & Graphs
These menu items show you everything about charts and their graphs.
→ To make a new chart, maybe it is better to use the Thumbnail Window.
→ Arrange All Charts makes sense when you have more than one chart on your page.
→ Rescale to fit into page can be used when you have a small sized plot and want to print it out in for
example DIN A4.
→ Use AutoScale all the time.
→ Do not forget the menu items around the Graph during your work with SimplexNumerica!
→ The Physics chart has also Cursor Lines in addition to this menu.

Note
Use the Thumbnail Window to select an individual chart from the original picture
of the chart.

SimplexNumerica has some of the following main chart types:
Logarithmic/Linear Cartesian Coordinate Systems, Physics and Mathematical Charts, Polar Charts, Smith
Diagram, Triplots, Business Line Charts, Pie Charts, Radar Charts, Bar Charts, Contour Plots, 3D Surface
Plots, Angular Meter Gauges, Misc. Charts, etc.
Please refer to the following link to see their appearance:

*** Gallery of Chart Types *** www.simplexnumerica.com

Note
You can exchange a selected chart against one of the others with the help of the
Pulldownmenu Change Chart to... or use the Thumbnail Window.

13.4.1 Arrange All Charts
Are there more than one chart in your page, then you can use the following layout menus from the
Pulldownmenu Objects (or their corresponding toolbars).
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But you can also use Arrange All Charts to arrange the charts. You can use the toolbar icon
same.

to do the

If the page is too small, then the program stops with the arrangement and writes an error in the Output
Window.
Go to the Property Window and select Page Properties. Then set the two parameters to your own values:
→ Gap between the charts.
→ Chart page overlapping.

13.4.2 Rescale to fit into page
Imagine you have shrunk the page size and want to adjust the charts to the new dimension. You can do that
by hand or use this menu item here.

Rescale
→→→→→

The program automatically rescales the dimensions of the
shapes/charts, until they fit back into the page.
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13.4.3 Locate Axes
Use this menu or the Chart Explorer to
setup the main chart axes.
→ Only for the Cartesian-coordinatesystem (Physics Chart) available.
The following axes can be set/hide:

Chart Explorer:

In the above chart, there are two graphs with identical data behind. They are different scaled in y direction.
The correct (y) axis for the blue graph (Data 1) is left and for the green graph (Data 1x) is on the right side.
The green one is in green bold because it is the active graph. The active graph is marked with an arrow and

the Graph Name on top and Graph Legend on bottom.
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→ Have a look also to the Chart Explorer.
To scale an axis, please click on the yellow
handle on that axis.
Then look to the Property Window - that has
reacted - to show the related scaling.
Change the scaling values if you like (here the left y-axis).
Note:
There is also another way to edit the scaling.
Double-click on min/max of any axis and edit

directly the min/max values.

Info:
In this SimplexNumerica version, that feature is only available in
the Physics Chart.

How to associate a Graph to the considered Axis?
In this example, the green graph is associated with the right y-axis. How to do that? Click on a Graph in the

Chart or click on the graph name in the Chart Explorer

Then scroll down the Property Window to the entry

.

.

Now, assign the graph "Data 1x" to the right y-axis (Ordinate). Do the same with other axes (if necessary).
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Scaling Properties
This menu calls the Scaling Property Window from the Pulldownmenu Charting.

13.4.4

Auto Scale Main Axes

All available axes will be scaled by the AutoScale function.
Use this menu or the toolbar icon

13.4.5

for all main x/y axes.

Auto Scale Y-Axes

Use this menu or the icon

to Auto Scale only the main y-axis.

13.4.6 New Graph
Please have a look at chapter 0.

13.4.7 Show/Hide SampleData (Marker)
First, select a chart, then use this menu or the associated toolbar icon
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13.4.8 Show/Hide Marker Polylines
First, select a chart, then use this menu or the associated toolbar icon

.

13.4.9 Fill/Unfill Marker Polylines
First, select a chart, then use this menu or the associated toolbar icon

.

13.4.10Show/Hide Bars
First, select a chart, then use this menu or the associated toolbar icon
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13.4.11Show/Hide CurveData (Curved Line)
First, select a chart, then use this menu or the associated toolbar icon

.

13.4.12Fill/Unfill CurveData (Curved Line)
First, select a chart, then use this menu or the associated toolbar icon

.

13.4.13Highlight Active Graph
A Graph can be highlighted (e.g. for calculations, to match its properties) so that the user knows which
Graph it just modifying.
Which one is the selected (= active) graph?
1. You can see it in the Chart Explorer (press key F4)
2. You can see it in the graph plot; the selected graph is highlighted with a broader curve.
3. The Physics Chart shows the name and the legend on the axis side.
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How to highlight the selected graph?
You can switch on/off the highlight of the selected graph in three steps:
Use this menu item or the toolbar icon
three steps.

to highlight the selected graph in

The next figure shows the highlighted graph in three different steps:
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The top left chart is the original one. In the bottom left chart is the selected graph shown with a broader
green polygon, the others are in gray. The top right chart shows the others in original color and the active
graph with a broader green polygon.

13.4.14Swap Active Data/Curve
This menu is to swap the SampleData and the CurveData of an Active Graph.

13.4.15Swap All Data/Curves
This menu is to swap the SampleData and the CurveData of All Graphs.

13.4.16Popupmenu Graph Labels

Use this menu to monitor Graph actions.
It is only for the Cartesian-coordinate-system (Physics Chart) available.
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Show No Data Points
Data points (x/y values) can be shown as labels
beside the marker on a graph. But this menu
deactivates these labels.

Show All X Data Points
Shows all x values as labels beside the markers on
the active graph.

Show All Y Data Points
Shows all y values as labels beside the marker on
the active graph.
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Show ArrayEditor Legend
Shows the legend per data row as labels beside the
marker on the active graph.
→ You can edit the legend in the GraphTable.

Click the button Legend to call next dialog and edit the
labels for each data row.

Show X/Y/Z Values pass the Limit
Shows all x, y or z values pass two limit lines as
labels beside the marker on the active graph.

Note:
Click on a yellow rhombus handle, hold the left
mouse button down and move the line.
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Set Exclusive Data Points
Use Exclude Data Points
If there are e.g. measuring points that are not interested to shown, then you can hide their labels. Put their
indexes into the next dialog and check the menu Use Exclude Data Points.
Result:

Note:
If the menu Use Exclude Data Points is not checked, then all data points are
labeled.

Show Label Box
Switch on and off the labels.

Label Decimal Places
Set the decimal places of the labels in the Graph Properties.
→ When you use this menu item here, then the program filters
the properties to the Graph Labels.
→ Do not forget to clear the filter afterwards…
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13.4.17Graph Manipulation
Use these menu items or the associated toolbar to manipulate the position and the data points of a graph.

→ Please have a look at toolbar chapter Fehler! Verweisquelle konnte nicht gefunden werden..

Floating Scaling
Move x-Axis-Scaling during movement of a Graph.

Move Graph/Scale X->
Move Graph/Scale in X->Direction.

Move Graph/Scale Y->
Move Graph/Scale in Y->Direction.

Move Graph/Scale XY->
Move Graph/Scale in both XY->Direction

Move only Graph X->
Move Graph in X->Direction (Scale ossified)
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Move only Graph Y->
Move Graph in Y->Direction (Scale ossified)

Move only Graph XY->
Move Graph in both XY->Direction

Make new Graph, Add or Move Points

Make a new Graph, then add or move marker points.

Clear Graph, Add or Move Points
Clear existing Graph, then add or move new points.

Let Graph, Add or Move Points
Add or move points from any existing Graph.

Delete Point
Delete an existing data point.

Draw Polyline
Draw an independent poly segment line.

Close or Open
Close or open polyline.

Reduce Polyline
Reduce polyline with less point.
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13.4.18Lasso Graph Data
Sometimes it will be necessary to alter data points in a Cartesian-coordinate-system. For instance,
if data points are lying outside a normal graph expectation, then it can be difficult to find out
which indexes these points are have inside the GraphTable array. For selecting strange data
points, the Lasso is predestined.

Note: Before you can manipulate any data points, a Lasso has to be drawn via mouse like a normal
polygon.

Use Active Graph
The Lasso functions will only manipulate the active Graph, but only if the graph data points are lying inside
the Lasso region.

Use all Graphs
The Lasso functions will manipulate all Graphs, but only if their graph data points are lying inside the Lasso
region.

Draw Lasso and delete Data Points
To delete certain data points, chose this menu and draw a lasso around the
data points.

Note:
The data points will be deleted immediately.
You can also use the toolbar icons
Graphs.

either for the active Graph or for all

Draw and select Lasso, then Delete Data Points
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The same as the menu above
but without to delete
immediately the data points.

Note:
The lasso is waiting for any
command.

Draw and select Lasso, then Mark Data

Points in Table
Marks the data points inside the hull of the lasso
in the GraphTable.

Draw and select Lasso, then Show Data Points in Output
Shows the marked data points in the Output Window.
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Draw and select Lasso, then Use for Exclude Data Points
Puts this data point indexes in the left dialog.

Note:
Use this link to see for what.

Draw Lasso and delete Data Points
Yes, the title says what it makes.

Remove last Lasso
Removes the last lasso from screen.

13.4.19Popupmenu Cursors
The following menus are for cursor functions and visual zooming.

Crosshair Cursor
Invokes the Cross Hair Cursor on screen. Right mouse click to quit.
Toolbar Icon

Expand Cursor
Expands (zoom) the area in the Physics Chart.
Toolbar Icon
Herewith you can expand a horizontal area with two vertical borders. It appears a
perpendicular line with current indication of the coordinates in the Status Bar. Click with the
left mouse button to set the interval. After that, all available graphs are expanded
immediately. After Expand the interval borders are shifted.
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Zoom Cursor
The same for a rectangle Zoom area (only made for the Physics Chart).
Toolbar Icon

Zoom Back
Zooms back, step-by-step, to the original area.
Toolbar Icon

Delete Data Outside Chart
Deletes all the data points left and right from the chart. Be careful, because all are removed, after. No Undo
possible!
→ Toolbar Icon
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13.5 Category Algorithm
Here you can select an algorithm and then calculate it.

13.5.1 Recalculation with Properties
Call this menu item and the program will guide you to the Graph
Properties, Category Graphs, as shown to the left.
→ Press the buttons…

…to re-calculate the algorithm(s), assigned to each graph.

Recalc the current (active) graph from the selected chart.
Hint
You can highlight a graph to see which one is active. Please have a look at
chapter 13.4.13!

Recalc all graphs from the selected chart.
Explicitly Undo the last action. Extra button here, because (big) data is involved.
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13.6 Category Interface
13.6.1 Enter Simplexety
Simplexety is an external calculation program
from the author of SimplexNumerica. It is used
here for calculations with explicit formulas.

Return Nothing
Use Simplexety only for your calculation purposes.

Return Formula String
Step 1
Use Simplexety to edit the formula in
the window below and press Enter to
return it to SimplexNumerica.
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Step 2
Edit the formula string and set up
the text parameters to your
satisfaction.

Step 3
Move the, now Text Label, around the chart.
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Return Formula Form
Step 1
Use Simplexety to edit the formula in the Form
Tab and press Enter to return it to
SimplexNumerica.

Step 2
Move the, now Image, around the chart.
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13.6.2 Set IPC Connection
Use this menu item as the starting point for the SimplexNumerica Inter Process Control (IPC) Client/Server
functionality.

You can use SimplexNumerica remote-controlled with external applications (yes, more than one client app).
Then SimplexNumerica acts as a Server and the external application(s) acts as a Client.
To test this, we have provided a Client demo application. First, call Start Server in the dialogbox.
Please have a look in the installation folder:
< ..\ IPCTestClient >
You will find the files:

Please call the program IPCTestClient.exe (alternative the new program SimplexIPC.exe) and press the
button Connect to connect to the IPC Server (= SimplexNumerica).
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Here are the steps:
1. Start Server
2. Connect Client/Server
3. Send Command or Script
You can send a command or a script from the Client to SimplexNumerica. It will execute the command
immediately and compile and run the script.
Address:
Use the address localhost, in the case that both programs are running on the same machine, else use IP
address or the client machine name.
Port:
Let the default port 5050, or change it.
Quit:
After the transaction, make a disconnect with the button Disconnect.
Info
Please refer to separate manual “Programming SimplexNumerica with AngelScript” to
get more details about the inbuilt scripting languages.
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13.6.3 Push in Runtime Mode
In Runtime Mode are some selection methods not available, so that the program looks like a dashboard or
SCADA application.
Maybe this functionality will be extended in future releases.

13.6.4 Database Storage and Requery
Here, you will find the following menu items for database requery:
•
•
•
•
•
•
•
•

Requery Import Database
Requery Chart Label
Requery Chart Label by Date/Time
Requery Text Label
Requery Selected Text Label
Requery Text Label by Date/Time
Jump over inhibited Layers
Properties

Hint
Please refer to the Prime Example, Generate Reports at chapter 0. Here at the
tutorial the functions and procedures for Database Requery will be explained in
detail.

13.6.5 Recalc
Here, you will find the following menu items:
•
•
•
•
•
•
•
•
•
•

Recalc Chart Labels
Recalc All Text Labels
Recalc Selected Text Label(s)
Set Recalc Tag Names equal Shape Names
Set Recalc Tag Names equal Report Names
Set Constants...
Number of Iterations...
Display Progress Bar
Jump over inhibited Layers
Enable Save Result to Database

The same hint as before…
Please refer to the Prime Example, Generate Reports at chapter 0.
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Recalc Chart Labels
Function: Recalc the tag of each Chart Label.
Before it gets to complicated in chapter 0, we can demonstrate that function here in a shorter way.
Let’s add a chart from the thumbnail window and then choose a predefined
Chart Label for this purpose here.
→Please close all evaluations (pages).
→Please click on this symbol or move it to an empty page.
→Please have in mind, that a Chart Label is always related to a chart,
whereby a Text Label is independent and not fixed on that.

We will choose the Header Chart Label for the re-calculation of a formula.

→ Double-click on the red pin opens the Labelling dialogbox...

We want to put a simple formula into the tag edit field:

calc{ 3 + 4 }

You can’t see any change at the Header text, yet.

Now, call the menu item…
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…and get the right result.

Recalc All Text Labels
Function: Recalc all Text Labels (Doesn’t matter whether selected or not).
Now, we want to do the same as before with a Text Label.
→ Let’s add a Text Label from the Drawing Toolbar.

Call it Alpha (Shape Name) with the Shape Text: 3, Shape Tag Text will be ignored.

Add the next equal steps:
1.
2.
3.
4.
5.

Add a Text Label Beta with the value 4
Add a Text Label Plus
Add a Text Label =
Finally add the Text Label γ
Arrange it to the formula…

The Text Label γ is different:
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Now, call the menu item,
Recalc All Text Labels or
Recalc Selected Text Label(s)
And you will get:

What is the sense behind?
Again: Please refer to the Prime Example, Generate Reports at chapter 0.

Now, we want to demonstrate the same with database support. Write this on screen…

…and the properties of alpha are now (beta are the same):

The Shape Tag Text [tag] is a placeholder for the expected database query entry.
The Shape Gamma is the same as above.
The next step is to use the Database Requery menu item from chapter 13.6.4 to fill the placeholder [tag]
with data from the database source.
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Then, you can call this menu item to recalc Gamma, again.

Recalc Selected Text Label(s)
Function: Recalc selected all Text Labels, only.
Please have a look to previous chapter.

Set Recalc Tag Names equal Shape Names
Instead to use the full Shape Name for
(re-) calculation purposes, you can use a
shorter form, if you like (e.g. β instead
Beta).
The shorter form can be set in the
properties in the rubric Recalc Tag Name.
Don’t forget to set the flag below to True.

If you do not like a shorter or different name, but the same as the Shape Name, then use this menu item
here to set all equal to this.

Set Recalc Tag Names equal Report Names
Use this menu item to automatically set for all
shapes the Report Tag Name into the Recalc
Tag Name.
Hint
If you have a lot of shapes on
your page, then this menu item’s
help will be appreciated.

Page 263 of 372

SimplexNumerica V21

-264Ribbonbar Reference

Set Constants...
Constants can be used in formulas for calculations. These constants here are special ones for the Text
Shapes. Constants should be unique.

You can save the table to and load it from a
Microsoft Excel© file.
If you load an Excel file, then put its Sheet
Name or Sheet Index in the edit field below. If
edit field is empty, then the program loads
the first one.

Number of Iterations...
Here you can set the number of turnarounds. To avoid so called circular references, the program default
makes minimum two passes (turnarounds) over all text shapes. But, you can change the number in the
dialogbox:

→ You can set the value also to 1, but that is not recommended!
What does circular references mean. Here an example: Imagine you want to calculate again γ = α + β, and
this time α, β values were not queried from database, as above, but also calculated, like α = 5 * sqrt(2) and β
= 2 * α. You will have definitely a circular reference if β was calculated before α. From bad to worse, maybe γ
was calculated before α and β.
→ To avoid this, use more than one pass, or
→ to avoid this, put the Text Labels in the right order; try to reproduce this:
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γ = α+β
α = 5 ∗ √2
β = 2∗α
The right order is: calc α, then β and finally γ.
To reflect this in SimplexNumerica, look at the Chart Explorer:

→ That is the right order.

The right order is:
On top of the list always the first to calculate Text
Shape, then the next and the last on bottom of the
list.

Display Progress Bar
Displays a Progress Bar during calculation. In fact, that is a little bit slower...

Jump over inhibited Layers
If there are (text) shapes not necessary to recalc, then put them on an inhibited layer.

Gamma, Beta and Alpha are lying on a not inhibited layer.
Info
When you going to checkmark this menu item here, then inhibited layers will not
be re-calculated.
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Enable Save Result to Database
After the calculation, you can save the results to an external database (server). Here you can globally enable
and disable this behavior. But you need to enable it for each individual text shape, too. That makes sense;
imagine you want, during maintenance of the database, for a short time disable the storages…

Use the properties to set each text shape differently.
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13.7 Category Trending
This is the start menu for online trending of external data inside SimplexNumerica. Here, you will find the
following menu items:
•
•
•
•
•

Start Trending
Stop Trending
Refresh Trending
Scrolling
Properties
The menu item Properties will guide you to the Property Window.
Please refer to the Trend Tutorial at chapter 15. Here at the
tutorial the properties and the procedures for trending will be
explained in detail.
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14 Simple Tutorial
Now we will show you the making of a simple chart, a Physics chart, typically named as Cartesian-coordinatesystem.
First, for this tutorial, close all existing Tab-views.
Next, open the Thumbnail bar. Then click on the pictugram Physics. The result
should be similar to this picture:

Use the property pages on the left to change the appearance of
the chart. The icons on top of the property page can be used for
sorting, expanding or different belongings to the entries.
Next, we will change the data of the chart…
Use the assigned grid view, called GraphTable for this purpose.
Each chart has its own data sheet. You can swap between
selected chart and sheet, very simple with the toolbar icon
or
key <F3> or Pulldownmenu GraphTable, Swap Graphics / Data
Sheet. If the chart is not selected, then select the chart and press
<F3>.
Click on the toolbar icon
or the Pulldownmenu File, New… or
press key <Ctrl + N> to clear the content of the sheet. You can
also use the new icon

.

Within the grid you can be in Table Mode or View Mode.

 See chapter 10.2.2 for the differences of the table and view mode.
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Remark:
SimplexNumerica has two modes for data
editing inside the same data sheet, Table
Mode (→Uncheck View checkbox) for
comfortable editing like Excel and the View
Mode (→Check View checkbox) for nearly real
time display, but limited data input.

Tips:
→ If you need more rows, then deselect checkbox
and press return in the last row.
→ If you like to see the real format of your data, then click on
→ If you need less rows, then stay in

to change to the View Mode.

and put ~ in any row (Icon

).

Put any data points into the sheet and press
<F3> to swap back to the Graphics View.
Next, make an Auto Scale to format the range
of the axes more convenient.
Press the icon
from the toolbar (or use
the Pulldownmenu Charting, Auto Scale Main
Axes).
If nothing happens, yet, then the program has
already called the AutoScale, before.
Next, go ahead and choose a curve fit
algorithm to interpolate your data. To do that,
first click on the graph (marker or line) in the chart.
This will select the chart and the graph in the Chart Explorer (use
key <F4> to show/hide).
Please select the Graph “Data 1” in the Chart Explorer.
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Parallel to the selection in Chart Explorer, the Entries in the
Chart Properties have changed.
Please go ahead and select the entry Numerical Algorithm
inside the Chart Properties. Please popup the Algorithm
menu. In the popup menu, please choose Interpolation and
then Cubic Spline. Put 300 Curve Points in the edit field. Then
click on the button Recalc. The result will look like:

The program has removed the polygon line and put a curve instead with the marker sets.
Please use the next toolbar to play around graphs:

Use again the Chart Properties and click on button
right to
Marker/Lines to change the marker type (or something else).
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You can also click on the pin on the right side of the graph...

Next step: Put another x/y data column (Graph) into the chart. Press <F3> to show the sheet. If there is more
than one chart in the view, then you have to select the right chart before you call the sheet. Of course, you
can click on the tab on the bottom of the window to change to the right data sheet.

We do not use the z-axis. Click the toolbar icon

to hide the z column.

As you can see the checkbox, the checkbox left to View is
checked. That means the GraphTable editor has swapped to the
fast View Mode. In View Mode, the program shows only the
visible parts of the internal arrays in the sheet. The Table Mode
(uncheck View) holds always a copy of all array entries. View
Mode is much faster than Table Mode but Table Mode is more
comfortable to handle for the user.
To put a new column in, you can click on the icon

.

SimplexNumerica always appends two x/y columns (or three
x/y/z columns) because it works with arrays, internally. That is
also much easier for the user because there is no need to select columns to see the graphical result.
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In fact, the program makes a copy of the active graph.

 Tip: Do not forget to save your evaluation from time to time.
Next, click on G1.y to select a y-column in Graph 2 (Data 1 was our first graph). Let us fill the column with a
random sample. Use this red-bordered icon:

As you can see the G1.y column has one cell more than in the first graph. Parallel the x-axis (G1.x) has gotten
also one cell more (with zero initialized). The cells of Data 1 have tilde signs.
➔ Tildes are guessing NO DATA AVAILABLE.
You can set tildes manually with the toolbar icon

.

Next step, we could change the G1.x column. For instance, you can change the 0.000 in 20 or something else
- but let us fill again a column automatically. Please select the G1.x column and call Fill incremental from the
Pulldownmenu (show next picture).
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Please fill exactly the same values into the dialog box.

You will see the next picture.

Do this:
Please let the column selected and Copy (Ctrl
+ C), click (with left mouse button) on G1.y
(will selected) and Paste (Ctrl + V) it to the
right next column (G1.y).
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We have copy & paste the x-axis column to the yaxis column.

Next step, we want to calculate this column with
the App Simplexety.

Please let the column selected and click on the toolbar icon
longer but the next time it appears immediately.

Make a simple formula like

to call the tool. The first call takes a little bit

y = x2 + A whereby A = 25 and press button

Hint:
For filling columns, the information “ y = ” will be ignored.

→ x is the important variable. It stands for each cell in the selected
column(s).
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You will see here the German numbering format.
Next, press <F3> to go back to the chart. Then you should see something like that:

Unfortunately, we could not distinguish between the
two graphs because the data of Graph 1 is versus
Data 1 too huge. Second axes can help here.
To do so, please call the menu in the left picture to
set a new x-axis on top of the chart…
… and a new right y-axis
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The result should look almost as follows after a
couple of reformatting:

We will put the graph Data 1 to the upper and right
axes. Please change the interval of these axes.
Double click on the min/max axis scaling of each axis.
Change the values: x from 0-16 and y from 0-60.
It should look like this picture now.

Now, we have to assign the graph Data 1 to the new
axes. Let us do it in the properties.
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 If you have here another graph names, then change the name to Graph 0 (instead of Data 1) and Graph 1
You can change the graph names here, too.

Right now, Graph 1 has only marker but no curve. Make a regression for Graph 1 either in the same way as
before with Graph 0 or direct from the Pulldownmenu Algorithm.
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In the properties, change the Fit Degree and Number of Curve Points and then press Recalc to calculate the
curve.
The output of the fit is shown in the Output Window next to the properties.

Would you like to calculate all graphs in the chart? → Then hold Ctrl key and press Recalc.

Page 278 of 372

SimplexNumerica V21

-279Trend Tutorial

15 Trend Tutorial
The Online Trending System is the way to trend external data inside SimplexNumerica. Trending is for
updating data as far as they have changed on a medium (for example a *.csv file on disk).
To start-up, we will use a file interface, because it is the simplest way to exchange data between different
applications. Furthermore, if you are going to exchange data with the help of files you will have a persistent
storage without any data losses when one of the programs is crashing. The data can also be stored
persistently into the file. When the program comes back, then it can refresh the lost data immediately. This
interface is normally fast enough, simple and very robust.
First, we need a source that will change data in a trend file. The author has made a small CSharp program
that generates a data file and updates it with arbitrary data, continuously. You can find the CSharp project
(incl. source code) in the SimplexNumerica tutorial folder, eg. in
[your_install_folder]\SimplexNumerica\Tutorial\CSharp\TrendDemoProject

There is the solution file <TrendDemo.sln>.
For instance, the program can be in the folder (here for 64-Bit version)
C:\Program Files\SimplexNumerica64\Tutorial\CSharp\TrendDemoProject\TrendDemo\bin\Release

The name of the program is TrendDemo.exe.

Info
You can find this program also in the folder:
C:\Program Files\SimplexNumerica64\Tutorial\Trending

Start this program and then put a filename in the edit field (without the
path).
Then press the button Start Trending.
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The content of the file will change each second. Next view is an example of some produced data.
To find the file, look e.g. here:
…\Tutorial\Trending\trend.txt
Info
The trend file is there where the program
was started!

The file has two columns, date/time and a real value.

In the following chapters, we want to explain the reading functionality based on the next methods.

15.1 Method 1: Load a Sample Trend Evaluation
Please load the sample evaluation
…\Tutorial\Samples\Trending1.sx

Fig.15-1: Trending a *.csv file

Page 280 of 372

SimplexNumerica V21

-281Trend Tutorial
→ Now, click in the Chart Explorer on Graph 1 and
beneath on Numerical Algorithms Property icon. There
you will find the SampleData File entries in the
properties (see below).
→ Please change the Data File Name entry to your
trend file place.
→ You can press the button
the right path.

to test

→ Now, press the icon
Trending.

Start

…or use the Pulldownmenu Interface

→ Please stop the trending here. Use the toolbar icon Stop Trending

.

→ Please stop also the CSharp trending program (click Stop Trending)!
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15.2 Method 2: Use Data Import Dialog
Next, we will show how this data structure can be imported via the Data Import
menu.
Because we want to keep it simply:
→ Make an empty evaluation (Use Ctrl + N).
→ Click on the pictogram Trending on the Thumbnail bar.
Now, we want to import the produced data (trend.txt). Use the data import dialog
from the Pulldownmenu File, Data Import From, Table Format (*.csv).

You can also use the icon

from the Array/Table Editor toolbar.

Open the right file, e.g.
..\Tutorial\CSharp\TrendDemoProject\TrendDemo\bin\Release\trend.txt

in the upcoming Fileselectbox. Please say Yes to the next dialogbox:
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Hint:
SimplexNumerica either stores the data-import-settings in the registry - at the
end of the program session, or if you like dedicated to each chart.

Fig.15-2: Settings for Data Import Dialog
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Jump over the first two lines and press Update Preview to see a preview in the dialog data sheet. Then press
Import into Main Grid to leave the dialog and see the result in the main GraphTable. Then press <F3> to see
the graphics result.
If you like to automatically adjust the graph colors and line styles, then
say “Yes” to this messagebox.

The result will similar look like this:

If you like, then you can change the axes scaling manually:

To do that, please set the property Sub AutoScale on “manual” instead of “Automatic”.
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If the scaling text is also to height, then change it also in the
properties.

There are some other things here that could be changed: The red
markers are too big. Simple, click on any red marker and change it
in the properties.

If you like to change header and axes label text, then that is also very
simple.
Please double click on the red pin on top of each label text.

By the way, give the chart another name, instead of SimplexChart(n).
Please change the name of the chart for instance to “My First Trend”.
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Now, it is time to come back to the trending issues…
Before, we had imported the file ‘trend.txt’ into the
GraphTable, but without to trend afterwards.
The parameters of the import dialog are also available in the
property section ‘Data Import Format’ (see left picture). In the
case that you have manually imported data from file as done
before, SimplexNumerica will put its data import settings to these
properties.

15.3 Method 3: Use dedicated Graph Trend File
Next, we will show how our trend file can be assigned to a Graph (like above in
chapter Method 1). If you have more than one Graph, then you need for every
Graph to trend a dedicated trend file (except you are not going to trend every one).
Again, because we want to keep it simple:
→ Make an empty evaluation (Use Ctrl + N).
→ Click on the pictogram Trending on the Thumbnail bar.
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As shown above in chapter Method 1, each individual graph can
also have its own data import file. To see that file entry, click in the
Chart Explorer on the Graph with the name Data 1 and put into
the Property Graph section SampleData File the right file path.
→ For this tutorial, uncheck Data 2 and Data 3.

If you like, then you can reload the file again. Press button
. The chart should look the same
like above.
As mentioned before, each graph can have its own
trending file. That file should also match the data import
format!
Important is that the file has only one x / y (/z) column,
respectively, like the sample file.
The entry Trend Option (+ sign) indicate that the
dedicated graph can be used for trending.

Here again:
→ Please set the Data Import Properties to the items shown left.
If this is done, then the graph is capable for trending. That means
that you can resume our test the trend file continuously and
SimplexNumerica is going to update the graph with the new data.
Use

to test!

To control the trending behavior, please use the dedicated
toolbar (or the Pulldownmenu).
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→ Please click on Start Trending.
On bottom left to the chart is a flashing lightbulb

to identify a trending watchdog.

Please start the external trending program (see above) and press button Start Trending again.

Press No in the Messagebox to append the new data to the old ones. You should see the new data in the
chart updating every second.

Please click on Stop Trending.

You can test it also with
Notepad. Put some arbitrary
sample data into the editor
and press save.

Page 288 of 372

SimplexNumerica V21

-289Trend Tutorial

When you set the entry “Look for Data and Time” to true, then
the program accepts the following formats for date & time and
for real values (separation is county specific):

Format
Normal
Scientific 1
Scientific 2
Technical
Date
Time
Date and
Time

Example
123.14
1.2314E02
0.12314E03
123.14E00
23.07.1996
16:10
23.07.1996
16:10

or

or

07/23/1996

23-07-1996

07/23/1996
16:10

23-07-1996
16:10

There are several other options for trending. We
will have a look to each property and how it will
influence the trending behaviors. Please click on
icon Trending Properties in the toolbar and have a
look to the properties for trending:
Hint for Always activate View:
View means an evaluation in a window
(*.sx files). Views are separated
into tabs straight under the Main
Toolbar.
Normally, an invisible display (view)
is not renewed (not updated)!
However, if there are two views lying
visible underneath, then they should
have been updated.

You can also use this icon in the Main Toolbar:
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This table describes each entry:

Property
Trending On

Action
Enable/Disable a chart for trending.
If there is more than one chart in a view, then it makes sense to switch on/off
one of them.

Trend File Import From
Graph File(s)→ Each individual graph will have its own data import file.
Data Import File → One data import file for all graphs.
Text Label File → Special file for trending shapes.
Enable/Disable a graph for trending.
If there is more than one graph in a chart, then it makes sense to
activate/deactivate some of them for trending or not. This cannot be done here
(see below the graph properties). Here you can adjust whether all graphs shall
be trended or not.
Chart Explorer: Click on Graph 1

Trend All Graphs

Scroll down to Sample Data File and put a + right to Trend Options to mark this
graph for trending.

Show Guideline

Refreshing
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The guideline is a vertical line at the end of the last data point from the active
graph. The color of the guideline is equal to the color of the active graph.
There is an icon in the trending toolbar for Refreshing.
Refreshing is only available for database and server online trending (see
SimplexNumerica Custom).
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Scrolling

Always Activate View

Update End Time

Scrolling equal True will scroll the graph along the x-axis. Use Scroll Range for
the data time range.
If there are more than one view on screen, then it makes not always sense to
update the views in the background, because the program performance will get
slower with the number of views. If there are views horizontal or vertical,
respectively, ordered on the visible level, then each view should be activated.
This here is only available for database and server online trending (see
SimplexNumerica Custom).
000d 03h 01m 30s

Scroll Range
Inflate X Axis
Inflate Y Axis
AutoScale

Scroll Range for scrolling along the x-axis. Edit day, hour, minute and second.
If AutoScale has been activated for x-min/x-max values, then only if a data point
exceeds the left/right border of the chart, min/max will be extended.
If AutoScale has been activated for y-min/y-max values, then only if a data point
exceeds the top/bottom border of the chart, min/max will be extended.
AutoScale can be activated for xmin, ymin, xmax, ymax, dx and dy. Dx and dy are
the real distance between two labels.

xmin
ymin
Hint:
xmax

If you have checked this here, then no manual scaling will work during trending.

ymax
dx
dy
Scan Time Interval
Hold Settings

Command

This is the scan time interval between two trend updates (in ms).
unused
File
SimplexNumerica Standard Edition always the word file.
SimplexNumerica Custom Edition command for
Database and Client/Server-Connections Connections.
-

CommandEx

SimplexNumerica Standard Edition nothing here (or -).
SimplexNumerica Custom Edition commands for extended
Database and Client/Server-Connections
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15.4 Method 4, Data Import Trending
We have seen in chapter Method 2 how to import data via Data Import Dialog. Now, we want to trend this
import in a similar way.
Again, because we want to keep it simple:
→ Make an empty evaluation (Use Ctrl + N).
→ Click on the pictogram Trending on the Thumbnail bar.
By the way:
Please compare this picture to the left with that from above chapter Method 2 + 3.
The trending pictogram looks different. That is because I have changed it previously.
How can we change that?
1.
2.

Make an empty evaluation (Use Ctrl + N).
Click on the pictogram Trending on the Thumbnail bar (or drag it).
→ Info: The path to this is held by the Clipboard!
3.
Change the look (Theme) of the chart…
4.

Save the selected Object (Chart)

→ Info: Paste the path from the Clipboard to the Fileselectbox.

5. Make a right mouse click on the chart and select

6. Call Microsoft Paint (MSPaint)
7. Paste the bitmap into MSPaint (and paint around it).
8. Click again on the pictogram Trending on the Thumbnail bar.
→ Info: The path to this is held again by the Clipboard!
9. Save the bitmap in Paint with the path in the Clipboard but change the word “objects” to “bitmaps”
and the extension “sxo” to “png”.
10. That’s it!
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Back to the roots…
To import and trend a Data Import File, please follow the steps:
→ Change the Trend Properties to
Data Import File.

Push the toolbar icon

→ Load the right trend
file.
→ Set the right settings.

→ Push here again
Start Trending

Follow the trend…

Fig.15-3: Settings for Data Import Trending

That’s it!
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15.5 Trend Toolbars
SimplexNumerica provides two trend related toolbars:

15.5.1 Trending Toolbar

..or change the toolbar to:
Change Toolbar Style:
Right mouse click next to any toolbar opens the Toolbar popup menu. Click on
Customize… will open the next dialog.
Select the Tab Toolbars, then e.g. entry Trending and then check the button
Show text labels.

15.5.2 Trend Scaling Toolbar
Scaling toolbar without text:

Scaling toolbar text:
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16 Prime Example, Generate Reports
We want to do the following tasks:
1. Create Database
Create a Microsoft Access Database

2.
Document Report
Create a WordPad RTF4 template with transferring the data
from the evaluation report in this document report.

3.
Evaluation-Report
Creation of a data sheet for AMN gas engine with
replenishment of data from a self-created Microsoft
Access database.

4

RTF: Rich Text Format used by Microsoft Wordpad and Word
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16.1 Create a Database
The Microsoft Access database is used as a data source for the evaluation report. The
database is kept deliberately simple. It consists of only one table. In the example folder, you
can already found a simple version of this database with the file name <AMN gas
Engine.mdb>.
Please open Microsoft Access (If not present, then jump over and use this file, only).
In the so-called Design View, the field name and the field data type can be specified. For this model, the
following fields are used (German version):

Into the Data Sheet View, the data is entered:

… namely on the basis of the in the documents report described subchapters.
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16.2 Create a Document Report
The document report can be created in WordPad or Word, but also in SimplexNumerica
according to the following pattern:
Following, the Technical GraphTable (our document report) how it appears completed.
Subsequently, the design should be an evaluation that will be used as a template for the
exchange of information with SimplexNumerica. Therein the data (e.g. 18V51 / 60G) are
shown as placeholders. The name of an item is not specified. So that not mistakenly a
wrong text is replaced, you should put brackets [e.g. item1] around the placeholder.

Technical GraphTable
Manufacturer:

AMN

System:

Four-stroke Gas Engine

Type:

18V51/60G

General Engine cycle:

Four-stroke

Turbocharging system:

Constant Pressure Number of

cylinders, V-engine: 18
Bore:

510 mm

Stroke:

600 mm

Swept volume per cylinder:

122.6 dm

Cylinder output (MCR)

at 514 rpm, 60 Hz: 1,050 kW

Cylinder cooling:

Fresh water Charge air cooler (two-

3

stage)
Starting method:
Emissions:

Compressed air
NOx-emissions maximum

500mg/Nm³ dry @ 5% O 2
Reference conditions according ISO 3046-1: 2002
The stated consumption figures refer to:

◼

Ambient air pressure:

1,000 mbar

◼

Relative humidity:

30%

◼

Ambient air temperature:

+25°C (77°F)

◼

Charge air temperature:

According to engine type, corresponding to 25°C cooling water temperature

Specific gas consumption:
Heat rate: Optimized for power generation, TA-Luft: 7597 kJ/kWh
Electrical efficiency:
Optimized for power generation: 47,4 %; Gas combined cycle: 46,8 %
Nominal generator efficiency: 97.7 %
Lube oil consumption
18V51/60G: 9.0 kg/h
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As describe above, here the template with the placeholders.

In this GraphTable, the placeholders have been defined arbitrarily.

Technical GraphTable
Manufacturer:

[Factory]

System:

[System]

Type:

[Type]

General Engine cycle:

[Engine]

Turbocharging system:

[Item1]

Number of cylinders,

[Item2]

Bore:

[Item3]

Stroke:

[Item4]

Swept volume per cylinder:

[Item5]

Cylinder output (MCR)

[Item6]

Cylinder cooling:

[Item7]

Starting method:

[Item8]

Emissions:

[Item9]

Reference conditions according ISO 3046-1: 2002
The stated consumption figures refer to:

◼

Ambient air pressure:

[AmbientAirPressure]

◼

Relative humidity:

[RelativeHumidity]

◼

Ambient air temperature:

[AmbientAirTemperature]

◼

Charge air temperature:

[Item10]

Specific gas consumption:

[Item11]

Electrical efficiency:

[Item12]

Nominal generator efficiency: [Item13]
Lube oil consumption
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16.3 Create Evaluation Report
Now, the evaluation report can be created in SimplexNumerica similar to the sample file <AMN
gas Engine.sx>. However, this file already shows the queried data from the database (eg 18V51
/ 60G).

Unlike the placeholders described above, here the items are expressed by name. These names
are listed in the properties, so the properties of the individual objects (shapes, charts, etc.).
The user should recognize the template as such. Therefore it is better to mark the data with
these placeholders, for example, with a dash (-) or question mark (?).

Tip:
For better formatting, multiple placeholders (e.g. -------) should be present so
that the formatting can be guided accordingly.
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Next, we will load the example evaluation file <AMN Gas Engine - Vorlage.sx> and make a
database query based on its content.

16.3.1 Database Query
Please open the file
<AMN Gas Engine - Vorlage.sx> and
call the adjacent menu. All text labels are
scanned and the contents are replaced by the
value of the database query.

The prerequisite is that each text label has been
previously prepared for it. That means its
properties should have been adjusted
accordingly.

You can also use the toolbar icon

from the Interface toolbar.

If you want to query only selected text labels, then use

.

If the SQL string uses a date, so you can retrieve any other time with the
menu item
It appears the adjacent dialog for entering the time range. This dialog is not
used in this prime example, however.
Since we do not use a chart in this prime example, the chart labels are not
used.

Chart labels are the texts that move with a chart with, e.g. the Header text, like:

Here is the result of the database query:
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It can be seen that the entry “Number of Cylinders” has not been filled. By using a template with
placeholders, you can easily find that out!
Now, let us examine why the entry has not been filled…
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16.3.2 Assignment of a Database Query
The assignment of a database query to a text label can be done in various ways.
Select the previously not queried text label with the left mouse button:

Then its properties are displayed in the Property Window. Have a look to the Chart Explorer. The shape
name NumberOfCylinders should also be selected.

Here are the properties:

Here you can see the dashes (-----) beneath the heading “Shape Text”, which have not been overwritten. The
entries are available under the heading „Database Query“. They are consistent with the other text label
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entries. To find the cause, you can spent most of the approach of the creation of such a text label or simple
click on the button Define Query.
Creation Approach
Please hold down the Ctrl key and click with the left mouse button on the marked position (the
placeholders):

…then the following dialog appears (parts removed) with the Text Label Properties.

Now click on the button
click in the properties

, then the Define Query Dialog appears similar to the direct
.

In the first property sheet dialog, please connect to the Microsoft Access database with the file name:
<x:\SimplexNumerica\Database\AMN Gas Engine.mdb>. The x: stands of course for any
pathname.

Then it goes on to the property page, which is for the database query responsible…
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Follow these steps:
10. Click in the left tree control on the text: „Four-stroke gas engine “
11. Type the following SQL string into the SQL Text Editor (Icon
):
SELECT [NumberOfCylinders] FROM [Four-stroke gas engine]
12.

Store the SQL string for later use.

13.

Perform the database query.

The result should be

in the table.

14. Click on the cell with the 18, and then select the button:
Tip:
The table has only one cell because the SQL string has been so declared, that
only one value can emerge from the database query. If several values were
returned, then several rows or columns would be present in the table. These cells
could then be selected differently (just as you would do it in Windows Explorer
with files and folders).

15. Finally, quit from the dialog with the button

.

16. The database query works the same as above described.
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16.3.3 Create a New Database Query
This works the same as in the previous chapter 16.3.2!

16.3.4 Creating a New Text Label with Database Query
The simplest way is to use the toolbar icon

Insert Text Label.

Then click with the left mouse button on the position in the report where the text should be placed.

Overwrite once the notice…

…with a new placeholder text, for example
The database settings are the same as in the previous chapter 16.3.2. Click on the button
and go on…
However, if you want a statement such as:
Speed: v = 1234 km / h,
then you can either create three text labels
Label1: Speed: v = ', Label2: 1234, Label3: km / h'
or you can use one text label with a defined tag (called Text Tag Label or Shape Tag Text) as shown in the
following chapter. It also shows how you can calculate with tags.
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16.3.5 Creating a New Text Tag Label with Database Query
We will now explain the Text Tag Label using the parameter Stroke. The statement shall read: ‚Stroke s = 600
mm‘. We will use the Stroke parameter, because this is already a record in the database.
Again, use the toolbar icon
evaluation side.

Insert Text Label and place the text at a point on the free area of the

Important:

Please make sure that you do not place the text on a suppressed (inhibit) layer.
, otherwise it will not be queried!

The dialog with the Text Label Properties opens. Put in the text
→ Stroke: s = [tag],
here at the Tag View.

→ The statement [tag] is a placeholder for the later database entry.

The database settings are the same as in
the previous chapter 16.3.2.

Push the Button
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When the database settings are finish, then the result will be shown in the Text Label Properties:

Please confirm this dialog with Ok, so the sheet changed as follows:

The following (user) database query is already described above, but shortly explained here again.
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Please call the adjacent menu.
Then all text labels will be queried and its content
replaced by the value of the database query.
The prerequisite is that each text label has been
previously prepared for it. That means, its properties
have been adjusted accordingly (done as above) and
the layer is not set to suppress (inhibit).

You can also use the toolbar icon

from the reload toolbar.

If you want to query only selected text labels, then use

.

Hint:
If one no longer need the tag, then simply remove the tag entry from the dialog.
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16.3.6 Creating a New Text Tag Label for Calculation
Now we want to create another text label and automatically perform a calculation
with the help of two other text labels. We will use for these two text labels the
parameters Stroke and Bore. The new text label should be assigned to a calculated
stroke volume.

VH = (d2 π) / 4 * s

Again, use the toolbar icon
Insert Text Label and place the text at a point on the free area of the
evaluation side. Finally, please put the above formula in the Tag View. It is handy that you can look right into
the list box to the (unsuppressed (not inhibited) in Layer) tag names. The tag names are of course the other
text labels.

A formula is always framed by means of the word calc {...}. An integrated formula parser can later interpret
the formula. Here the statement:
➔ calc{ 1/4 * Bore^2 * PI * Stroke }
Thus, the new third label consists of calculating other labels. It may itself not be included in the calculation.
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Of course, the formula can be
changed later in the Properties.
On the screen, the evaluation looks
like this:
→ Only a selected question mark!
Please go to the Properties and
correct the information as follows:

To change the question mark also in the shape name it is best to use the properties of the text labels (here
the German Names):

Furthermore, a new layer named "Calc" was created and the text label placed on or assigned to the layer,
respectively.
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Next, the execution of the calculation is
made.
If you want to re-calculate all text labels,
or only the selected ones, then please
select the text labels on the screen and
call the adjacent menu or the
corresponding icon in the toolbar.
Unfortunately, the calculation was not
working right. It appears the word:

The output view shows you the information about the error:
Text Label: Volumen
Formula: 1/4 * Bore^2 * PI * Stroke
Error Message: Undefined token "PI" found at position 15.
Token: PI on Position: 15
➔ Please change PI (Upper Case) in pi (Lower Case) to fix this error!
➔
Please press

again…

Then you get this error:
Text Label: Volumen
Formula: 1/4 * Bore^2 * pi * Stroke
Error Message: Can't evaluate function/operator "*": Argument 2 of
function/operator "*" is of type 'i' whereas type 'm' was expected.
Token: * on Position: 18
You can see that the error messages can sometimes be a little bit cryptic. The reason here is that “Bore” and
“Stroke” were exchanged against the database entries “510 mm” and “600 mm”. Now, the program formula
parser tries to calculate with the string “510 mm” instead of the number “510”. Right, the input “mm”
should not to be in there!
Use the properties and try to manually replace 510 mm in 510 and 600 mm in 600 or better directly in dm
(decimeter) instead of mm: 5.1 and 6.0. Then recalc again… See the result; should be ok.
Next, place this in: “V = calc{ 1/4 * Bore^2 * pi * Stroke } liter”, then you will get:
Page 311 of 372

SimplexNumerica V21

-312Prime Example, Generate Reports

You have seen that it is very important to edit a proper formula string and shape text related to the text label
properties.
Let's look again at the formula: → calc{ 1/4 * Bore^2 * pi * Stroke }
…it is noticeable that the two variables "Bore" and "Stroke" denominated equal to the name in the Shape
Properties:

If one uses a longer Shape name, it is often undesirable to use these in the calculation formula. Therefore,
you can enter a nickname either under the headings “Exchange Report” or “Re-calc with Shape tags”.

➔ If the flag is set to True, then the entry will be used. The report-item is taking precedence.
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→Because of the fact that the Flag Calc with Recalc Tag name is on True, this entry takes precedence.
Thus, the formula can be written as follows:
➔ calc{ 1/4 * Bo^2 * pi * St }
Please press the button

…and see the result as above:
Note:
Is Recalc Format set to Generic String, then the program tries to convert the
string into a number.
The entry Decimal Points specifies the number of decimal places.

Now, we can repeat the calculation with the abbreviations of the category Exchange Report, and the formula
looks like (change the Flags, too!):
➔ calc{ 1/4 * Bor^2 * pi * Str }

Please press the button

again…

…and see the result as above:
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16.3.7 Calculating and Storing in Database
The values are displayed according to the calculation in the evaluation and can also be stored as such.
After the calculation, maybe you want the data stored back in the same database or in a different on
another machine.
To do this, please follow the steps…

1.
Use Microsoft Access and expand the
database to create a new column named Volumina.

2.
the evaluation sheet.

…click on

3. Editing the Properties under the heading: Recalc with Shape tags
➔ Please put
Save Result to Database on True
➔ Please let
Encrypt Result on False
➔ Provider is Microsoft Access
➔ The Filename should be the
same, too.
➔ The Database SQL String
must be adapted for writing on a
database.
➔ In order to make it not too
complicated, a simple update
string is used (as shown in the
next picture):
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Important:
The alias name $SxResult is always given as a
synonym for the expected result of the program
calculation. → Therefore, the result is entered in
this variable!

Hint:
Here is a more complex SQL statement (for Microsoft SQL Server):
IF NOT EXISTS (SELECT * FROM [DBResults].[dbo].[CalcTbl]
WHERE [myStringVar1] = '$Var1'
AND [ExperimentNo] = $ExperimentNr)
INSERT INTO [DBResults].[dbo].[CalcTbl] ([myStringVar1], [ExperimentNo],
[Volumina])
VALUES ('$Var1', $ExperimentNr, '$SxResult')
ELSE
UPDATE [DBResults].[dbo].[ CalcTbl]
SET [Volumina] = '$SxResult'
WHERE [myStringVar1] = '$ Var1'
AND [ExperimentNo] = $ExperimentNr

We have understood that the result of the executing - after
the menu item
variable

- is set to the

$SxResult and that it needs a SQL-Statement to update
the database.

Now, press this button and look to the Microsoft Access Database to the column Volumina; there should be
the value 122.569 in the cell beneath.
If not, then please load the sample evaluation and compare these with yours.
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16.4 Filling Documents Report
The Document Report was introduced in chapter 16.2. Now, we referring back to...
➔ The point is to feed out the placeholders with data from the evaluation.
Manufacturer:

[Factory]

System:

[System]

Type: [Type]

Take for example the type of the machine with the same Shape Name "Type". After the database query, the
Shape Text will be filled with the string „18V51/60G“.This string is to be written in the document Report. As
this has been already provided above with wildcards, a menu item must here be invoked only, see next
picture.
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➔ After running Exchange Report, the value of the evaluation is in the report.

To describe all the Report placeholders, please use the menu item:

Let's look again at the placeholders used above:
Manufacturer:

[Factory]

System:

[System]

Type:

[Type]

•

Compared to the Text Label Name (Shape Name) in the Properties:

They are the same; both are called „Type“. If this is not the case, then there must be a possibility to enter the
corresponding placeholder name.
➔ Use the Properties Report Tag Name to put in a different placeholder name (e.g. Item3).
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In the report, to be seen as:

The result is by calling the menu item…

…the same as above!

That’s it!
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17 Advanced Label Editor
This here is a short description of the extended SimplexEditor inside SimplexNumerica. A simple HTM text,
table and graphic editor. It can load web pages from the internet or from your harddisk. It has a design and
runtime mode and a source editor.

We will describe this chapter only at popular request!
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18 Working with Function Plots
18.1 Insert a Function
Close all evaluations (Tab-views), use the Science Plots, and click on the Functionplot
thumbnail to open a sample chart object. Remove the graph with the name Scatter
Data.
Then use the Pulldownmenu Algorithm, Function Plot and one of the sub-menus (e.g.
Regular Function Plot) either to call the calculation program Simplexety or directly to
open the Function Plot Properties (Use or close Simplexety).

Function Plot Properties
Put the formula | sin(x) / x | in the y = f(x) field and look
to the chart to see the function plot.
All other Function Plots will work the same way.

Page 320 of 372

SimplexNumerica V21

-321Working with Function Plots

18.2 Function Types
You can choose between three different types of functions:
1. Standard Function,
2. Parametric Function
3. Polar Function.
A standard function is defined as y = f(x), i.e. for each x-coordinate there is exactly one y-coordinate. For a
parametric function the x- and y-coordinates are calculated from an independent variable t, called the
parameter, i.e. a parametric function is defined as two functions: x(t) and y(t).
A polar function r(t) indicates an equation to calculate the distance from the origin to a point on the function
given an angle t. t is the direct angle between the initial ray and the point on the function. This means that
the x- and y-coordinates are given as x(t) = r(t) * cos(t), y(t) = r(t) * sin(t).
Function Equation
The equation for a function can be f(x), x(t), y(t) or r(t) depending on the function type. Under List of
functions, you can see all the available variables, constants and functions, which may be used to draw the
graphs.
Argument Interval Range
You can choose an interval for the independent variable. Graph From and Graph To indicates the start and
end of the interval. The graph range should be inside the chart range.

No. of Curve Points
You have to specify the number of steps for which you want the function to be evaluated. When you specify
a higher number of steps, the graph will appear smoother, but it will take longer to plot.
Display Graph Plot or Graph Data
Imagine the tan(x) function, it has to be drawn in steps instead of one polygon line because the points will
getting infinite. Graph Plot will plot the functions in steps, Graph Data in one polygon line.
Graph Plot will not produce any Graph Data (e.g. for cursor, storage, etc.).
Recalc
Only for Graph Data available to explicitly calculate the graph data.
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18.3 Add Tangent / Normal
Use Pulldownmenu Algorithm, Function Plot and then Add Tangent or Add Normal to a function.
A tangent is a straight line that touches the graph of the function at a given point without crossing it. The
tangent may however cross the graph elsewhere. A normal is a straight line perpendicular to the graph of
the function at a given point. If the item is a standard function, the point is identified by the x-coordinate,
while the point is identified from the independent t-parameter for parametric and polar functions.

Hint:
A Normal looks not "normal" in the chart when the x-scale is different from the y-scale (see above)!
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18.4 Fill Area
You can fill an area between graphs or the x-axis in the chart.
Please load the demo evaluation Fill Area.sx from the example folder to see how it works.

The Area can be filled as:

Between function and x-axis
This is the most commonly used type of shading. This will shade the area between the graph of the function
and the x-axis in the selected interval. If you check Decrease to intersection or Increase to intersection, the
interval will decrease or increase until the graph is crossing the x-axis.

Between function and y-axis
This will shade the area between the graph of the function and the y-axis in the selected interval. This is
rarely used and probably most useful for parametric functions. Notice that you still use the x-coordinates for
the interval. If you check Decrease to intersection or Increase to intersection, the interval will decrease or
increase until the graph is crossing the y-axis.

Below function
This will shade the area below the graph of the function down to the bottom of the graphing area in the
selected interval. If you check Decrease to intersection or Increase to intersection, the interval will decrease
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or increase until the graph is crossing the bottom of the graphing area.

Above function
This will shade the area above the graph of the function up to the top of the graphing area in the selected
interval. If you check Decrease to intersection or Increase to intersection, the interval will decrease or
increase until the graph is crossing the top of the graphing area.

Inside function
This will shade the area inside the graph of the function in the selected interval. If you check Decrease to
intersection or Increase to intersection, the interval will decrease or increase until the graph is crossing itself.
This is especially useful to shade a closed part of a parametric or polar function, but it can also be used to
shade standard functions.

Between functions
This will shade the area between the graphs of two functions. The first function is the one you selected in
the function list in the main window, before you invoked the dialog. The second function is selected in the
list box in the 2nd function tab. For standard functions, the interval will be the same for the two functions.
For parametric functions, you may select different intervals for the two functions. If you don't select an
interval for the second function, it will use the same interval as the first function.

Second Graph
When you have chosen Between functions, you may select the second graph function in the Second Graph
field of the properties.
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Shading Range for Second Graph Function
This is used to select the interval for the second function, just like you selected the interval for the first
function in the property field. This is only available for parametric functions and not for standard functions.
For standard functions, the interval for the second function is always the same as the interval for the first
function. If you enter neither a start nor an end of interval for a parametric function, the values for the first
function will be used for the second function as well. Shadings are a great way to mark an area, but if you get
weird results, check that you selected the right function and the right interval. If you try to shade an interval
crossing an asymptote or your shading is associated with a weird parametric function, you might get weird
results.
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18.5 Relation Plot
Relation is a common name for inequalities and equations, also known as implicit functions.
Use Pulldownmenu Algorithm, Function Plot and then Relations (Equations/Inequality). This menu is used to
insert a relation in the coordinate system.
Please load the evaluation Relation1.sx from the example folder ..\Examples\Functionplot

Relation
Here you enter the relation you want to graph. This must be either an equation or an inequality. x and y are
used as the independent variables.
An equation is a statement that one quantity equals another and the quantities must be separated by the =
operator. For example the equation x^2 + y^2 = 25 will plot a circle of radius 5.
An inequality is a statement that one quantity is greater or less than another, and the quantities must be
separated by one of the four operators: <, >, <=, >=. An inequality can for example be abs(x) + abs(y) < 1. Two
operators can be used to specify a range, for example y < sin(x) < 0.5.
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You can use the same operators and built-in functions as for plotting graphs of functions. In addition, you
can also create custom functions.

Constraints
Here you can enter optional constraints, which can be any numeric expression. The relation will only be valid
and plotted where the constraints are fulfilled, i.e. evaluates to a non-zero value. The constraints usually
consist of a series of inequalities separated with the logical operators (and, or xor). As for the relation, x and
y are used as the independent variables. For example, if you have the relation x^2 + y^2 < 25, which is a
shaded circle, the constraints x > 0 and y < 0 will only show the part of the circle in the 4th quadrant.
Here is the same example adapted from the famous program Graph:
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18.6 Differentiation
This menu is used to create the first or second derivative of a function. To create a derivative, make a new
Graph and select the function you want to differentiate. If the function is a standard function, the first
derivative is the slope of the function, and it is defined as the function differentiated with respect to
x: → f '(x) = df(x) / dx.
Tip:
You can load the example evaluation ..\Examples\Functionplot\Functionplot.sx to see how it works!

The violet colored curve is the first derivative of the red colored function sin(x)/x.
Next see the entries of the Chart Explorer and the according Properties for this chart, whereby the graph
with the name Differentiation is selected and hence active in the Property Window.

Chart Explorer
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Properties
Hint:
After pressing the button Recalc the function (in text form) of the first derivative is setting in the Graph
Legend field.
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18.7 Custom Functions & Constants
SimplexNumerica allows you to define your own custom functions and constants, which you can use in other
expressions in the program. You may want to use this to factor out frequently used constants and subexpressions to make it faster and easier to use these items.
Tip:
You can load the example evaluation ..\Examples\Functionplot\Custom Functions2.sx
to see how it works!

Please use the Pulldownmenu Algorithm, Function Plot and then Custom Functions and Constants or click in
the Properties on the button Customize as shown below:

Hint: The button is available only if a Graph made by a Function Plot is selected.
Now, if you click on the button Customize the following dialog appears:
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Entering functions
The names of the functions (or constants on the other dialog tab) are entered in the first column Naming.
The name may contain any combination of letters, digits and underscore, but it must always start with a
letter. You may not use a name that is already assigned to a built-in function or variable. Function arguments
are entered after the name in brackets separated by comma, e.g. f(x,y,z) is a function named f taking three
arguments named x, y and z. Like the function name, the argument names must start with a letter and only
contain letters and digits. The expressions you want to define are entered in the second column. The
expressions can use the arguments specified in the first column and all built-in functions, other custom
functions and constants, and even call themselves recursively. A comment can be written after a # symbol at
the end of an expression.

Changing and removing functions
You can remove a function or constant by clearing the name and definition. All elements using the deleted
function or constant will fail when evaluated. When you press Ok in the shown dialog, all elements are
updated to reflect any changes to the functions and constants.

List of functions
Please see Appendix A for a list of functions…
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19 Algorithm in SimplexNumerica
Curve and surface algorithm are important topics in SimplexNumerica for geometric modelling and
visualization courses. The algorithm functions in SimplexNumerica, especially the Interpolation and
Approximation algorithm, providing another level of sophistication.
In many situations such as surface re-engineering and facial movement animation, you may specify a set of
data points that describes a desired shape (e.g., surface model) through any probing or scanning, and obtain
a surface that contains all data points. Interpolation is also important in computer animation. An animator
may specify a number of key camera positions and orientations (i.e., key frames), interpolate these positions
with any Spline curve (i.e., camera path), and interpolate the key frames with additional frames. While
interpolation can produce a curve/surface that follows the shape of the data points, it may oscillate or
wiggle its way through every point. Approximation can overcome this problem so that the curve/surface still
captures the shape of the data points without containing all of them.

Nowadays, at the age of Wikipedia, it makes no sense to blow-up a documentation with detailed
information about specific algorithm. Instead, we will set a link to interesting articles.
SimplexNumerica provides the following algorithm:
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19.1 Function Plot
Here you will find the following functions:
•
•
•
•
•
•
•
•

Regular Function f(x)
Parametric Function x(t), y(t)
Polar Function r(t)
Relations (Equation/Inequality)
Add Tangent
Add Normal
Fill Area
Custom Function Constants

 Please have a look at chapter 18 for detailed information.

19.2 Regression
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Linear Least Squares Fit
http://en.wikipedia.org/wiki/Regression_analysis
Robust Linear Regression
http://en.wikipedia.org/wiki/Robust_regression
Exponential Least Squares Fit
http://mathworld.wolfram.com/LeastSquaresFittingExponential.html
Logarithmic Least Squares Fit
http://mathworld.wolfram.com/LeastSquaresFittingLogarithmic.html
Power Least Squares Fit
http://mathworld.wolfram.com/LeastSquaresFittingPowerLaw.html
Invers Least Squares Fit
http://mathworld.wolfram.com/LeastSquaresFitting.html
Invers Least Squares Fit2
http://mathworld.wolfram.com/LeastSquaresFitting.html
n-dim. Polynomial
http://mathworld.wolfram.com/LeastSquaresFittingPolynomial.html
Quadratic Polynomial
http://en.wikipedia.org/wiki/Quadratic_function
Cubic Polynomial
http://en.wikipedia.org/wiki/Cubic_function
Sine Wave
Line Form
Circle Form
Ellipse Form
Inner Circle Arcs
http://www.codeproject.com/Articles/282972/Curve-representation-by-ICAS-Inner-Centered-Arcs
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Consider the nature of most experimental data. Typically, such data include noise due to many different
effects. The noisy data from an experiment might appear as shown in the following Table and Figure. We
assume that the x values are accurate. Visual inspection of the data suggests a positive relationship between
x and y = f(x), i.e., higher values of y are associated with higher values of x. One strategy for deriving an
approximating function for this data might be to try to fit the general trend of the data without necessarily
matching the individual points. A straight line could be used to generally characterize the trend in the data
without passing through any particular point. The line in next Figure has been sketched through the points.
Although this approach may work well in many cases, it does not provide us with any quantitative measure
of how good the fit of the line is to the data. We need a criterion with which to measure the goodness of fit
of the line to the data. One way to do this is to derive a curve that minimizes the discrepancy between the
data points and the curve. The technique for accomplishing this is called least-squares regression.
Often data are available at discrete points and we require estimates at points between the discrete values. In
this section, we will discuss techniques to fit curves to data in order to estimate intermediate, or fitted,
values. Two methods of curve fitting are generally considered, depending on the amount of error in the data.
When the data are known to be precise, the method of interpolation is used. The primary purpose of
interpolation is to provide information between tabular data, and, as accurately as possible, to force the
approximating function to assume exactly the value provided at each of the points where the data is
supplied. For significantly “noisy” data, a single curve representing the general trend of the data is derived by
the method of least-squares regression.
In statistics, Regression means finding a description of a data set. For example, if a data set fits into a normal
distribution, the whole data set can then be described by two numbers: its mean and standard deviation.
The next functions are also available in SimplexNumerica:
Linear Least Squares:

y=a+bx

Exponential function:

y = a ebx; a > 0

Logarithmic function:

y = a + b ln(x)

Power function:

y = a xb; a > 0

Power function with weighting: y = a xb; a > 0

Parabolic Regression:

y = a + bx + cx2

Cubic Regression:

y = a + bx + cx2 + dx3

Polynomial 0-9ten of degree

y = a0 + a1 x + a2 x2 + a3 x3 +. . . . . + an xn
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The coefficients are determined by the solution of the Gauss' Eliminationsverfahren with partial Pivotierung.
Error messages result:
During logarithmic computation by values for xi < = 0;
During exponential computation for values of yi < = 0;
During computation to a power function, xi and yi must be positive values.
The results will be shown in the Output Window.

19.3 Sample Consensus
•
•
•
•
•
•
•

Random Sample Consensus (RANSAC)
http://en.wikipedia.org/wiki/RANSAC
Progressive Sample Consensus (PROSAC)
Randomized RANSAC (RRANSAC)
Least Median of Squares (LMEDS)
M-Estimator Sample Consensus (MSAC)
Randomized MSAC (RMSAC)
Maximum Likelihood Estimation Sample Consensus (MLESAC)

 Please have a look at chapter 20. Here you can find a fictive sample chapter about these functions.

19.4 Approximation
Approximation or Fitting means finding a smooth curve that describes the underlying pattern without
necessary to touch it data points.
•
•
•
•
•
•
•
•

Standard Simplex Algorithm
Gauß Algorithm
Bezier
Bezier V2
B-Spline
Smoothing Spline
Param. Smoothing Spline
Cyclic Smoothing Spline

19.4.1 Simplex-Fit
The Simplex-Algorithm or shorter Simplex-Fit is a very effective procedure for a nonlinear Fit. The Simplex
algorithm function performs non-linear approximation of all the parameters that have been in the formula
marked to be floated. As always in non-linear approximation, good starting guesses are essential (for the
nonlinear parameters).
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Therefore, before executing the fit command, it is essential that parameter estimates are entered into the
Formula parser. A similar fitting strategy implemented in SimplexNumerica is the Gauß-Algorithm.
This program originally appeared in the May 1984 issue of Byte Magazine. It was originally written in Pascal
by M. S. Caceci & W. P. Cacheris at Florida State University. This program is based upon the Simplex curve
fitting algorithm. For a detailed description of this program and its workings see the above mentioned
article. I acknowledge the work of Marco Caceci and William Cacheris for writing the original Pascal program
from which this is derived. The original authors explicitly stated ''no copyright''.
The Simplex-Fit is quite fast and uses no analytical derivative of the fit function. The draw-back is that there
is no direct error estimation of the optimized parameters. To get an idea of the error, one would need to
repeat the fit very often starting from random initial conditions and then evaluate the statistics of fit results.
Although the Simplex-Fit is not always the most efficient approach, it is known to be very stable. Starting
from the initial parameter estimates, a set of random variations of the parameters are generated. The sum
of squared residuals is calculated for each of the variations, and the simplex algorithm performs a series of
optimization steps, in each of which the worst parameter set is eliminated and a better one is introduced.
The algorithm is known to be susceptible to 'circling' the optimum, i.e. it can get trapped in a path of
parameter values close to the optimum without converging. As convergence criterion, the sum of squared
residuals and all of the parameters have to be within the pre-determined Tolerance value. After
convergence, the simplex is repeatedly restarted (using randomly selected variations around the previously
found optimal values), until the parameters and the values are within the tolerance. Two consecutive
simplex procedures are required to converge to the same values and to the same parameter values for the
fit to stop. After the simplex has converged, SimplexNumerica will show you the results.
The text output during the fitting procedure shows the number of simulations of the sedimentation process,
and the simplex number, the simplex step # and the finite element gridsize. The remaining lines show the
values and the parameter values from the current simulation. The last line shows residuals from the current
simulation.
Convergence can be observed if the value does change only very little, and when the parameter values stay
virtually the same.
The Simplex algorithm used four mechanisms of vertex movements. Vertices are moved toward the
minimum point by the four mechanisms, reflection, expansion, contraction, and shrinkage. Reflection moves
the highest (worst) vertex to the opposite side of the center of the other vertices. Expansion moves the
highest vertex to twice the distance from the center, which is used when a reflected vertex is lower than the
lowest vertex and the expanded vertex becomes the lowest one. Contraction moves to the middle between
the highest vertex and the center, which is used when a reflected vertex is higher than the highest vertex.
When the contracted vertex is still higher than the highest vertex, all the vertices except the lowest vertex
move toward the lowest one by half, which is called shrinkage.
Put the function equation (formula) with the associated parameters into the Simplex Formula Parser
(SimplexParser).
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The operation of the above formula box facilitates the input of the function equation for the user. One can
arrange the formula both over the keyboard and by activating the small buttons with the mouse. Go to the
Gauß-Fit in this manual for getting more info about the formula parser dialog and the right parameter order.
The parameters are start values for the algorithm. The program varies these parameters and tries to find a
minimum of the sum of the discrepancy squares.
If the algorithm found a minimum, then one says: it converges. It can be possible, that there is more than
one minimum are available. Then, the algorithm does not have necessarily found the absolute minimum. As
abort criteria will be the maximum number of iterations and the difference of the remaining variance
between two iterations. When it falls short of these criteria, thus the Fit becomes cancelled. Sometimes it is
difficult to find suitable initial values and increments to a convergence of the algorithm.
For this some references:
The initial values should be oriented at the orders of magnitude of the measured values. The increments
should amount to approximately a third step of the data, whereby they can be also more largely selected at
the beginning. If the algorithm a minimum, it reduces the increment independently. The results of a not
handy Fit should be used as new initial values for the next try.
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19.4.2 Gauß-Fit
The Gauss-Fit proceeds from the same problem definition as the Simplex-Fit.
Application:
If the intervals of the measuring data move in very small number ranges (e.g. xmax = 10 -9), then it makes
sense, to scale the data to larger values, e.g. by multiplication with the factor 10 9. Reasons for this are the
rounding errors of approximation at to small values.
Next the function equation has to be entered into the Formula parser.

The operation of the above formula box facilitates the input of the function equation for the user. One can
arrange the formula both over the keyboard and by activating the small buttons with the mouse.
If one presses the Return key, then the program examines the formula immediately and indicates a possible
error in form of a message text.
The Gauss' algorithm expects a certain number of parameters from the user, with which it can adapt the
entered function equation to the x/y pair (at least 1, at the most 10 parameters).
These parameters are indicated on the right side in the dialogbox. It is very important to know that
SimplexNumerica expects the parameters in a right order. If a formula has for instance three parameters,
then the parameters in the formula have to be in sequence B, F and then G (and not differently)! It must
have the same order as in the dialogbox B, F, G, H, J K, M, N and U!
These parameters are changed in the course of the calculation by the program and given afterwards as an
output result in the Report Window.
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19.4.3 Bézier-Curves
Bézier curves were independently discovered in the late 1960's by two French engineers, Pierre Bézier and
Paul de Casteljau, who worked for different French automobile companies. Bézier curves used in drawing
packages are determined by parametric polynomials of low degree, and are used because they give local
control of shape, the resulting curves are smooth and continuous, derivatives can be evaluated at any point
(although sometimes will be infinite) and are very easy to adapt in SimplexNumerica.

19.4.4 Smoothing Spline
The Smoothing Spline Approximation provides a useful way of approximating a smooth function f(x) only
when the data points lie along the path of the function or very close to it. If the data is scattered at random
in the vicinity of the path, then an interpolating polynomial, which is bound to follow the same random
fluctuations, will belie the nature of the underlying function. Therefore, in the interests of smoothness, we
may wish to allow the spline to depart from the data points.

19.4.5 Parametric Smoothing Splines
A paper entitled “Connecting the Dots Parametrically: An Alternative to Cubic Splines.” which is published in
The College Mathematics Journal and written by W. Hilderbrand5, describes a method for obtaining the
parametric equations of a smooth curve that passes through a sequence of points. The method presented
shows how to connect any set of n ordered points with smooth curve that is defined parametrically. The arc
that connects two successive points is determined by four points, namely, the two points, the point
preceding them, and the point following them. Substituting the coordinates of these four points into the
general form of the parametric equations completely determines the parametric equations of the arc. At
each given point of the ordered set, the tangent to the curve exists and is parallel to the chord that connects
the preceding point to the succeeding point. The parametric equation does not require y to be a function of
x nor must x values be equally spaced.

5

1. J. H. Ahlberg, E. N. Nilson and J. L. Walsh, The Theory of Splines and Their Applications. (Academic Press, New York)
1967.

3. W. J. Hilderbrand, “Connecting the Dots Parametrically: An Alternative to Cubic Splines.” The College Mathematics
Journal, 21, 208-215, 1990.
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19.4.6 Cyclic Smoothing Splines
With the help of the Cyclic Spline function you can interpolate arbitrary closed curves. This splines are
particularly appropriate for the representation of closed smooth curves, e.g. for isolines.
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19.5 Interpolation
Similar to curve fitting, interpolation methods attempt to find a function (or often a set of functions) that
represents a set of discrete data points (SampleData). However, in this case, the data points are considered
to be very accurate, such that the approximating relationship must not only pass exactly through each point,
but also allow accurate interpolation between them. These methods are most commonly used as a means of
obtaining a continuous representation of accurately measured experimental data (e.g., equilibrium data) for
subsequent computational purposes. They are also particularly useful in situations where a tedious
numerical method has been employed to generate a fairly sparse set of discrete information, and this data
must then be used in continuous form as a starting point for some other type of analysis on the computer.
For example, when a mathematical function like the sine function is evaluated on the computer, it is not
determined from scratch using, e.g., its infinite series representation. Rather, a call to sin(x) invokes an
interpolation method that determines functional values at positions intermediate to a small number of very
accurately determined values of the sine function. Interpolation methods are also used extensively in
graphical routines, to produce smooth curves connecting a set of discrete points.
Thus the general point of view in this chapter can be stated as follows:
Given a set of “accurate” data points, (xi, yi), i = 1, 2 , , n, construct a function f(x) such that f(xi) = yi for each
i and f(x) assumes “reasonable” values for all x between the data points.
One approach to the problem of approximating a set of data according to the above criteria is to simply find
the (n−1)-order polynomial that passes through all n points. This approach certainly meets the first
condition that f(xi) = yi, but, in most cases, because higher-order polynomials tend to oscillate, it usually
won’t meet the second. Thus, most interpolating methods attempt to find many separate functions that fit
only portions of the data, often just the region between each pair of neighbouring x values. Furthermore,
these interpolating functions are usually lower-order polynomials, e.g., quadratics, cubics, quartics, etc.
There are two different approaches that can be taken to find a lower-order polynomial which passes through
two neighbouring data points and allows accurate interpolation at all intervening x values. One method is to
determine the polynomial that passes exactly through several points surrounding the interpolation interval.
This approach is illustrated below, where 3rd-order polynomials are passed through the 4 points (2 on either
side) surrounding each interval.
SimplexNumerica provides the following interpolation algorithm:
•
•
•
•
•
•
•
•
•
•
•
•

Polygonal Segments
Forwardflat Segments
Backwardflat Segments
Additional Segments
Cubic Spline
Parametric Spline
Periodic Spline
Cyclic Spline
Smooth Spline
Akima Subspline
Renner Subspline
Polynomial Interpolation
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•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

(n-1) Polynomial
Lagrange
Newton
Rationale
Aitken/Neville
Hermite Splines
Catmull-Rom Spline
Kochanek-Bartel Spline
Cardinal Spline
Modified Cubic Splines
Natural Overshooting
Non-overshooting in 1st Derivative
Non-overshooting in 2nd Derivative
Parabolic Interpolation
Fritsch-Butland Interpolation
Akima Interpolation
Kruger Interpolation
Extrapolation Cubic Spline

The most algorithm can be find in the internet and they are not described here (see the link underneath the
bullet point).

19.5.1 Polygonal Curve
The simple polygonal function connects the individual measuring points by straight lines. These straight lines
are also present as CurveData. The individual measuring points are not only simply connected; in each
subinterval a linear curve is computed. Thus one can integrate or differentiate a polygonal curve.
(xi+1, yi+1)
(xi, yi)

(x2, y2)
(x3 y3)

(x1, y1)
f1(x
)

(xi-1, yi-1)

fi(x)

fi+1(x
)

fi−1 (x)

(xn-1, yn1)

f2(x
)
hi-1

h1

(xi+2, yi+2)

h2

hi

hi+1

(xn, yn)

fn1(x)
hn1
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For a given set of data containing n points, there are n−1 intervals and hence n−1 separate Polygonal Curve
that must be determined. Assume that each pair of neighbouring points, (xi, yi) and (xi+1, yi+1), is joined by a
linear Polygonal Curve (i.e., a 1st-order polynomial) of the form:

f i ( x) = pi + qi ( x − xi ),

i = 1, 2,  , n − 1

where pi and qi (i = 1, 2, ···, n−1) are 2n−2 constants that must be determined from the following conditions:

f i ( xi ) = yi ,

i = 1, 2, ···, n−1

f i ( xi +1 ) = yi +1 ,

i = 1, 2, ···, n−1

n−1 equations
n−1 equations
2n−2 equations

The first condition yields:

f i ( xi ) = pi = yi ,



pi = yi ,

i = 1, 2,  , n − 1

The second condition gives:

f i ( xi +1 ) = yi + qi ( xi +1 − xi ) = yi + qi  hi = yi +1


qi =

yi +1 − yi
,
hi

i = 1, 2,  , n − 1

19.5.2 Additive Segmentation
The procedure for the curve with additive segmenting is primarily for series of measurements with a large
number of measuring data. The number of SampleData should be more than 50, so that one gets a smooth
course of the curve.
The algorithm of the Additive Segmentation contains a calculation specification, with their assistance the
progression of a function is described by a finite number of values, laying on a curve; their curvature are
closely as possible at the point process.
The procedure divides the existing segments (places of the measuring points) with the help of auxiliary
points into smaller segments. The number of the added segments depends on the curvature of the function.
Within the range of a strong curvature the points are nearer together.
Hint:
For the production of the auxiliary points the number of CurveData should be adapted!
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19.6 2D Surface Interpolation & Approximation
2D Surface Interpolation
•
•
•
•

Bi-Linear
Nearest Neighbors Linear
Smoothing Spline
Thin Plate Surface Spline

2D Surface Approximation
•
•
•
•

Nearest Neighbors Distance
Nearest Neighbors Around Distance
Thin Plate Surface Spline
Bivariate Cubic Spline

3D Approximation and Interpolation is sometimes difficult to handle. The result is very depended from the
sample data and the used algorithm.
SimplexNumerica has integrated some different algorithm for 3D fits. The following fits are implemented:
•
•
•
•
•
•

Thin Plate Surface Spline Interpolation
Thin Plate Surface Spline Approximation
Bivariate Cubic Spline Approximation
Nearest Neighbours Distance Weighted
Nearest Neighbours Linear Interpolation
Nearest Neighbours Around Distance Weighting

19.6.1 Thin Plate Surface Spline
Thin Plate Surface Spline, or TPS for short, is an interpolation method that finds a "minimally bended"
smooth surface that passes through all given points. TPS of 3 control points is a plane, more than 3 is
generally a curved surface and less than 3 is undefined.

The name "Thin Plate" comes from the fact that a TPS more or less simulates how a thin metal plate would
behave if it was forced through the same control points.
Thin plate splines are particularly popular in representing shape transformations, for example, image
morphing or shape detection. Consider two equally sized sets of 2D-points, A being the original shape and B
the target shape. Let zi=Bix - Aix. Then fit a TPS over points (aix, aiy, zi) to get interpolation function for
translation of points in x direction. Repeat the same for y.
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In some cases, e.g. when the control point coordinates are noisy, you may want to relax the interpolation
requirements slightly so that the resulting surface doesn't have to go exactly exactly through the control
points. This is called regularization and is controlled by regularization parameter λ. If λ is zero, interpolation
is exact and if it's very large, the resulting TPS surface is reduced to a least squares fitted plane ("bending
energy" of a plane is 0). In our example, the regularization parameter is also made scale invariant with an
extra parameter α.

19.6.2 Bivariate Cubic Spline
The authors Jörg Haber, Frank Zeilfelder, Oleg Davydov and Hans-Peter Seidel from Max-Planck-Institut für
Informatik, Saarbrücken, have described an article about <Smooth Approximation and Rendering of Large
Scattered Data Sets>. So search in the internet for this article about Bivariate Cubic Splines.

They have presented an efficient method to automatically compute smooth approximations of large sets of
unorganized scattered data points. The method is based on the construction of a differentiable bivariate
spline with respect to a uniform triangle mesh over an arbitrarily shaped planar domain. For a uniformly
distributed subset of triangles we compute local polynomial least squares approximations by using singular
value decomposition (SVD) of small matrices.

The smooth approximating spline is constructed by gluing together these patches using Bernstein-Bezier
smoothness conditions. We emphasize the following key features of our method: They develop a completely
local approach, which means that we do not use any global optimization or other techniques involving
computation with large portions of the data set. They employ the rank-revealing features of SVD to control
the polynomial degree of the initial patches, which allows taking into account the local variation and
distribution of the data points.

Nearest Neighbor Algorithm
The nearest neighbor query ranks all objects in terms of their distance from a query object which is a a point.
The point query object is specified by positioning the mouse over it and clicking it. The objects are displayed
in the order of their distance from the query object along with their position in the ranking.

The neighboring objects are found in an incremental manner. In other words, having found the k nearest
neighbors, in order to find the k+1st nearest neighbor, the algorithm does not recompute the set of k+1
nearest neighbors; it just finds the additional neighbor. The incremental nearest neighbor algorithm (see G.
Hjaltason and H. Samet, Ranking in spatial databases in Advances in Spatial Databases - 4th Symposium,
SSD'95, M. J. Egenhofer and J. R. Herring, Eds., Lecture Notes in Computer Science 951, Springer-Verlag,
Berlin, 1995, 83-95) makes use of a priority queue where the queue elements are the blocks of the
underlying data structure as well as the objects themselves. The priority queue is ordered on the basis of the
distance of its elements from the location of the query object which is a point in our implementation. In case
of a tie between two spatial objects (i.e., two non-block objects have the same distance from query point p )
and if the distance is zero and if the object has extent and area (i.e., a rectangle), then use the distance from
SimplexNumerica V21
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p to the nearest boundary of an object that contains p (if such an object exists) as the discriminator for the
ordering.

The algorithm works in a top-down manner in the sense that as elements are removed from the queue, they
are checked if they correspond to blocks that are not at the lowest level of the hierarchy (i.e., nonleaf
nodes). If this is the case, then their immediate descendants (i.e., the sons) are inserted in the queue
ordered according to their distance from the query object. Otherwise, the objects that they contain are
inserted into the queue ordered according to their distance from the query object. If the element e that has
been removed from the queue is a data object, then e is reported as the next nearest neighbor of the query
object.
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19.7 Digital Signal Processing
19.7.1 Simple Waveforms
▪
▪
▪
▪
▪
▪

Sine Waveform
Sine Waveform with Harmonics
Square Waveform
Triangle Waveform
Sawtooth Waveform
Gaussian Noise

▪
▪
▪
▪
▪
▪
▪
▪
▪
▪
▪
▪
▪
▪
▪
▪
▪

Summation of sine waves
Sawtooth wave by summation
Sawtooth wave by direct calculation
Inverse Sawtooth wave
Triangle wave
Square waves
Pulse wave
Frequency modulation FM
Phase modulation PM
Amplitude modulation AM
Ring modulation AM
Pulse wave buzz
Pulse wave buzz2
Dynamic spectrum
Bandwidth limited
Waveshaping
White noise

19.7.2 Complex Waveforms

19.7.3 Envelope Generators
o
o
o
o
o
o
o
o
o
o
o
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Simple Linear Integration
Convex Exponential Interpolation
Variable Exponential Interpolation
Logarithmic Interpolation
DB Interpolation
Simple State Machine
Multiple Segments ADSR
Multiple Segments State Machine
Constant Rate ADSR
Constant Rate ADSR Transformed
Amplitude Envelope
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19.8 DFT
•
•
•
•
•

Approximation
Spectrum
Phase
Real Part
Imaginary Part

•
•
•
•
•
•
•
•
•
•

Approximation
Spectrum (Simplex FFT)
Spectrum (Complex FFT
Spectrum (Real FFT)
Phase
Real Fourier Analysis
Real Fourier Synthesis
Real Part
Imaginary Part
Interpolation (2:1 ratio)

19.9 FFT

Page 348 of 372

SimplexNumerica V21

-349Algorithm in SimplexNumerica

19.9.1 Fast Fourier Transform (FFT)
The Fast Fourier Transform [FFT], suggested by Tuckey and Coolidge6 in 1965 is a powerful tool used in many
engineering disciplines. It was developed to perform the Discrete Time Fourier Transform in a faster and
6

Cooley, J. W. and Tukey, J. W., 1965, An algorithm for the machine calculation of complex Fourier
series, Mathematics of Computation, 19, 90, pp. 297-301.
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efficient manner. The following plots show an evaluation signal smoothed by the input signal. The last
screen-shot shows the resulting FFT spectrum.
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Fourier Subtotal
The result of the FFT Fourier Subtotal corresponds practically to the Fourier series, except that the
Computation algorithm is different.

τ

SimplexNumerica computes to M = 2 given real function values y(0), y(1),...., y(M-1) the discrete Fourier
coefficients A(0), A(1),...., A(M/2) und B(0), B(1),...., B(M/2) from the discrete Fourier Subtotal.

A(0) +

M / 2 −1

 A(k ) cos(k  x) + B(k ) sin( k  x) + A( M / 2) cos( M / 2  x
k =1

with  =

2
T

T : Period duration

The value τ corresponds to the twosome logarithm of the number of function values. The number of the

τ

function values is M = 2 . It must be τ

≥ 2.

An index value smaller than the final index leads to an approximation of the measuring data. The fit of the
measuring data is called filtering.
Info:
With the Fourier Subtotal we are staying in the time interval and not in the frequency region.
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Spectrum
Many technical procedures run periodically with a frequency (number of revolutions). Periodical Processes
possess spectrum of lines.

So, how is it made in SimplexNumerica? You have to start with the original function signal as it shown in the
previous chapter. Then call the Pulldownmenu Algorithm → Approximation → FFT → Spectrum.

This means that beside the first harmonic frequency f0 there are other terms of frequencies - that are integer
multiples of the basic frequency - so called higher harmonics (n * f0).

The amplitude of these spectral lines with f = n f0 are given by (continuous) pulse spectrums, depend on the
time scale (form of the impulse) from the respective measurement value certain within one period. The
spectrum is defined as the amount from the real and imaginary part of the complex discretional Fourier
coefficient.

Phase Angle
This menu is for the calculation of the phase angle.

The zero-phase angle is defined as:
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 = arc cos

Re
+2k
S

für

Im  0

Re
+2k
S

für

Im  0

and

 = −arc cos

The abscissa (x-axis) is shifted from the time interval into the frequency range.

Fourier Analysis
τ

The program calculates to M = 2 given real function values y(0), y(1),...., y(M-1) the discretional Fourier
coefficients A(0), A(1),...., A(M/2) and B(0), B(1),...., B(M/2) from the discretional Fourier Subtotal (see
above). Afterwards no further calculation will be done. The x-measuring data are not changed.

Fourier Synthesis
Fourier-Synthesis means the determination of a repetitive function from the discrete Fourier coefficients
A(0), A(1)...., A(M/2) and B(0), B(1)...., B(M/2) from the associated discrete Fourier subtotal. Afterwards no
further computation is accomplished. The x-measuring data are not changed.
Before the execution applies to the function: In the y-array stands now the discrete Fourier coefficient, as
follows:

y(0)

= A(0)

y(k)

= A[(k+-)/-]
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k= 1, 2, . . . , M/2 ,
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y(k)

= B(k/-)

for

k= 1, 2, . . . , M-2 ,

thus in the order:
A(0), A(1), B(1), A(2), B(2), . . . (like above)
After the execution applies for the function: The y-Array has now the functions values.
Advantage of this way of writing: You can put the results in the clipboard or save it as curve data. You can
use in SimplexNumerica immediately the inverse function, it then corresponds Fourier Synthesis. The array
of the inverse function expects this parameter arrangement.

Real Part
This function sets particularly only the real part of the complex discrete FFT. This is naturally the discrete
Fourier analysis described above. The transformation can be done as follows:
 f
H 
NT


T
 =
N
T


N −1

 h(k T ) e

−

j 2 f k
N

k =0

The divisor N * T is the period duration (harmonious) of the component of the signal with the lowest
frequency, which can be determined. The N scanning values of h(k * T) must be exactly one period of the
repetitive function h(t), so that the above equation supplies exact values. The following figure shows a
rectangle pulse as an example.

The computation of the analysis supplies the following real part of the discrete Fourier Analysis:
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The bar chart view is here not automatically done by the program. You must set it up manually.
Since the results are symmetrical concerning f = N/2, only one half of the diagram becomes places.
Acceptable values were obtained for harmonious lower order. With a reduction of T and an increase of N a
larger accuracy can be reached with high ordered harmonious.

Imaginary part
Similarly to the Fourier Real Part this function represents only the imaginary part of the discrete complex
Fourier transform.
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19.10

Window Functions
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

19.11

Goertzel DFT (Filter)
•
•

19.12

Scaled Magnitude
Tone detection

FIR Filter
•
•
•
•
•
•

19.13

None Window (Rectangle)
Hamming Window
Hanning Window
Hann Window (Matlab)
Blackman Window
Triangular Window
Sqrt Window
Hann Window (Numerical Recipes)
Blackman-Harris Window
Bartlett Window
Parzen Window
Welch Window
Steeper Window
Kaiser Window
Flat Top Window
Flat Top Window (Stanford)

FIR Coefficients (Remez Algorithm)
FIR Filter Graph (Remez Algorithm)
FIR Coefficients (Parks McClellan Algorithm)
FIR Filter Graph (Parks McClellan Algorithm)
FIR Coefficients (Iowa Hills Algorithm)
FIR Filter Graph (Iowa Hills Algorithm)

IIR Filter
•
•
•
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RBJ Biquad
Butterworth
Chebyshev I
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•
•
•
•
•

19.14

Time-series Filter
•
•
•
•
•

19.15

•
•
•
•
•
•
•
•

Simple Moving Averages
Exponential Moving Averages
Linear Moving Averages
Savitzky-Golay Filter
FIR / IIR Real Filter

Audio Signals
•
•
•
•
•

19.16

Chebyshev II
Elliptic
Bessel
Legendre
Custom

Play
Change Sound Tempo
Change Sound Pitch
Change Sound Rate
Adjust Tempo to BPM

Math Operations

Add Array
Add Number
Sub Array
Sub Number
Mul Array
Mul Number
Div Array
Div Number
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19.17
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Math Functions

Use Formula Parser
Bernstein Polynomial [0,1]
Bernstein Polynomial [a,b]
Bernoulli Polynom of order N
Euler Beta Function (Euler's Integral)
Gaus Error Function
Gaus Error Function Inverse
Legendre Polynomial
Hermite Polynomial
POPUP Bessel Functions
Bessel Function of the first kind
Bessel Function of the second kind
Modified Bessel Function of the first kind
Modified Bessel Function of the second kind
Spherical Bessel Function of the first kind
Spherical Bessel Function of the second kind

19.17.1Airy Functions
•
•
•
•

Airy function Ai
Airy function Bi
Airy function Ai'
Airy function Bi'

19.17.2Elliptic Integrals
•
•
•
•

Carlson's elliptic integral RC
Legendre's complete elliptic integral of the first kind
Legendre's complete elliptic integral of the second kind
Legendre's complete elliptic integral of the third kind

19.17.3Jacobi Elliptic Functions
•
•
•
•
•
•

Function cd
Function cn
Function cs
Function dc
Function dn
Function ds

Page 358 of 372

SimplexNumerica V21

-359Algorithm in SimplexNumerica
•
•
•
•
•
•
•
•

Function nc
Function nd
Function ns
Function sc
Function sd
Function sn
Riemann Zeta Function (left)
Riemann Zeta Function (right)

19.18

Differentiation

19.19

Integration

19.20

Outlier Algorithm

•
•
•
•
•
•
•
•

Auto Detection
Dean-Dixon Outlier Test
Nalimov Outlier Test
Grubbs Outlier Test
Significance of extreme values
Show Outlier Test Limit
Show Outliers in Output Window
Acoustics Alarm if any Outlier

19.21
•
•
•
•
•
•
•
•
•
•
•

Data Reduction

Routine from MIR (Russian Space Station)
Band Slope Method
Scherenschnitt Method
Removing nth Data Points
Radial Vertex Reduction
Perpendicular Vertex Reduction
Retake Perpendicular Vertex Reduction
Reumann/Witkam Reduction
Ramer/Douglas/Peucker Reduction
Optimized Ramer/Douglas/Peucker Reduction
Opheim Simplification
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•

Lang Simplification

19.22
•
•
•

Hull Edge Points
Hull Polygon
Hull Curve

19.23
•
•
•

Convex Hull

Misc.

Histogram
Inter Line
Stochastic Alpha, BetaRho (SABR)
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20 New Approach for Regression Analysis
The aim of this chapter is to obtain the best possible result for the measurement of data points for the fictive
Engine Retardation.
The results of any measurement can be misleading because of:
•
•
•
•
•

A low magnitude that cause inaccurate measurements.
The presence of measurement dips that result in significant variation in the calculated value over the
period of a scan.
The results can be influenced by data spikes.
Unintentional generation, propagation and reception of electromagnetic energy among an
electromagnetic device (engine, generator, etc.) with reference to unwanted effects
(electromagnetic interference, or EMI) that such energy may induce.
Inaccurate measurement devices with too high deviations.

All these effects can have massive influence of the accurate of a measurement. Most of the effects cannot
be resolved without going further, but can be covered with the help of the algorithm described below.
Here in this document, these misleading data points are simply called outliers.
To calculate the straight regression line from fictive measurement points (called engine retardation), a
floating Linear Least Squares Fit (LLSF) algorithm is used. The LLSF estimation is a good method if
assumptions are met to obtain regression weights when analyzing the engine data. However, if the data
does not satisfy some of these assumptions, then sample estimates and results can be misleading. Especially,
outliers violate the assumption of normally distributed residuals in the least squares regression. The fact of
outlying engine power data points (engine dips), in both the direction of the dependent (y-axis) and
independent variables (x-axis / timestamp), to the least squares regression is that they can have a strong
adverse effect on the estimate and they may remain unnoticed. Therefore, techniques like RANSAC (Random
Sample Consensus) that are able to cope with these problems or to detect outliers (bad) and inliers (good)
have been developed by scientists and implemented into SimplexNumerica.
Robust consensus algorithms like RANSAC are important methods for analyzing data that are contaminated
with outliers. It can be used to detect outliers and to provide resistant results in the presence of outliers.
A new approach based on the Maximum Likelihood Estimator Sample Consensus (MLESAC7) and Random
Sample Consensus (RANSAC8) for an improved Engine Retardation measurement routine inside the device is
described for robustly estimating floating linear regression relations from engine power point
correspondences. The method comprises two parts. The first is a new robust estimator MLESAC that is a
generalization of the RANSAC estimator. It adopts the same sampling strategy as RANSAC to generate
putative solutions, but chooses the solution that maximizes the likelihood rather than just the number of

7

The MLESAC here represents an implementation of the MLESAC (Maximum Likelihood Estimator Sample
Consensus) algorithm, as described in: "MLESAC: A new robust estimator with application to estimating
image geometry", P.H.S. Torr and A. Zisserman, Computer Vision and Image Understanding, vol 78, 2000.
8

http://de.wikipedia.org/wiki/RANSAC-Algorithmus
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inliers. The second part of the algorithm is a general-purpose method for automatically parameterizing these
relations, using the output of MLESAC.
Quintessence:
The new approach should be an established algorithm for maximum-likelihood estimation by random
sampling consensus, devised for Engine Retardation measurement to avoid the influence of the abovedescribed misleading results.

20.1 RANdom SAmple Consensus (RANSAC)
The Random Sample Consensus (RANSAC) algorithm proposed by Fischler and Bolles 9 is a general parameter
estimation approach designed to cope with a large proportion of outliers in the input data. Its basic
operations are:
1.
2.
3.
4.

Select sample set
Compute model
Compute and count inliers
Repeat until sufficiently confident

Step ( i )

Step ( i + j )

Step n (result)
Step ( n – j )

9

Martin A. Fischler and Robert C. Bolles (June 1981). "Random Sample Consensus: A Paradigm for Model
Fitting with Applications to Image Analysis and Automated Cartography". Comm. of the ACM 24 (6): 381–
395. doi:10.1145/358669.358692
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Result
The RANSAC steps in more details are10:
1. Select randomly the minimum number of points required to determine the model parameters.
2. Solve for the parameters of the model.
3. Determine how many points from the set of all points fit with a predefined tolerance.
4. If the fraction of the number of inliers over the total number points in the set exceeds a predefined
threshold, re-estimate the model parameters using all the identified inliers and terminate.
5. Otherwise, repeat steps 1 through 4 (maximum of N times).
Briefly, RANSAC uniformly at random selects a subset of data samples and uses it to estimate model
parameters. Then it determines the samples that are within an error tolerance of the generated model.
These samples are considered as agreed with the generated model and called as consensus set of the chosen
data samples. Here, the data samples in the consensus as behaved as inliers and the rest as outliers by
RANSAC. If the count of the samples in the consensus is high enough, it trains the final model of the
consensus with using them. It repeats this process for a number of iterations and returns the model that has
the smallest average error among the generated models. As a randomized algorithm, RANSAC does not
guarantee to find the optimal parametric model with respect to the inliers. However, the probability of
reaching the optimal solution can be kept over a lower bound with assigning suitable values to algorithm
parameters.

10

From: Overview of the RANSAC Algorithm, Konstantinos G. Derpanis, kosta@cs.yorku.ca,Version 1.2,May 13, 2010.

Or: M.A. Fischler and R.C. Bolles. Random sample consensus: A paradigm for model fitting with applications to image
analysis and automated cartography. Communications of the ACM, 24(6):381–395, 1981.
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20.2 Maximum Likelihood Estimator Sample Consensus
(MLESAC)
This chapter describes in a simple and concise way the robust estimator, MLESAC11, which can be used for
calculation instead of the floating regression algorithm LLSF.
In particular, MLESAC is well suited to estimating the Engine Retardation trend or more general, it manifolds
the engine’s power data to timestamp miss relation in Engine Retardation measurement because of the fact
that the timestamp is set maybe inaccurately inside the internal clock of the measurement device.
Technical descriptions and own tests have shown that the RANSAC algorithm has been proven very
successful for robust estimation, but with the robust negative log likelihood function having been defined as
the quantity to be minimized it becomes apparent that RANSAC can be improved on. One of the problems
with RANSAC is that if the threshold for considering inliers is set too high then the robust estimate can be
very poor and the slope of the regression line goes wrong.
As an improvement over RANSAC, MLESAC has a better estimate for elimination of noise dips for instance
influenced by neighborhood machines. The minimal set point, initially selected by MLESAC, is known to
provide a good estimate of the data relation. Hence, the initial estimate of the point basis provided by MLESAC
is quite close to the true solution and consequently the nonlinear minimization typically avoids local minima.
Then the parameterization of the algorithm is consistent, which means that during the gradient descent phase
only data relations that might actually arise are searched for. It has been observed that the MLESAC method
of robust fitting is good for initializing the parameter estimation when the data are corrupted by outliers. In
this case, there are just two classes to which a datum might belong, inliers or outliers.
Torr and Zisserman have shown that the implementation of MLESAC yields a modest to hefty benefit to all
robust estimations with absolutely no additional computational burden. In addition, the definition of the
maximum likelihood error allows it to suggest a further improvement against RANSAC. As the aim is to
minimize the negative log likelihood of the data it makes sense to use this as the score for each of the
random samples.
After MLESAC is applied, nonlinear minimization is conducted using the method described in Gill and
Murray12, which is a modification of the Gauss–Newton method. All the points are included in the
minimization, but the effect of outliers is removed as the robust function places a ceiling on the value of
their errors, unless the parameters move during the iterated search to a value where that correspondence
might be reclassified as an inliers. This scheme allows outliers to be reclassed as inliers during the
minimization itself without incurring additional computational complexity. This has the advantage of
reducing the number of false classifications, which might arise by classifying the correspondences at too
early a stage.

11

MLESAC: A New Robust Estimator with Application to Estimating Image Geometry P. H. S. Torr
Microsoft Research Ltd., St George House, I Guildhall St, Cambridge CB2 3NH, United Kingdom and A. Zisserman
Robotics Research Group, Department of Engineering Science, Oxford University, OX1 3PJ, United Kingdom
12

P. E. Gill andW. Murray, Algorithms for the solution of the nonlinear least-squares problem, SIAM J. Numer.
Anal. 15(5), 1978, 977–992.
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20.3 Evaluation of Samples
To show some results of the new SimplexNumerica algorithms, the following samples are evaluated. All have
simulated data randomized around the slope f(x) = m x + b, m = 1/36, b = 1000. The inverse value of the
difference quotient (m) is equal to the rundown time in (s/W). The next figure shows two outliers down
under the theoretical graph - fitted by RANSAC (green line).
Example with two outliers:

The above figure shows the theoretical regression line f(x) = m x + b in red, the floating Linear Least Squares
Fit (LLSF or Linear Regression) in blue and the RANSAC line in green (on top of the red one).
Result:
RANSAC and theoretical line are nearly equal. The Linear Regression line drops away.
The next figure has more outliers and some inliers to direct the real engine power.
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The above figure has more outliers and some inliers to direct the real rundown slope. The Linear Regression
(blue line) goes away again. RANSAC (dark green line) does not find the right way. But finally: MLESAC (bright
green line) shows the right fit to the real inliers.

The above figure is similar to the previous one, but the additional two outliers have more distant down
under the real line as in the figure before. Result: RANSAC and MLESAC are fitting best and lying on the same
line.
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The bright green MLESAC regression line y(x) = m x + b yields best with the following statistical data:
•
•
•
•
•

Estimated Slope: m = -0.0276023 → 1 / 0.0276023 ~ 36 s/W
Estimated Y-axis Intercept: b = 999.415 ~ 1000 W
Maximum number of iterations: n = 1000
Distance to the model threshold: d = 0.001
Probability of at least one SampleData free from outliers = 99 %

Conclusion:
Also under these extremely difficult to identifying conditions, the MLESAC
algorithm can accurately predict the right offset and slope of the Engine Power
line with the result that the Engine Retardation is now the right one.
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Lastly, extreme outliers far from realism - but still the right regression line:
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21 End-user License Agreement
Developer:
•

Dipl-Phys.-Ing. Ralf Wirtz
Mürlenbach/Germany
Email: support@SimplexNumerica.com
Web: www.SimplexNumerica.com

SIMPLEXNUMERICA, SIMPLEXIPC, SIMPLEXEDITOR AND SIMPLEXETY ARE PROVIDED "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED
TO WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT
WILL THE AUTHOR BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING INCIDENTAL OR
CONSEQUENTIAL DAMAGES, ARISING OUT OF THE USE OF THE PROGRAM, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES.

This SimplexNumerica software or any SimplexNumerica software that is made available to download from a
server is the copyrighted work of Ralf Wirtz and/or its suppliers. Use of the Software is governed by the
terms of the end user license agreement, if
any, which accompanies or is included with the Software ("License Agreement") . An end user will be unable
to install any Software that is accompanied by or includes a License Agreement, unless he or she first agrees
to the License Agreement terms.
The Software is made available for downloading solely for use by end users according to the License
Agreement. Any reproduction or redistribution of the Software not in accordance with the License
Agreement is expressly prohibited by law, and may result in severe civil and criminal penalties. Violators will
be prosecuted to the maximum extent possible.
WITHOUT LIMITING THE FOREGOING, COPYING OR REPRODUCTION OF THE SOFTWARE TO ANY OTHER
SERVER OR LOCATION FOR FURTHER REPRODUCTION OR REDISTRIBUTION IS EXPRESSLY PROHIBITED.
THE SOFTWARE IS WARRANTED, IF AT ALL, ONLY ACCORDING TO THE TERMS OF THE LICENSE AGREEMENT.
EXCEPT AS WARRANTED IN THE LICENSE AGREEMENT, RALF WIRTZ HEREBY DISCLAIMS ALL WARRANTIES
AND CONDITIONS WITH REGARD TO THE SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES AND
CONDITIONS OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT.
RESTRICTED RIGHTS LEGEND. Any Software which is downloaded from this Server for or on behalf of the
United States of America, its agencies and/or instrumentalities ("U.S. Government"), is provided with
Restricted Rights. Use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth
in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.2277013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software - Restricted Rights at 48 CFR
52.227-19, as applicable. Manufacturer is Dipl.-Phys.-Ing. Ralf Wirtz, Kasterstr. 30, D-52428 Jülich.
NOTICE SPECIFIC TO DOCUMENTS AVAILABLE ON THIS WEBSITE
Permission to use Documents (such as white papers, press releases, data sheets and FAQs) from this server
("Server") is granted, provided that (1) the below copyright notice appears in all copies and that both the
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copyright notice and this permission notice appear, (2) use of such Documents from this Server is for
informational and non-commercial or personal use only and will not be copied or posted on any network
computer or broadcast in any media, and (3) no modifications of any Documents are made. Use for any
other purpose is expressly prohibited by law, and may result in severe civil and criminal penalties. Violators
will be prosecuted to the maximum extent possible.
Documents specified above do not include the design or layout of the Ralf Wirtz website or any other Ralf
Wirtz owned, operated, licensed or controlled site. Elements of Ralf Wirtz Web sites are protected by trade
dress and other laws and may not be copied or imitated in whole or in part. No logo, graphic , sound or
image from any Ralf Wirtz website may be copied or retransmitted unless expressly permitted by Ralf Wirtz.
RALF WIRTZ AND/OR ITS RESPECTIVE SUPPLIERS MAKE NO REPRESENTATIONS ABOUT THE SUITABILITY OF
THE INFORMATION CONTAINED IN THE DOCUMENTS AND RELATED GRAPHICS PUBLISHED ON THIS SERVER
FOR ANY PURPOSE. ALL SUCH DOCUMENTS AND RELATED GRAPHICS ARE PROVIDED "AS IS" WITHOUT
WARRANTY OF ANY KIND. RALF WIRTZ AND/OR ITS RESPECTIVE SUPPLIERS HEREBY DISCLAIM ALL
WARRANTIES AND CONDITIONS WITH REGARD TO THIS INFORMATION, INCLUDING ALL IMPLIED
WARRANTIES AND CONDITIONS OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE AND
NON-INFRINGEMENT. IN NO EVENT SHALL RALF WIRTZ AND/OR ITS RESPECTIVE SUPPLIERS BE LIABLE FOR
ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM
LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF INFORMATION
AVAILABLE FROM THIS SERVER.
THE DOCUMENTS AND RELATED GRAPHICS PUBLISHED ON THIS SERVER COULD INCLUDE TECHNICAL
INACCURACIES OR TYPOGRAPHICAL ERRORS. CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION
HEREIN. RALF WIRTZ AND/OR ITS RESPECTIVE SUPPLIERS MAY MAKE IMPROVEMENTS AND/OR CHANGES IN
THE PRODUCT(S) AND/OR THE PROGRAM(S) DESCRIBED HEREIN AT ANY TIME.
NOTICES REGARDING SOFTWARE, DOCUMENTS AND SERVICES AVAILABLE ON THIS WEBSITE.
IN NO EVENT SHALL RALF WIRTZ AND/OR ITS RESPECTIVE SUPPLIERS BE LIABLE FOR ANY SPECIAL, INDIRECT
OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR
PROFITS, WHETHER IN AN ACTION OF CONTRACT , NEGLIGENCE OR OTHER TORTUOUS ACTION, ARISING
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF SOFTWARE, DOCUMENTS, PROVISION OF
OR FAILURE TO PROVIDE SERVICES, OR INFORMATION AVAILABLE FROM THIS SERVER.
LINKS TO THIRD PARTY SITES
THE LINKS IN THIS AREA WILL LET YOU LEAVE RALF WIRTZ'S SITE. THE LINKED SITES ARE NOT UNDER THE
CONTROL OF RALF WIRTZ AND RALF WIRTZ IS NOT RESPONSIBLE FOR THE CONTENTS OF ANY LINKED SITE
OR ANY LINK CONTAINED IN A LINKED SITE. RALF WIRTZ IS PROVIDING THESE LINKS TO YOU ONLY AS A
CONVENIENCE, AND THE INCLUSION OF ANY LINK DOES NOT IMPLY ENDORSEMENT BY RALF WIRTZ OF THE
SITE.
COPYRIGHT NOTICE.
Copyright © 1988-2016 Dipl.-Phys.-Ing. Ralf Wirtz, Hinter Herschenhaus, Mürlenbach/Eifel.
All rights reserved.
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TRADEMARKS. Microsoft, Windows, Windows NT, MSN, The Microsoft Network and/or other Microsoft
products referenced herein are either trademarks or registered trademarks of Microsoft. Other product and
company names mentioned herein may be the trademarks
of their respective owners.
The names of companies, products, people, characters and/or data mentioned herein are fictitious and are
in no way intended to represent any real individual, company, product or event, unless otherwise noted.
Any rights not expressly granted herein are reserved.
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